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1 System Requirements   

 
Part 1 

 

Getting Started 

 
 

 

CheckMark Payroll is an automated payroll software program 

designed for the small to medium sized business to calculate and 

print payroll. This program will process hourly and salaried pay 

rates and tracks regular, overtime, double-time, sick and vacation 

hours. CheckMark Payroll will calculate Federal and State 

withholding as well as other taxes that may not necessarily be set 

up for you upon installation depending on your locale. Use 

CheckMark Payroll to define deductions, additional incomes, 

calculate and create checks, generate tax liability reports and print 

W-2s, W-3s, Form 940, 941, 943 and 944 reports. 
 

Before jumping into the set up of your company payroll, please 

read through the manual. General set up and payroll 

procedures are covered as well as how you can receive 

additional support directly from CheckMark, Inc. 
 

System Requirements 
 

CheckMark Payroll can be installed on a computer running 

either Macintosh or Windows operating systems. The software 

is a single-user application and not designed for multiple user 

access of the data files. DO NOT install the application 

program on a server, but locally on the user’s computer hard 

drive even if you save the data on a server. 
 

Users will need to have a personal computer running an 

operating system of either Windows 8 or higher, or 

Macintosh OS X 10.6 or higher. 
 

Along with a compatible printer, the latest version of Adobe 

Reader is also required to properly print certain forms from the 

program. You can download a free copy of Adobe Reader from 

Adobe’s website at www.adobe.com. 
 

Whichever computer you choose, a fundamental knowledge of 

the operating system is essential. For more information about 

the basics and navigation of your operating system, see the 

user manual that came with your computer. 
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Software Updates 
 

Each year the program is issued with the latest Federal and 

State withholding tax information as well as added features. 

Program patches are released as needed throughout the year 

for the current version of the software. Patches are available 

online at www.checkmark.com. Hard copy CDs can be 

purchased by calling the sales department at 800-444-9922. 
 

Renewal notices are sent out each year, generally late summer 

to early fall, announcing the next update. Updates must be 

purchased each year to receive support and the ability to install 

patches for changes including withholding tables and reports 

that occur throughout the year. 
 

How to Get More Help 
 

This manual covers general Payroll set up, calculation and 

reporting. There may be items that are specific to your 

company that are not addressed here except in general terms. 

For these times, CheckMark Software, Inc. offers additional 

support for users that wish to purchase a support plan. 
  

Only registered users can receive technical support so please, 

take a moment and read the License Agreement, fill out the 

Registration Card and send it in. 
 

Support is offered via internet submission, email, fax or 

telephone. Whenever you contact support, have your 

customer number OR product registration number available. It 

is important that you are at your computer with CheckMark 

Payroll running when speaking with support to best resolve 

your question/problem. 
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Support Plans 
 

CheckMark Software offers several additional support plans 

to meet your needs: 
 

Priority Support 
 

300 minutes with your annual subscription, with an 800 phone 

number exclusively for priority support customers and top of 

the queue assistance. Phone, email or fax support 
 

Professional Support 
 

90 minutes with your annual subscription. Phone, email or fax 

support. 
 
 

Before Contacting Support/Other Resources 
 

Check For Latest         Users with internet access can check to be sure that they are 

up-to-date as often as they wish by selecting Check for Latest 

Version under Help in the program. If you wish the program to 

check this for you every time it is launched, select the 

Preference to Check for Latest Version on Launch. If 

necessary, download and install the latest update (may require 

purchase if not using the current year version). 
 

Payroll Manual Users can access the Payroll Manual from the Help menu while 

in the CheckMark Payroll program. An updated manual is 

installed with each upgrade. 
 
 Online Knowledge Base         Users with internet access can check the online data base for 

Answers to common questions. Access to the KnowledgeBase 

can be obtained by going to the Help menu and selecting 

CheckMark KnowledgeBase. You can also access the 

KnowledgeBase directly from the CheckMark website at 

www.checkmark.com. 
 

Online Tutorials These short movies are valuable for new users and seasoned 

pros alike. Each topic is easy to understand as you are taken 

step-by-step through features and procedures. You can access 

the tutorials under the Help menu in the program or by going to 

the CheckMark website at www.checkmark.com.  
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Contact CheckMark Inc 
 

Suggestions Our program continues to improve with the input of our users. If 

you wish to see a feature considered for possible implementation 

into the Payroll program, please send us your suggestions. 
 

Sales - 800-444-9922 or sales@checkmark.com 
 

Support - 970-225-0387 or support@checkmark.com 
 

Customer Service - 970-225-0522 or info@checkmark.com 
 

Fax - 970-225-0611 
 

Address - 
 

CheckMark Inc.  
323 W. Drake Rd., Ste. 100  
Fort Collins, CO 80526  
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Installing CheckMark Payroll 
 

Macintosh Install 
 

1 Close all programs including disabling of anti-virus software. 
 

2 Insert the CheckMark Payroll CD-ROM into your computer’s drive. 
 

3 When the CD icon appears on the Desktop, open by double-

clicking on it and double-click the CheckMark Payroll installer. 
 

4 Follow the on-screen instructions to complete installation. 
 

The default install location on the hard drive for CheckMark Payroll is:  
Macintosh  
HD\Applications\CheckMark\Payroll\(year)\CheckMark Payroll.  
Users can install the program in any location, however, it is  
recommended to install the program on the local drive in the default  
location.  

 

Note The (year) folder represents the current calendar year. Each 

new year, a new folder pertaining to that year will be created. 
 
 

Windows Install 
 

1 Close all programs including disabling of anti-virus software. 
 

2 Insert the CheckMark Payroll CD-ROM into your computer’s drive. 
 

3 The installer will start automatically. 
 

If the installer does not start automatically after a minute, 

click your Start menu and then select Run. 
 

Type in the path and filename in the Run box. That would be the 

drive name, colon (:), backslash(\), filename. For example: 

D:\setup. Then click OK. 
 

4 Follow the on-screen instructions to complete installation. 
 

The default install location on the hard drive is C:\Program 

Files\CheckMark\Payroll\(year)\pay.exe. It is 

recommended to install the program on the local hard 

drive in the default location. 
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Note The (year) folder represents the current calendar year. Each 

new year, a new folder pertaining to that year will be created. 
 
 

 

Note CheckMark Payroll for Windows should not be installed on a file 

server. Install the application onto the local hard drive of any 

computer in your company that will need to access payroll files. 

Then save your company database to a file server. If you 

choose to save your data files on a server, you need to map 

your network drive. Each operating system handles this 

differently. For more information, see the documentation that 

came with your operating system. 
 

Keep in mind, the payroll application is still a single user 

program. Only one user should access the database at a time. 
 

 

Command Center 
 

When you open up CheckMark Payroll, the Command Center 

appears on the screen. 
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The Command Center is divided into three sections: Setup, Payroll 

and Reports. To use the Command Center, first click the section 

you wish to open, then click the option you want. If no company is 

open, the options for each section will appear greyed out and 

inactive. When a company is open, the options for each section 

will appear bold and the payroll year, company name, as well as 

the type of filer the company is and the number of active 

employees will appear on the right of the Command Center. You 

can click the Show Database Path link and a dialog will appear 

that shows the path to the company’s database files. 
 

The Command Center also has links to important support 

information, knowledge base articles, the user manual, as well as 

links to order checks and forms from CheckMark Software, Inc. 

The newsfeed at the bottom of the Command Center is a great 

way to keep up with the latest information from CheckMark.  
 

Note Not all menu commands are represented on the Command 

Center. Some dialogs, such as those under the File menu, can 

only be accessed using the pull-down menus or CTRL key 

(Windows) or COMMAND key (Macintosh) shortcuts from the 

keyboard. 
 

 

Changing Command Center View 
 

You can easily change the Command Center view back to CheckMark  
Payroll’s Classic Command Center by selecting Change View from the  
View menu. 

 

Database Manager 
 

CheckMark Payroll stores company data in a database. When 

you initially open CheckMark Payroll, a database named Default 

Payroll Company Database is created (the path is as follows: 

HD/Documents/CheckMark/Payroll/[year]/ 

DefaultPayrollCompanyDatabase[year]). 
 

If you process payroll for only one company, this is probably 

the only database you’ll ever need. 
 

If, however, you process payroll for more than one company, 

you should consider the following scenarios to manage your 

companies correctly.You can either store all your company 

files in the same database, or you can create two or more 

separate databases and store individual companies in them.  
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Storing All Company Files in the Same 

Database 
 

Each database can contain multiple companies. The advantage 

to storing all your different company files in one database is that 

when you Backup Database, Restore Database, Close 

Database, or advance to a New Year, all companies stored in 

that database will be backed up, restored, closed or advanced to 

a New Year at the same time, saving you time. 
 

Storing Company Files in Separate 
 

Databases 
 

The advantage to storing each of your company files in 

separate databases is that you have more control over where 

each database is stored on your computer, as well as when 

you want to Backup Database, Restore Database, Close 

Database, or advance companies to a New Year. 
 

Using the Database Manager 
 

Choose Database Manager from the File menu.  



Database Manager 9  

 

Create New Database 
 

This option allows you to create and save a new database in 

any location you wish. Keep in mind that each database can 

store multiple companies. 
 

1 Click Create New Database.  
 
 
 
 
 
 
 
 
 

 

2 Enter a Database Name and Payroll Year. Click the Browse 

button to select a new location to save the database. 
 

3 Click Create Database to save the new database. 
 

Add Database to List 
 

This button allows you to add an already-existing database to 

the list. For example, if you copied over a database from 

another computer and the Database Manager does not list this 

database, you can choose Add Database to List and browse to 

that location to update the Database Manager’s list. 
 

1 Click Add Database. 
 

An Open dialog box appears. 
 

2 Browse to the location where the database is saved.  
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3 Select the database and click Open. 
 

The database is added to the list in the Database Manager. 
 

Rename Database 
 

This option allows you to rename the database. It is 

recommended you use only alpha-numeric characters. 
 

1 Click Rename Database. 
 

The following alert appears: 
 

 

The Rename Database window appears.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
2 Click Yes.  

 
 
 
 
 
 
 

 
 

3 Enter the new name and click Rename Database to Save. 
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Remove From List 
 

This option allows you to remove a database from the list.  
 

Note This only removes the listing in the Database Manager. It does 

not delete the database file from the saved location. To delete a 

database, you will need to manually delete the database (.db) 

file from your hard drive or saved location..  
 

1 Click Remove From List. 
 

A warning message appears.  
 
 
 
 
 
 
 
 

2 Click Yes to remove the database from the Database Manager list. 
 

You can add the database again at anytime by using the Add 

Database command. 
 

Open Database 
 

This option allows you to choose a different database and open it 

up to view all saved payroll companies in that particular database. 
 

1 Select the database you want to open and press Open Database. 
 
 

The new database is now open and all companies stored in this 

database are available under the Open Company command under 

the File menu. 
 

Close Database Manager 
 

This option closes the Database Manager window.  
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Open Company 
 

This command allows you to choose a specific company in an 

available database. Once the program is launched, choose 

Open Company from the File menu. Select the database, if 

necessary, then select the payroll company to open and click 

Open Company. 
 

Delete Company 
 

You can also choose to delete a company from the database 

list by going under the File menu and selecting Delete 

Company. Select the company you wish to delete and click the 

Delete Company button. If you delete a set of files in this way, 

they cannot be recovered without a previously saved backup 

archive. 
 

Exiting CheckMark Payroll 
 

To exit or quit CheckMark Payroll: 
 

• Choose Exit from the File menu (Windows) 
 

• Choose Quit from the CheckMark Payroll menu (Mac) 
 

Tips for Navigating Windows Within Payroll 
 

You can enter information in any order you like by clicking in 

each field’s edit box. 
 

To move the cursor from one field to the next field, you could 

click in the field box. However, often the quickest way to move 

the cursor to another field is to press the following keys on your 

keyboard: 
  

Keystroke Result 
  

TAB Next field or control 

SHIFT+TAB Previous field or control 

(While holding down the SHIFT key,  

press TAB)  
  

 

Making Selections in a List Box 
 

While using CheckMark Payroll, you often select items from a list box.  
You can make your selections in the following ways: 

 
• In most list boxes, you can choose a consecutive range of 

items by holding down the SHIFT key while clicking the first 

and last desired items in the list. For example, here is a 

consecutive range of checks selected on the Print 

Paychecks window: 
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•      In most list boxes, you can also select a consecutive range 

of items in a list by dragging through the list to highlight the 

desired items. Simply select the first item in the selection 

and, while holding down the mouse button, move the 

mouse pointer through the list. 
 

• To deselect an item in a list, position your mouse pointer 

over the selected item and click the mouse button. To 

retain other selections in the list while deselecting an item, 

hold down the CTRL key (Windows) or COMMAND key 

(Mac) while clicking the item. 
 

• In some lists, you can make non-consecutive selections by 

holding down the CTRL key (Windows) or COMMAND key 

(Mac) while clicking the desired items in the list. The 

example below shows a non-consecutive range of checks 

selected. 
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Using Drop-Down Lists 

 
Drop-down lists make data entry fast and easy. When you 

click the down arrow button in a drop-down list, a list of 

choices appears:  
 
 
 
 
 
 
 
 
 

 

CheckMark Payroll offers you several ways to quickly find an 

item in a drop-down list. 
 

• Use your mouse to select the item. Drag up or down 

through the list and select a name when it scrolls into 

view. 
 

• Type the first character of the item. This automatically 

selects the first occurrence of the character at the 

beginning of an item name. On Windows, typing the 

character again will select the next item that starts with that 

character. 
 

• Press the UP ARROW or DOWN ARROW keys on your 

keyboard to move through the list. 
 

After the item you want is highlighted, press Enter to enter 

the item into the field. 
 

Converting Old Company Files 
 

In Payroll version 8.2 and higher, a database is used to store 

all company and employee information. Multiple companies can 

be stored in one database or multiple databases can be 

created for each company. This section describes how to use 

the Payroll Company Conversion Wizard if you’re opening data 

from Payroll versions prior to 8.2. 
 

1 Make sure all old Payroll files are closed. Launch the Payroll 

Company Conversion Wizard application. 
 

A Welcome screen appears with details on the conversion 

process and the new database that will be created. You can 

Print these details by choosing the Print button in the upper 

right hand corner. Click Next to continue.  
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2 Choose the company you want to convert. 
 

This screen lists the old company files that are ready to be 

converted. If your company is not listed you may either choose 

the Add Company to List or Find Companies button.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Choosing the Add Company to List button opens a dialog box 

for you to browse to and select the location where you saved 

the old payroll files.  
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The Find Companies button searches your hard drive and 

network drives for all available payroll files that can be 

converted.  
Once the company list is populated, select the company you 

want to convert. You may only convert one company at a time. 

Click Next to continue.  
 

Note If there’s an asterisk (*) by the company’s name, this 

company has already been converted. 
 
 

3 Choose a Database for Saving 
 

Once you’ve chosen a payroll company to convert, you’ll have 

the option of saving the data into the provided Default Payroll 

Company Database or creating one of your own.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The location of the Default Payroll Company Database is: 
 

Windows: 
 

C:\CheckMark\Payroll\2011\Default_Payroll_Company_Database_2001.db 
 

Macintosh: 
 

HD/CheckMark/Payroll/2011/Default_Payroll_Company_Database_2011.db  
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Note You can change the name of the  
Default_Payroll_Company_Database_2011.db after the convert is finished.  
For information on database management, See “Database Manager” on page 7.  

 

Create a New Database 
 

1. To create your own database and/or save a database in a 

new location, choose the Create New Database button. 
 

2. Enter a name for the new database. 
 

3. Change the Year if necessary. 
 

If necessary, change the default location where you want to 

save the database by choosing the Browse button. 
 

4. Click Create to Save the new database. The new database 

should now be included in the list of databases to choose from 

for the final Confirm and Convert stage.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

4 Confirm and Convert 
 

After you have selected the database you want to convert 

your data into, click the Next button. 
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Verify that all information and save location is correct. If 

changes are needed, hit the Back button. 
 

5 Click the Confirm and Convert button.  
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6 Once the conversion is complete and the green complete screen is 

displayed, you may either choose to Convert Another Company or 

Close.  
You may now proceed to open the newly created files in the 

new database with Payroll version 8.2 or higher. For instruction 

on Opening your Payroll company, See “Open Company” on 

page 13. 
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Chapter 2 Sample Company 

 

Starting CheckMark Payroll for Windows and Opening the 

Sample Company 
 
 

Note A sample company is NOT included if you are installing a full 

version for the first time. If you have downloaded a Trial version 

or for any reason would like to see a sample company, contact 

CheckMark and we can send you the database that contains 

the Sample Company for review.  
 

The following steps show you how to start CheckMark Payroll for 

Windows and open a sample company file called PRSample.pr0. If 

you would rather start setting up your own company right away, see 

“Chapter 3 Creating a New Company” on page 25. 
 

1 Once you’ve received the database containing the sample 

company and saved it to your hard drive, launch CheckMark Payroll 

by clicking the shortcut on the desktop or from the Start menu. 
 

2 Choose Open Company from the File menu. If the Sample Co is 

not listed, use the Database Manager to open the correct database 

containing the Sample Company. For information on the Database 

Manager, see “Database Manager” on page 7. 
 

3 Select the PR Sample Co, Inc and click Open Company.  
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4       The PR Sample Co, Inc is now open and all sections are 

      active on the Command Center. 
 
 

Note Do not enter your own company data in the PR Sample Co, 

Inc. You should create a new company if you plan to process 

payroll for your own company.  
 

 

Starting CheckMark Payroll for Macintosh and Opening the 

Sample Company 
 

The following steps show you how to start CheckMark Payroll for 

Macintosh and open a sample company file called PR Sample Co, 

Inc. If you would rather start setting up your own company right 

away, go to “Creating a New Company File” on page 25. 
 

1 Double-click the alias on the dock or desktop. You can also launch 

Payroll by opening the folder where CheckMark Payroll was installed 

and double-clicking on the CheckMark Payroll icon. 
 

2 Select Open Company from the File menu. 
 

3 Select the PR Sample Co, Inc then click Open Company. 
 

4 The PR Sample Co, Inc is now open and all sections are active 

on the Command Center. 
 
 

Note Do not enter your own company data in the PR Sample Co, 

Inc. You should create a new company if you plan to process 

payroll for your own company.  
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Part 2 
 

Setting Up a Company 

 
 

 

Setup of your company’s payroll data set is key to ease of use and 

accuracy in your calculation and reporting. Read through the 

chapters ahead and evaluate each item to determine which items 

will be essential to your company setup. Depending on your 

company’s needs, not all windows in CheckMark Payroll may be 

used. It is recommended that you follow the setup chapters in 

order so that all necessary items are available when setting up 

Employees, Employer Payees and Ledger Accounts. 
 

Some things to consider before starting: 
 

• Do you have an accounting program you wish to post 

payroll to and how do you wish the payroll to post? By 

department? By MultiLedger Job? 
 

• Are there special taxes in your local area that you need to 

verify the setup? How are they reported to the taxing entity? 
 

• Do I have all the documents I need to setup a company; ID 

numbers, SUTA rate, Employee W-4 forms? 
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Steps to Setting Up a Company 
 

The following is a checklist that you can follow for setting up 

your company. 

 

 

Steps for Creating a New  

Company 
 

Create or Open the Database where 

you want to store your company files 
  

Create a New Company file  

 

Setup Company Information and   
select Payroll Year 

 
Setup Departments (optional)  

 
Add the appropriate state tax tables   
and parameters to your company 

 
Enter the State ID and SUTA % for   
each state in which you process a  
payroll 

 
 
 

 

Payroll Screen 

 

Database Manager, under  
the File menu 
 
New Company, under the  
File menu 
 
Company Information 
 
 

Departments 
 

State Tax Values 
 
 

State Tax Values 

 

Setup Local taxes (if required) Local Tax Values  
 

Setup Hour Categories (optional) Hour Categories  
 

Setup Additional Income items Additional Income   
(optional) 

 
Setup Deduction items (optional). Deductions  

 
Setup Employee information Employees  

 
Setup Employer Payees (optional) Employer Payees  

 
Setup Ledger Accounts (optional) Ledger Accounts  
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Chapter 3 Creating a New Company 

 

This chapter shows you how to create a new company file 

and enter basic company information. 
 

Creating a New Company File 
 

1 In Windows, Double click the Payroll shortcut on the Desktop or 

click the Start menu, select Programs, then select CheckMark 

Payroll from the CheckMark Payroll group. 

On Macintosh, Double-click the CheckMark Payroll alias in the dock or 

on your Desktop or double-click the CheckMark Payroll icon located in 

the install folder that was installed on your hard drive. 
 

2 Choose New Company from the File 

menu. The following window appears: 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

3 Select how you want to save the new company. 
 

Save the new company in the currently open database 
 

If you already have created a database already from the database 

manager, you can create a new company in that same database. 
 

Choose an existing database in which to save the new 

company 

If you want to create a new company in a different database 

that you have previously created, choose this option. Once you 

click OK, you’ll be prompted with an Open Dialogue box to 

browse and select the database you want to use. 
 

Create a new database for the company 
 

If you are just starting CheckMark Payroll for the first time or what 

to create a new database for the company, choose this option. 
 
 

Note If this is a first-time setup, you won’t have an existing CheckMark  
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Payroll company to copy from. The sample company that is 

provided contains example information only and it is not 

recommended for copying setup information. If you want to copy 

setup information from an existing CheckMark Payroll company, 

see “Copying From an Existing Payroll Company” on page 27.  
 

4 Click OK. 
 

5 Enter a name Company Name and Trade Name (if applicable).  
 
 
 
 
 
 
 
 
 
 
 

 

An alert appears asking if you want to copy setup data from an 

existing company. See, “Copying From an Existing Payroll 

Company” on page 27 for more information. 
 

6 Finish entering the Company Information. 
 

For more information on the fields on the Company Information 

window, see “Setting Up Company Information” on page 29. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Once you’ve entered the basic Company Information, click Save 

and close the window. All sections should now be active on the 

Command Center.  
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Copying From an Existing Payroll  

Company 
 

When you create a new Payroll Company, you have the option to copy 

certain setup data from an existing CheckMark Payroll company. You 

can copy Income and Deduction Categories, Departments, Hour 

Descriptions, Tax Tables, and Ledger Accounts. 
 
 

Important You can also import employee information. For more information 

on importing employee information, see “Import Employee 

Information” on page 103.  
 

1 Open CheckMark Payroll. 
 

2 Choose New Company from the File menu. 
 

An alert asking if you want to copy setup data from an 

existing company appears. 
 
 

Note The Default Payroll Company Database will be used to save your 

company information. If you wish to use a different database or 

rename the database, see “Database Manager” on page 7. 
 
 
 
 
 
 
 
 
 
 
 

 

3 Click Yes. An Open dialog box appears.  
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:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Note Typically, you would not copy setup information from the “PR 

Sample Co, Inc.” since it contains only example information. 
 
 

4 Select the company you wish to copy information from. Once that 

company is selected, click the New Company button. 
 

5 Begin setting up your Company Information in the Company 

Information window. 
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Chapter 4 Company Information 

 

Setting Up Company Information 
 

Use the Company Information window to enter your starting payroll 

year and basic company information, such as your company’s name, 

address, and federal employer identification number. 
 

1 Click Setup in the Command Center, then select Company Information.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Enter your company’s name and press TAB to move to the next field. 
 

3 Complete all necessary fields and click Save.  
 

Note Press SHIFT - TAB (hold down the SHIFT key and press TAB) to 

move the cursor to the previous field and highlight any 

previously entered information. 
 



30  Chapter 4 Company Information  

 

Items in the Company Information Window 
 

Company Name Enter your company’s legal name. 
 

Trade Name Enter your company’s Trade Name, if any. 
 

Use on Checks &     Check this box if you want the Trade Name you entered to be used 

Reports        on checks and reports. If this box is not checked, CheckMark 

                    Payroll will use your Company Name on checks and reports. 
 

Address Lines 1 & 2         Enter your company’s street address, city, your state’s two- 

         letter postal City, State, Zip abbreviation, and zip code. 
 
 

Note Only Address 1 information prints on Forms 940, 941, 944, and W-2/ 

W-3s; the information in Address 2 will not print on these reports. 
  

Phone Enter your company’s telephone number, including area code. 
 

Federal ID Enter your federal employer identification number. This number 

prints on 940, 941, 944 and W-2/W-3s reports. 
 

Password Enter up to 40 characters for a password if you want to restrict access 

to your company’s files. The password is not case sensitive. For 

example, an upper case “T” is treated the same as a lower case “t.” 

For more details, see “Setting Up a Password” on page 242. 
 

Payroll Year The payroll year you enter appears on checks and reports and 

limits the check dates you can enter. CheckMark Payroll works 

with one year of data at a time. The current year is 

automatically entered based on the year the database is in. 
 

To modify the year, you must create a new database to change it to an 

earlier year. However, you can advance it to the next year with the New Year 

command. For details, see “Starting a New Year” on page 245 
 

Comments The Comments field allows you to type text to keep track of items 

like dates and addresses for filing or other pertinent information 

that might relate to your company. 
 
Company Activity Log Click the Company Activity Log button.  
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This screen displays a list of all activities performed in the payroll 

software. You can filter those activities by Type, Employee and 

Warnings. This helps give an idea of the daily, weekly, monthly, 

etc. transactions that are entered, modified or deleted. 
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Chapter 5 Setting Up Departments 

 
CheckMark Payroll will accommodate up to 99 departments for your 

company’s payroll distribution. Once defined on the Departments 

window, you can assign a default department to an employee and/or 

define the particular departments that an employee’s wages will be 

distributed to on the Employees, Distribute Hours or Allocate Dept/ 

Jobs windows. CheckMark Payroll allows you to create new 

departments, modify or delete existing departments. 
 
 

Note: Tenant Pro    Departments in CheckMark Payroll are Properties in Tenant Pro. 

          Your Users Department list MUST match the Property ID report 

from Tenant Pro in order to post from CheckMark Payroll into 

Tenant Pro. See your Tenant Pro manual for more information. 
 

 

Setting Up Departments 
 

1 Click Setup in the Command Center, then select Departments.  



34  Chapter 5 Setting Up Departments  

 

2 Click New.  
 

3 Enter a name for the department in the edit box, and click 

OK. Department names can be up to 17 characters. 

Modify Departments 
 

1 Click Setup in the Command Center, then select Departments. 
 

2 Select the department from the list. 
 

3 Modify the department name in the edit box. 
 

4 Click Save. 
 

Deleting Departments 
 

You can delete a department provided it is not assigned to 

any employees and has not been used on any existing 

checks. To delete a department: 
 

1 Click Setup in the Command Center, then select Departments.. 
 

2 Select the department from the list. 
 

3 Click Delete. An alert appears asking you to verify that you wish to 

delete the department. 
 

4 Click Yes to delete the department.  
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Chapter 6 Federal Tax Values 
 
 
 

Important While CheckMark attempts to maintain up-to-date and accurate 

tax information, we cannot be responsible for changes or 

discrepancies in tax values. Please check your Circular E, 

Employer’s Tax Guide or state or local tax publication if you are 

in doubt as to the accuracy of any tax value. 
 

CheckMark has an annual tax update to make sure you are kept up to 

date on all the latest tax changes and software changes. See the flyer 

that came with your CheckMark Payroll package or check our web 

site, www.checkmark.com, for more information on updating. 

 
Users of the current year’s version should check online for updates 

and download available patches to make sure they’re always up to 

date. For details about this, see “Software Updates” on page 2. 
 

 

Setting Up Federal Tax Values 
 

When you create a new company, or advance an existing 

company to a New Year, the following federal tax tables and 

parameters are already set up: 
 

• Federal Single 
 

• Federal Married 
 

• Annual W/H Allowance 
 

• FUTA (Federal Unemployment Tax Act) 
 

• Social Security 
 

• Medicare  
 

Note FUTA rate includes the credit of 5.4% for payment of SUTA 

taxes to your state. If your state is a credit reduction state, the 

rate may need to be modified.  
 

You assign the appropriate federal table to each employee on the 

Employees window. see “Setting Up Employee Taxes” on page 78. 
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CheckMark Payroll uses the annual percentage method to 

calculate Federal withholding. To verify the tax tables that your 

company is using for calculation:  
1 Click Setup in Command Center, then select Federal Tax Values.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select the radio button next to the desired table to view. 
 

3 Click the Tax Table button. 
 

To reload the Federal withholding tables and tax parameters in 

the company data files: 
 

1 Select Setup in Command Center, then select Federal Tax Values. 
 

2 Click the Load “year” Values button. 
 

3 When prompted to replace existing values, click OK.  
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Chapter 7 State Tax Values 

 

Setting Up State Tax Values and SUTA Values 
 

Important: While CheckMark Inc attempts to maintain up-to-date 

and accurate tax information, we cannot be responsible for changes or 

discrepancies in tax values. There may also be additional taxes for 

your specific state that will need to be setup and maintained by you. 

Please check your state’s current tax publication if you are in doubt as 

to the accuracy of any tax value. 
 

State taxes, along with the employee’s earnings and 

withholding allowances, determine how much state tax is 

withheld from an employee’s check. 
 

Even if your state doesn’t have a tax table, you still need to 

add your state to the State Taxes list, so you can enter your 

state ID and State Unemployment Tax Authority (SUTA %). 
 

After a state tax has been added to your company, you can 

assign it to an employee on the Employees window. 

see“Setting Up Employee Taxes” on page 78.  
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Adding Pre-defined State Taxes to Your 

Company 
 

CheckMark Payroll accommodates up to 30 state tax tables in 

your State Taxes list. Each employee can be assigned one 

SUTA and one withholding state at a time 
 

1 Click Setup in the Command Center, then select State Tax Values.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Click Load Latest Table...  
 

3 Select one or more states from the list. 
 

Select a state by clicking it in the list or by typing the first letter 

of its name. 
 

If you need to select more than one table, drag through the list 

to highlight the desired names. To select non-consecutive 

states, hold down the CTRL (Windows) key or Command key 

(Macintosh) and click the desired names. 
 

4 Click OK.  
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Note When possible, the Exemption Total or Tax Credit total, if applicable 

for the selected state(s), is calculated for you. If the parameters for 

this calculation cannot be calculated within the program, you will 

receive a an alert advising you to see the information available by 

clicking the Additional Web Information button. This button is a link 

that will launch a page on CheckMark’s website that contains details 

on manual calculators, as well as other information about your state 

taxes. An internet connection is required. If you do not have an 

internet connection, information is available in your state tax guide. 
 

 

Setting Up Your State ID and SUTA Values 
 

After you’ve added the appropriate states to your company, 

do the following: 
 

1 Select a state from the State Taxes list. 
 

If you don’t see the state you need, add it with the Load 

Latest Tables...button. 
 

2 Click in the State ID edit box, and enter your state employer identification 

number. This is the State ID that prints on W-2s. Then press TAB. 
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3 Enter your SUTA % and press TAB. 
 

This is the rate you pay as an employer that has been given to 

you by your state and is based on an experience rating. If the 

state has presented this number as a rate rather than a 

percentage, convert it to a percentage by moving the decimal 

point two places to the right. For example, the rate of .004 

should be entered as .4 in the SUTA % edit box. 
 

4 Verify that the value shown for the Max SUTA Wages is correct. 
 

The Max SUTA Wages amount for the selected state is automatically 

entered; however, you should use your state tax guide or your 

company’s state unemployment report to verify that it’s correct. 
 
 

Note Assigning the State ID, SUTA %, and Max SUTA Wages for a state tax 

table automatically assigns those values to all tables for that state. 
  

5 Click Save in the upper left hand corner.  
 

If you are processing a multistate payroll, repeat steps 1– 5 

for each state. 
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Chapter 8 Local Tax Values 

 

Setting Up Local Tax Values 
 

Important: While CheckMark Inc attempts to maintain up-to-date 

and accurate tax information, we cannot be responsible for changes or 

discrepancies in tax values. There may also be additional taxes for 

your locality that will need to be setup and maintained by you. Please 

check your locality’s current tax publication if you are in doubt as to 

the accuracy of any tax value. 
 

If necessary, local taxes can be configured for your company. 

The local tax tables, along with the employee’s earnings, and 

the number of withholding allowances (if necessary), determine 

how much local tax is withheld from an employee’s check. 

CheckMark Payroll accommodates up to 10 local tax tables, 

but each employee can be assigned only one. 
 

After a local tax has been added to your company, you can 

assign it to an employee on the Employees window. see 

“Setting Up Employee Taxes” on page 78.  
 

Note If you have more than one local tax per employee, you can also set 

up a local tax as a deduction. For instructions on setting up 

deductions see “Creating a New Deduction Category” on page 62. 
 

 

Creating a New Local Tax Category 
 

You can add a new Local tax category if the local tax is a 

Fixed % or Fixed Amount. 
 
 

Note You cannot create a new Local Tax that uses a tax table for calculation.  
 

1 Click Setup in the Command Center, then select Local Tax Values. 
 

2 Click the New button at the top of the screen. 
 

3 Enter a name for the new Local Tax.  
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4 The new Local Tax should now be added to the list of taxes 

available. Highlight the new Local Tax and set up the 

appropriate calculation parameters.  



Setting Up CASDI for California Employees 43  

 

5 Click Save. For assigning a local tax to the employee(s), see “Local 

Taxes” on page 82. 
 

Adding Pre-Defined Local Taxes to Your 

Company 
 

1 Click Setup in the Command Center, then select Local Tax Values.  
 

2 Click Load Latest Values.. 
 

3 Select one or more local taxes from the list. 
 

Select a local tax by clicking its name in the list or drag to 

select consecutive tax names. To select non-consecutive local 

taxes, hold down the CTRL (Windows) key or Command (  ) key 

(Macintosh) and click the desired names.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 Click OK. 
 

Setting Up CASDI for California Employees 
 

California’s State Disability Insurance (CASDI) should be set up 

as a Fixed %. Please verify the current rates with EDD or visit 

the website at www.edd.cahwnet.gov/taxind.htm.  
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Note You can also set up CASDI as a Deduction Category. For more 

information, see “Creating a New Deduction Category” on page 62 
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Chapter 9 Setting Up Hour 

 

Categories 
 

Use the Hour Categories window to set up the types of hours that your 

company uses to calculate pay for hourly employees. You can also set 

up accrued hour categories, such as sick and vacation. 
 

You can define up to twelve hour categories for your 

company; all of which can be used for any employee. 
 
 

Important You should carefully choose the order of the hour categories in the 

Hour Categories list because it determines the order of their 

appearance on the Distribute Hours and Enter Hours windows. 

Setting up hour categories according to their frequency of use with 

the most used hour category first is recommended. 

 
Once you’ve created at least one set of payroll checks or set up 

beginning year-to-date balances with the YTD view mode on the 

Employees window, you should not change the order, delete or 

modify the names since this could adversely affect these balances. 
 
 

CheckMark Payroll comes with several pre-defined hour categories. 

Click the Add from List button in the Hour Categories window for a 

complete list. You can add a pre-defined hour category to your 

company, and then use it as is or change its definition. 
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Adding a Pre-Defined Hour Category to Your Company 
 

1 Click Setup in the Command Center, then select Hour Categories. 
 

2 Click Load from List.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3 Select one or more hour categories from the list  
 
 
 
 
 
 
 
 
 
 
 
 
 

 

4 Click OK.  
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Creating a New Hour Category 
 

If you need an hour category that isn’t pre-defined in 

CheckMark Payroll, use the New button to create a new one. 
 

1 Click New.  
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Enter a name, up to eight characters, for the hour category and click OK.  
 

3 Define the new hour category. 
 

Employee Hourly Rate: Use this drop-down list to select whether Hour 

Rate 1, 2, 3, or 4 should be used for the hour category. The hourly rate 

is assigned to each employee on the Employees window. 
 

Multiplier: Use this drop-down list to select the multiplier (1, 1.5, 

2, 0.5) by which an employee’s hourly rate should be multiplied. 

 
For example: Regular would be defined as Hour Rate 1 x 1. 

Overtime would be defined as Hour Rate 1 x 1.5. Employee 

Brian makes $8/ hour. Regular hours would be paid at $8/hour 

(1 x $8) and overtime at $12/hour (1.5 x $8). 
 

Use in Calculations Based on Hours Worked: Check this option if the 

hours in this category should be included for income and deduction 

calculations based on Fixed Amount/Hour Worked. An example would 

be Labor & Industry taxes in the state of Washington. 

 
You should also check this option if you plan on accruing hours such 

as vacation or sick based on hours worked. For example, you wish to 

accrue vacation on regular hours worked. Check this option on 

Regular so that each hour worked by those employees would accrue 

vacation on them at the rate set on the Employee window. 
 

4 Click Save.  
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Modifying an Hour Category 
 

Once you have created at least one check or setup YTD balances on the 

Employee window, modifying an hour category is NOT recommended 

since it could adversely affect balances. 
 

1 Click Setup in the Command Center, then select Hour Categories. 
 

2 Select the hour category from the Hour Categories list. 
 

3 Use the Employee Hourly Rate and Multiplier drop-down lists to 

change the hour category’s definition. 
 

4 Click Save.  
 

 

Deleting an Hour Category 
 

You can delete an hour category as long as there are no employee 

checks or employee year-to-date balances associated with it. 

 
Important Once you’ve created at least one set of payroll checks or set up 

beginning year-to-date balances with the YTD view mode on the 

Employees window, you should not change the order, delete or 

modify the names since this could adversely affect these balances. 
 

1 Select the hour category from the Hour Categories list. 
 

2 Click Delete.  
 

CheckMark Payroll asks you to verify that you want to delete 

the hour category. 
 

3 Click Yes.  
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Chapter 10 Setting Up Additional 

 

Income 
 

The Additional Income window allows you to set up the types of 

income, such as mileage or tips, that your company uses in 

addition to a salary or hourly wages to calculate an employee’s 

pay. You can set up your own or add pre-defined categories 

which can be modified if need be.  
 

Note You can assign ledger accounts to each Additional Income category 

for transferring or posting Additional Income amounts to an accounting 

system. See “Chapter 14 Setting Up Ledger Accounts” on page 97. 
  

You can add up to 40 Additional Income categories for your 

company and assign up to eight per employee. 
 

Once set up on the Additional Income window, a category can 

be assigned to an employee on the Employees window. See 

“Setting Up Employee Additional Income” on page 83.  
 

Important Do not delete any Additional Income categories once the first 

check for the year has been created. The only time a category 

should be deleted is after the New Year file has been created, 

but before any checks have been created.  

 

Important Do not change the tax status on any Additional Income category 

once the first check of the year has been created. To make a 

change to the tax set up mid year, stop the category from being 

applied by simply modifying the amount/rate to zero. Then create a 

new category with the correct tax set up to be applied.  
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Adding Pre-Defined Additional Income Categories to Your 

Company 
 
 

Important Pre-defined incomes are setup using general tax guidelines. 

Verify the tax setup with current tax laws including your state 

and/or locality. You can modify any pre-defined income.  
 

1 Click Setup in the Command Center, then select Additional Income.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Click Load from List... 
 

3 Select one or more categories from the list.  
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4 Click OK.  
 

Creating a New Additional Income Category 
 

If you need an Additional Income category that’s not pre-

defined, use the New button to create a new one. 
 
 

Note When adding a new income (not applicable for Variable 

calculation) or modifying a rate or amount, you will be 

prompted to “Change Amount/Rate for all employees assigned 

this income category?” when you click Save. If this is a new 

income category setup, selecting either Yes or No will have no 

effect. If you modify an existing income category: 
 

- Clicking Yes overrides any specific amount entered on the 

Employees window to the amount/rate entered and saved on the 

additional Income window. 
 

- Clicking No leaves the specific amount entered on the 

Employees window. 
 
 

1 Click Setup in the Command Center, then select Additional Income. 
 

2 Click New.  
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3 Enter a name, up to 12 characters long, for the category and click OK. 
 

4 Select the calculation method for the Additional Income 

category. See “Calculation Methods” on page 54. 
 

5 Define the Additional Income parameters. For more information on 

what each parameter means, See “Items in the Additional Income 

Window” on page 54.  
 

Tip If the rate/amount of the Additional Income is the same for ALL 

employees - enter the rate/amount in the edit box on this 

window. Then, that amount will be entered on the Calculate 

Pay window for all employees you assign the Additional Income 

to on the Employees window. 
 

If the rate/amount of the Additional Income is different for each employee - 

enter zeroes on this window. Then, modify the rate/amount on the 

Employee window when you assign the income to the employee. 
  

6 Click Save when you have finished defining the category. 
 

 

Modifying an Additional Income Category  
 

Important Do not change the tax status on any Additional Income category 

once the first check of the year has been created. To make a 

change to the tax set up mid year, stop the category from being 

applied by simply modifying the amount/rate to zero. Then create a 

new category with the correct tax set up to be applied.  
 

1 Click Setup in the Command Center, then select Additional Income. 
 

2 Select the category from the Additional Income list. 
 

3 Make the necessary changes to the category’s definition.   
4 Click Save.  
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5 When modifying a rate or amount, you will be prompted to change 

for all employees. Select yes or no. 
 
 
 
 
 
 
 
 
 
 
 
 

 

Yes Clicking Yes overrides any specific amount entered in the Employee 

Set Up window under the employees Income Tab screen 
 

No Clicking No le aves the s pecific am ount i n th e Empl oyee  Set Up wi ndow 
 

under the employees Income Tab screen as previously entered 
 

1 Example 1: You update the amount of mileage reimbursement from .445 

cents/mile to .565 cents/mile in the Additional Income window and click 

Save. When prompted to Change Amount/Rate, clicking Yes will update all 

employees that have the mileage category assigned and update those 

values regardless of what value was entered previously. 
 

2 Example 2: You set up a category for commissions based on percent of sales. 

Each employee this applies to might have their own specific amount. When 

saving this category, selecting No upon this Change Amount/Rate screen, all 

values entered in the Employee Set Up screen under the Income tab will 

remain and each person will continue to have specific amounts. 
 
 

Note If no employees have this category assigned to them in the 

Employee Set Up window, selecting Yes or No will have no effect 
 

 

Deleting an Additional Income Category 
 

You can delete an Additional Income category as long as there 

aren’t any employee checks or year-to-date balances 

associated with it and it is not assigned to any employees.  
 

Important Do not delete any Additional Income categories once the first 

check for the year has been created. The only time a category 

should be deleted is after the New Year file has been created, 

but before any checks have been created.  
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1 Click Setup in the Command Center, then select Additional Income. 
 

2 Select the category from the Additional Income list. 
 

3 Click Delete.  
 

CheckMark Payroll asks you to verify that you want to delete the  
Additional Income category. 

 
4 Click Yes to delete the category.  

 

Items in the Additional Income Window 



 
 

 

Variable 
Amount 

 
 
 

 

Fixed Amount per Pay 

Period, Hour Worked, 

1st Chk of Month, or 

1st Chk of the Quarter 
 
 
 
 
 
 
 
 
 

 

Fixed % of Sales 
 
 
 

 

Apply to 
Wages 

 
 

Calculation Methods 
 
Amount paid to an employee varies with each pay period. If this option 

is selected, the amount that appears on the Calculate Pay window will 

always be 0.00 until you override and enter the amount of the 

additional income. 
 
Select Fixed Amount per Pay Period if the amount paid to an employee 

is the same each pay period. Select Fixed Amount per Hour Worked, if 

the amount paid to an employee is multiplied by the number of hours 

worked that pay period. Hour Categories defined with Use in 

Calculations Based on Hours Worked are used in this calculation. 

Select Fixed Amount per 1st Check of Month if the amount paid to an 

employee is the same each month. The amount will be added to the first 

paycheck created for the month. Select Fixed Amount per 1st Check of 

the Quarter if the amount paid to an employee is the same each 

quarter. The amount will be added to the first paycheck created for the 

quarter. 
 
There are two ways to handle a Fixed Amount income category: 
 
Select Fixed % of Sales if the Additional Income should be calculated as a fixed 

percentage of an employee’s total sales, such as a commission. The value 

entered here should be a percent, not a decimal value. For example, a decimal 

value of .015 should be entered as 1.5. 
 
With option Fixed % of Sales selected, select Apply to Wage check 

box if the Additional Income should be calculated as a fixed 

percentage of an employee’s total wages. The value entered should 

be a percent, not a decimal value. For example a decimal rate of .015 

should be entered as 1.5. 
 
There are two ways to handle a Fixed % of Sales or Fixed % of Wages 

income category: 
 
If the Fixed % is the same for all employees: 
 
You can enter the rate/amount in the edit box on this window.
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If the Fixed % is the different for each employee: 
 

You can modify the amount for each employee on the Income tab of 

the Employee Setup window. For more information, see “Setting Up 

Employee Additional Income” on page 83. 
 

Mileage Amount         Select Mileage Amount/Mile if the Additional Income should be 

Per Mile calculated on the number of miles an employee drives. 
 

Once you’ve assigned the category to an employee, you can enter 

the number of miles on the Calculate Pay window. 
 

Piecework Rate Select Piecework Rate if the Additional Income should be calculated 

on a rate an employee receives for a quantity you enter. 
 

Once you’ve assigned the category to an employee, you will enter 

the number of pieces on the Calculate Pay window. 
 

Other Options 
 

Omit from Net Check this option if the income category should only be added to an 

employee’s wages for taxing purposes but not included in the net of 

the employee’s check. An example where this would be used is 

Reported Tips. Incomes with this selected will not post into your 

accounting program. 
 

Include in Wages for  Check this option if the income category amount should be        

included in Dept/Job Posting the Department or Job wage distribution 

when posting to your 

accounting program. 
 

Tip Income Options 
 

You can check either Allocated Tip or Reported Tip but not both.  

 
Important When either Reported Tip or Allocated Tip is checked, other checkboxes, such as 

Tax Status options, are automatically set. However, you should verify these 

settings according to current tax laws. 
  

Allocated Tip Check Allocated Tip if the income should not be included in net pay 

nor subject to any employee withholding taxes. The Allocated Tip 

amount will appear in the Allocated Tips box of the employee’s W-2 at 

year end.  
Reported Tip Check Reported Tip if the income should not be included in net pay, but is 

subject to Social Security and Medicare, federal, state, and local withholding 

taxes. Reported tips are also subject to employer taxes. 
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Exempt From Options 
 

By checking the appropriate options, you can classify an Additional 

Income category as exempt from any combination of the following taxes: 

See your Circular E, Employer’s Tax Guide, state or local tax guide to 

determine the correct handling of individual income items. While all 

Additional Income categories will appear as part of Gross Wages, how 

they are reported on reports such as Form 941, State Wages Summary or 

W-2 Statements is determined by your setup here. 
 

Federal Tax Check Federal Tax if the income should be exempt from 

Federal Withholding tax. 
 

Social Security Check Social Security if the income should be exempt from 

Social Security Withholding. 
 

Medicare Check Medicare if the income should be exempt from 

Medicare Withholding. 
 

FUTA Check FUTA if the income should be exempt from 

Federal Unemployment tax. 
 

State Tax Check State Tax if the income should be exempt from 

State Withholding tax. 
 

SUTA Check SUTA if the income should be exempt from State  
Unemployment tax. 

 
Local Tax Check Local Tax if the income should be exempt from 

Local Withholding tax. 
 

Deduction (%) Check Deduction (%) if the income should not have a Fixed % 

Deduction item applied to it. For example, you may not want to take a 

401(k) deduction out of a bonus. Setting this up in CheckMark Payroll 

is a two-step process. The following instructions explain how: 
 

Step 1—Set up the Additional Income Item 
 

1 Highlight an Additional Income item in the list. 
 

You can also click Add from List to add an Additional Income 

item, or click New to create one from scratch. 
 

2 Check the Deduction (%) option in the Exempt From list. 
 

3 If necessary, continue setting up the Additional Income item. 

Then, when you're finished, click Save. 
 

4 Close the window. 
 

Step 2—Set up the Deduction Item 
 

1 Click Deductions in the Command Center. 
 

2 Highlight an existing Fixed % Deduction item in the list.  
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You can also click Add from List to add a Deduction item, or 

click New to create one from scratch. 
 

3 Choose Wages-Exempt Income from the Apply to drop-down list. 
 

4 If necessary, continue setting up the Deduction item. Then, 

when you're finished, click Save. 
 

5 Close the window. 
 

See your Circular E, Employer’s Tax Guide or state tax guide to 

determine the correct handling of individual income items. 
 

W-2 Options 
 

Box 10-Dependent Check this option if you want the Additional Income amount to print 

in Care Benefits Box 10, Dependent Care Benefits, on the W-2. 
 

Box 11 Check this option if you want the Additional Income amount to print 

in Box 11, Non-Qualified Deferred Compensation, on the W-2. 
 

Sec 457 Check this option if you have selected Box 11 and the non-

qualified deferred compensation is a section 457(b) plan. 
 

Box 12 Check this option if you want the Additional Income’s code and amount to 

print in Box 12 of the W-2 Statement. A Code must also be entered when 

this is selected. Refer to the Instructions for Form W-2 from the IRS for the 

code to be entered here. Codes are entered as capital letters. 
 

Box 12 Code Enter the one-letter code using a capital letter. Refer to the “Instructions for 

Form W-2” section of the IRS publication Federal Employment Tax Forms 

for guidelines about what codes to use for Box 12. 
 

Box 14-Other Check this option if you want the Additional Income category’s 

amount and description to be included in Box 14 on the W-2 form. 
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Use the Deductions window to setup deductions from employee’s pay 

in addition to setting up tax categories. Depending on your location, 

deductions can be setup for special tax categories required to be 

withheld. CheckMark Payroll allows you to add pre-defined 

deductions, create new deductions, modify existing deductions or 

delete deductions not being used in the Deduction list. Pre-defined 

deductions can be modified once they are in the Deduction list. 
 
 

Note You can assign ledger accounts to each Deduction category for 

transferring or posting Deduction amounts to an accounting system. 

See “Chapter 14 Setting Up Ledger Accounts” on page 97. 
  

You can define up to 60 Deduction categories for your 

company and assign up to 16 per employee. 
 
 

Important DO NOT delete any Deduction categories once the first check 

for the year has been created. The only time a category should 

be deleted is after the New Year file has been created, but 

before any checks have been created. 
 

DO NOT change the tax status on any Deduction category 

once the first check of the year has been created. To make a 

change to the tax set up mid year, stop the category from being 

applied by simply modifying the amount/rate to zero. Then 

create a new category with the correct tax set up to be applied.  
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Adding Pre-Defined Deduction Categories to Your Company 
 

1 Click Setup in the Command Center, then select Deductions.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Click Load from List....  
 

3 Select one or more categories from the list.  
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4 Click OK.  
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Important Pre-defined Deductions are setup using general tax guidelines. 

Verify the tax setup with current tax laws including your state 

and/or locality. You can modify any pre-defined deduction.  

 

Creating a New Deduction Category 
 

If you need a Deduction category that’s not pre-defined, use 

the New button to create a new one. 
 

1 Click Setup in the Command Center, then select Deductions.  
 

2 Click New. 
 

3 Enter a name for the category, up to 12 characters, and click OK.  
 
 
 
 
 
 
 
 
 
 
 

 

4 Define the Deduction parameters. For further description of each 

parameter see “Items in the Deductions Window” on page 64. 
 

5 Click Save when you’ve finished defining the category.  
 

6 You will be prompted to change selected items for all employees 

assigned this deduction. Click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Change All pop up message: For each checkbox marked, the 

number entered in the Employee Setup under the Deductions 

tab will be overridden to the number set in this screen.  
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Example: A 401(k) annual deduction limit has changed for the 

payroll year and you modify the limit amount and hit the Save 

button. When the Change All pop up box comes up, select the 

Limit Amount checkbox the click OK. You will only have to 

modify any employee with a different limit amount rather than, 

most likely, the majority of employees. 
 

Modifying a Deduction Category  
 

Important Do not change the tax status on any Deduction category once 

the first check of the year has been created. To make a change 

to the tax set up mid year, stop the category from being applied 

by simply modifying the amount/rate to zero. Then create a 

new category with the correct tax set up to be applied.  
 

1 Click Setup in the Command Center, then select Deductions. 
 

2 Select the category from the Deduction list. 
 

3 Make the necessary changes to the category’s definition. 
 

4 Click Save.  
 

5 You will be prompted if the deduction values (Rate/Amount, Limit 

Amount, or Employer Match Amount) should apply to all employees 

assigned the deduction. Select the appropriate check boxes and 

click OK to make changes for all employees using the deduction. 
 

Deleting a Deduction Category 
 

You can delete a Deduction category as long as there are no 

employee checks or year-to-date balances associated with it 

and it is not assigned to any employees.  
 

Important Do not delete any Deduction categories once the first check for 

the year has been created. The only time a category should be 

deleted is after the New Year file has been created, but before 

any checks have been created.  
 

1 Click Setup in the Command Center, then select Deductions. 
 

2 Select the category from the Deduction list. 
 

3 Click Delete.  
 

CheckMark Payroll asks you to verify that you want to delete the  
Deduction category.   

4 Click Yes to delete the category.  
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Items in the Deductions Window 
 
 

 

Variable Amount 
 
 
 

 

Fixed Amount per Pay 

Period, Hour Worked, 

1st Chk of Month, or 

1st Chk of the Quarter 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fixed % 

 
 

Calculation Methods 
 
Select Variable Amount if the Deduction amount for an employee 

varies with each pay period. If this option is selected, the amount 

that appears on the Calculate Pay window will always be 0.00 

until you override and enter the amount of the deduction. 
 
Select Fixed Amount per Pay Period if the deduction amount is 

the same each pay period. Select Fixed Amount per Hour 

Worked if the amount deducted from an employee is multiplied 

by the number of hours worked of that pay period. Hour 

categories defined with the option to Use in Calculations Based 

on Hours Worked are used in this calculation. 
 
Select Fixed Amount per 1st Chk of Month if the deduction 

amount is the same each month. The income will be deducted 

from the first paycheck created for the month. 
 
Select Fixed Amount per 1st Chk of Quarter if the deduction 

amount is the same each quarter. The income will be deducted 

from the first paycheck created for the quarter. 
 
There are two ways to handle a Fixed Amount deduction category: 
 
If the Fixed Amount is the same for all employees: 
 
You can enter the amount in the edit box on this window. This 

amount will be entered automatically on the Calculate Pay 

window for all employees who are assigned this deduction. 
 
If the Fixed Amount is the different for each employee: 
 
You enter 0.00 here and modify the rate/amount for each employee on 

the Deduction tab of the Employee Setup window. For more 

information on this, see “Setting Up Employee Deductions” on page 85. 
 
Select Fixed % if the amount deducted from an employee is 

calculated as a percentage of their wages. You can have this Fixed 

% be deducted from total wages, federal withholding wages, state 

withholding wages, Wages-Exempt Income, or SUTA wages by 

selecting the appropriate option from the Apply to: drop down list. 

The value entered here should be a percent, not a decimal value. 

For example, a decimal value of .015 should be entered as 1.5. 
 
There are two ways to handle a Fixed % deduction category: 
 
If the Fixed % is the same for all employees: 
 
You can enter the amount in the edit box on this window. This amount 

will be entered automatically on the Calculate Pay window for all 
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employees who are assigned this deduction. 
 

If the Fixed % is the different for each employee: 
 

Enter 0.00 here and modify the rate/amount for each employee on the 

Deductions tab of the Employee Setup window. For more information 

on this, see “Setting Up Employee Deductions” on page 85. 
 
 

Note If you have a deduction based on disposable wages you will 

need to choose Disposable Wages under the drop down for 

Apply to. This basic setup is subtracting all deductions required 

by law (Federal, State, Local, SS and Med are already 

included) from the employee’s gross earnings.  
There are certain rules and situations on what is to be included or 

not included. For example, tips are not included for disposable 

earnings while state unemployment or disability tax is included. 

The Deduction and Additional Income setup screens both contain 

a checkbox for Include in Disposable Wages Calculations to 

include the calculation of disposable wages.  

 

Deduction Limit Options 
 

Limit Type You can set the Limit Type for a deduction defined as Fixed 

Amount (per Pay Period, 1st Check of Month, or Hour Worked) or 

Fixed % by selecting the appropriate Limit Type from the pop-up 

list. You can choose a deduction limit type of Annual Wages, Loan 

Amount, Annual Deduction Amount, Pay Period, or Monthly.  
 

Note As with the calculation methods in the last section, if the limit 

amount is the same for all employees, enter the amount in this 

screen. If it is a different amount for each employee, insert 0.00 

in this screen and modify the deduction limit amount in the 

Employee Setup under the Deduction tab.  

 

• If you choose Annual Wages as the Limit Type, the 

deduction will be taken out of the employee’s pay each pay 

period until the employee’s annual wages meet or exceed 

the amount you enter in the edit box or the limit setup in 

the Deduction tab of the Employee Setup. 
 

• If you choose Loan Amount as the Limit Type, the deduction 

will be taken out of the employee’s pay each pay period until 

the loan amount you enter in the edit box is reached. 
 

• If you choose Annual Deduction Amount as the Limit Type, the 

deduction will be taken out of the employee’s pay until the 

annual deduction limit you enter in the edit box is reached. 
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• If you choose Pay Period as the Limit Type, the deduction 

will be taken out of the employee’s pay up to the maximum 

deduction limit for the pay period. 
 

• If you choose Monthly as the Limit Type, the deduction will 

be taken out of the employee’s wages for each paycheck of 

the month until the deduction limit you enter in the edit box 

is reached for the month.  
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Employer Match Options 
 
Employer Match Type You can set the matching type for a deduction by selecting either 

Fixed Amount, Fixed %, or Hour Worked from the drop down list. 
 

Amount/Rate Enter the amount or rate for the employer match. If you have 

Fixed Amount or Hour Worked selected as the Employer Match 

Type, the amount you enter in the Amount/Rate edit box is 

treated as a dollar amount. 
 

If you have Fixed % selected as the Employer Match Type, the amount 

you enter in the Amount/Rate edit box is treated as a percentage of the 

employees wages. The rate entered can be modified for each employee 

in the Deductions tab in Employee Setup. 
 

Wage Limit If necessary, enter the employee wage at which the employer 

match should stop calculating. This cannot be entered or 

overridden in the Employee Setup. 
 
Match if No Employee          Use this box if a deduction has no employee portion, but 

should still Deduction have an employer portion. An example 

of using this box is for California’s ETT, Employer Training 

Tax. ETT does not have an employee deduction, but does 

have a Fixed % the employer contributes, so the Match if no 

Employee Deduction box should be checked. 
 

Deduct Before Options 
 

By checking the appropriate options, a deduction will be 

deducted before the following taxes: 
 

• Federal Tax 
 

• Social Security 
 

• Medicare 
 

• FUTA 
 

• State Tax 
 

• SUTA 
 

• Local Tax 
 

See your Circular E, Employer’s Tax Guide or state tax guide to 

determine the correct handling of individual deduction items. 
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W-2 Box Selections 
 

You should refer to the “Instructions for Form W-2” section of the 

IRS publication Federal Employment Tax Forms for guidelines 

about where deductions and codes should print on W-2s. 
 

Box 10 - Dependent         Checking causes the year-to-date total for the dependent care 

benefits Care Benefits deduction to appear in Box 10 of an 

employee’s W-2. 
 

Box 12 Checking causes the deduction’s code and amount to be 

included in Box 12 on a W-2 form. 
 

Box 12 - Code Check this option if you wish the Deduction amount to print in Box 

12 of the W-2. A Code must also be entered when this is selected. 

Refer to the Instructions for Form W-2 from the IRS for the code to 

be entered here. Codes are entered as capital letters. 
 

Box 14 - Other Checking causes the deduction’s name and amount to be 

included in Box 14 on a W-2 form. 
 

Box 18 - 20       Check this option if you wish the Deduction and description to 

print in Local Tax Boxes 18-20 - Local Tax. Wages reported in      

box 18 are YTD wages even if the deduction was created and 

assigned mid-year.  
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The items you assign to individual employees will have been set 

up previously in the prior sections. If you have not setup all 

items you will need, for example deductions, additional incomes, 

etc., set those up prior to setting up the employees. 
 

CheckMark Payroll does NOT limit the number of employees in 

your company. The number of employees in the employee list is 

displayed in the Number of Employees: field.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Using the Employee View Tabs 
 

View tabs allow you to quickly access different information 

about an employee. 
 
 
 
 
 

 

Viewing different information about your employees is as 

easy as clicking the appropriate tab. 
 

      Personal Use this view tab to enter information such as name, address, social  
        security number, employee #, and default department. 

 
Wages Use this view tab to set up wage information, such as salary or 

hourly rate, pay frequency, hire/terminate dates, last raise 

date, and department/job distribution percentages.  
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Taxes Use this view tab to set up an employee’s W-4 options, advance 

EIC payments, and federal, state, and local tax withholdings. 
 

Income Use this view tab to assign up to eight Additional Income 

categories to an employee. 
 

Deductions Use this view tab to assign up to 16 Deduction 

categories to an employee. 
 

Accrued Hours Use this view tab to assign up to three accrued hour categories, 

such as sick or vacation, for an employee. Employees can earn 

a set amount by month, year, hour worked or pay period. 
 

YTD Use this view tab to enter an employee’s beginning year-to-date 

balances for wages, Additional Income categories, Deduction 

categories, and taxes, if necessary. For more information, see 

“Setting Up Employee YTD Balances Mid Year” on page 89. 
 

How to Set Up an Employee 
 

Since the employee list is available in all view tabs, you can set 

up your employees in one of three ways: 
 

• Set up all your employees within the same view tab and 

then select the next view tab. 
 
 

Important SUTA State must be selected for each employee before saving employee 

information or a default SUTA State will be assigned to the employee. 

 
The default state will be the state you have setup in the 

Company Information window. If you don’t have a state setup in 

Company Information, the default will be the first state listed in 

the State Taxes Setup. If you don’t have any states setup in the 

State Taxes Setup, you will not be able to save any information 

in the Employee Setup other than Personal Information.  

 

• Set up an employee completely within all the view tabs 

and then start setting up the next employee. 
 

• Import employees personal or wage information from another 

software program. For more information on importing employee 

information, see “Import Employee Information” on page 103 
 

Setting Up a New Employee 
 

You can start setting up a new employee from within any of 

the view tabs on the Employees window. 
 

1 Click Setup in the Command Center, then select Employees.  
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2 Click New in the tool bar.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3 Enter the employee’s first name and press TAB.   
4 Enter the employee’s last name and click OK or press ENTER.  

 

Warning Punctuation marks such as a comma (,) in an employee’s name 

for items such as suffixes can cause errors when posting payroll 

information into certain accounting programs.  
 

The employee’s name is added to the employee list. 
 

You can either continue setting up the employee in the 

current view mode, or you can change to another view mode. 
 

Saving an Employee’s Setup 
 

Click Save to update the employee’s record when you’ve 

finished setting up an employee. 
 
 

Click Save when you’re finished 

 updating an employee.  
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If no SUTA State is selected, an alert appears reminding you 

that a SUTA State has not been selected and a default SUTA 

State will be assigned to the employee  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Note You will not be able to setup your employees until your 

company state tax tables are setup. 
 

 

Deleting an Employee  
 

Note You can mark a terminated employee as inactive by checking the 

Inactive checkbox on the Personal view tab. When you start the new 

year, employees marked as Inactive are automatically deleted. 
  

You can delete an employee as long as there aren’t any 

year-to-date balances associated with the employee. 
 

To delete an employee, do the following: 
 

1 Click Setup in the Command Center, then select Employees. 
 

2 Select the Personal view tab. 
 

3 Select the employee from the employee list. 
 

4 Click Delete.  
 

CheckMark Payroll asks you to verify that you want to 

delete the employee. 
  

5 Click Yes to delete the employee.  
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Setting Up Employee Personal Information 
 

1 Select the Personal view tab on the Employees window. 
 

2 Select an employee from the employee list. 
 

If you are setting up a new employee, click New in the tool bar.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3 Enter the personal information for employee. 
 

4 Click another view tab after you’ve finished entering the employee’s 

personal information to continue setting up the employee, or click 

Save, after assigning a SUTA State on the Taxes View Tab. 
  

Fields in the Employee Personal View Tab 
 

First Name For a new employee, click the New button in the tool bar to 

enter the employee’s first name, up to 15 characters. 
 

Last Name For a new employee, click the New button in the tool bar to 

enter the employee’s last name, up to 20 characters. 
 

Address Lines 1 The address that you enter (including City, State, and Zip) will 

appear on the employee’s paychecks and W-2s. 
 

Address Line 2 This is the employee’s delivery address. Address Line 2 will 

accommodate up to 30 characters. If both Address Line 1 and Address 

Line 2 are filled in, both lines will print on employee checks and reports. 
 

City Enter the employee’s city up to 25 characters. 
 

State & Zip Enter the 2-letter postal code for the state and the 5-digit ZIP code. 

The ZIP code field can also accommodate the 4-digit extension. 
 

Social Security        Enter the employee’s social security number. You must 

      include the Number hyphens. 
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Email Address Enter the employee’s email address to send the employee’s paycheck 

stub to them electronically.You can enter up to 40 characters. 
 

Phone Number Enter the employee’s phone number, including an area code. 
 

Birth Date Enter the employee’s birth date in the MM/DD/YY format. 

However, you do not need to enter any leading zeros. For 

example, enter March 7, 1960 as 3/7/60. 
 

Employee # The employee number must be greater than 0 and can 

accommodate up to 6 digits. If assigned, an employee’s number 

will print on the check stub. 
 

Tip: In states such as CA that don’t allow the full social security number 

to print, you can have the last 4 digits print or use a unique employee 

number. You can use the last 4 digits of the social security number as 

the employee number and this will print on the paycheck stub under the 

employee name. Use the Suppress SS# Print option located in the Print 

Paychecks screen to completely suppress the Social Security number. 

For information on sorting employee lists and reports by employee 

number, see Chapter 21, Setting Preferences. 
 

Department The department assigned here will determine which department heading the 

employee will appear under in lists and reports. Employee wages will default 

to this department for posting and department reports. 
 

Inactive        Choose this option for employees that no longer work but have YTD 

(Deleted when balances. Inactive employees (such as terminated        

employees) appear  
Creating New Year) after active employees in employee lists and reports and are 

marked by an asterisk (*) preceding their names. 
 

You can print W-2s for inactive employees and inactive employees 

are included in the employee count for W-3s when in the previous 

year. When you start the new year, all inactive employees are 

automatically deleted from your new year company files. 
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Direct Deposit Paycheck 
 

Setup these options if you wish to use either ACH Direct Deposit 

through your own financial institution or Web Direct Deposit 

through National Payment Corporation. For more information, see 

“Using CheckMark Payroll for ACH Direct Deposit” on page 247. 
 

Direct Deposit Check this option for employees set up for either Direct Deposit with 

your own financial institution or for Web Direct Deposit through 

National Payment Corporation. You should contact your financial 

institution for more information on getting set up for direct deposit. 

Once you are set up with your financial institution, see “Using 

CheckMark Payroll for ACH Direct Deposit” on page 247. For more 

information on signing up for Web Direct Deposit, please contact 

National Payment Corporation at www.directdeposit.com. 
 

Prenote Check this option if the employee is joining an existing direct deposit 

program. Prenote is used to test that the routing and account 

information go through the electronic banking system without problems. 

Prenoting an employee will zero their direct deposit check, but you are 

able to print a check for the employee on the Print Paychecks window. 
 

Checking/Savings Select either Checking or Savings on the drop-down list depending on 

the type of account the employee is depositing into. If the employee is 

depositing into 2 accounts, this will need to be set on each account. 
 

Routing #1 Enter the 9-digit routing number for the employee’s account. If 

the employee is depositing into 2 accounts, this is the routing 

number to the account that the remainder of the paycheck will 

be deposited. Account #2 has a specified amount entered. 
 

Account #1 Enter the account number for the direct deposit. Up to 16 

digits are accommodated in this field. 
 

Routing #2 Enter the 9-digit routing number for the employee’s account. 
 

Account #2 Enter the account number for the employee’s account. 
 

Acct. #2 Amount Enter the amount that is to be deposited in the second account. The 

remainder of the paycheck will be direct deposited into Account #1. 
 

Routing #3 Enter the 9-digit routing number for the employee’s third account. 
 

Account #3 Enter the account number for the employee’s account. 
 

Acct. #3 Amount Enter the amount that is to be deposited in the 3rd account. The 

gross amount of the check must cover all allocations or any 

remainder will be allocated to Account 1.  
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Setting Up Employee Wages 
 

1 Select the Wages view tab on the Employees window.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2 Select an employee from the employee list if one is not already selected. 

 
3 Enter the amount of salary that the employee receives each pay period 

in the Salary per Pay Period edit box if the employee is salaried. 
 

4 Enter the amount per hour in the Hour Rate 1 edit box if the 

employee is paid by the hour. 
 

An employee can be paid up to 8 different hourly rates. These 

hourly rates, along with the hour categories set up on the Hour 

Categories window, are used to calculate wages for hourly 

employees. For details about hour categories, see “Chapter 9 

Setting Up Hour Categories” on page 45.  
 

Note Don’t enter hourly rates, such as overtime or double-time, since 

these are defined on the Hour Categories window. 
 
 

5 Select how often the employee is paid from the Pay Frequency 

drop-down list. 
 

6 Continue entering employment information, such as the employee’s hire 

date, last raise date, and department/job distribution percentages. 
 

7 Click another view mode to continue setting up the employee or 

click Save after you’ve finished entering the employee’s wage 

information and assigning a SUTA State on the Taxes View Tab. 
 

Items in the Wages View Tab  
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                      Salary per If the employee is paid a salary, enter the amount 

    that the employee Pay Period receives each pay period. 
 

Hour Rate 1, 2, 3 & 4 If the employee is paid by the hour, enter the amount per hour in 

the edit box. You don’t have to enter .00 for whole dollar rates. 
 

Hour Categories and Hour Rate 1-4 calculate together to 

determine gross wages for an hourly employee. Hour 

Categories are set up on the Hour Categories window. 
 

Pay Frequency Use this drop-down list to choose how often the employee is 

paid. You can choose Daily, Weekly, Bi-Weekly (every two 

weeks), Semi-Monthly (twice a month), Monthly, Quarterly, 

Semi-Annually (twice a year) and Annually. 
 

Hire Date Enter the date that the employee was hired. 
 

Last Raise Date Enter the date that the employee last received a raise. 
 

Termination Date Enter the date that the employee’s employment ended. 
 

Comments Use this text area for recording comments (such as dates of pay 

raises or prior pay rates) about the employee. 
 

Department/Job       You can distribute an employee’s pay to as many as 10 

                                departments or Distribution % MultiLedger Jobs by 

                                percentages. Percentages are automatically  
assigned based on the number of departments or Jobs assigned. 

For example, if two departments are assigned, the distribution 

percentage is 50% for each department. If the percentages are 

incorrect, you can click Modify Percentages and enter the correct 

values. The sum of the percentages must equal 100%. 
 

Percentage distributions will not sort your employee list, this is 

based on the default department assigned on the Personal Tab. 

This distribution, however, does override the default department 

assigned on the Personal tab.  
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Setting Up Employee Taxes 
 

1 Select the Taxes view tab on the Employees window.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 Select an employee from the employee list if one is not already selected. 
 

3 Select the appropriate federal tax table for the employee from the 

Federal Tax Table drop-down list. 
 

4 Enter the number of federal allowances that the employee is claiming. 
 

You can also withhold additional federal withholding per 

paycheck as a dollar amount or as a percentage of wages. 
 

5 Select the state for SUTA reporting from the SUTA State drop-down list. 
 

6 Select the appropriate state tax table for the employee from the 

State Tax Table drop-down list. 
 
 

Important Even if you do payroll in a state with no state withholding, such as 

Texas, you still need to assign both the SUTA State and State Table to 

every employee for correct quarterly wage reports. SUTA State must be 

selected for each employee before saving employee information or a 

default SUTA State will be assigned to the employee. 

 
If the employee is exempt from taxes, choose the appropriate checkbox 

ender the Exempt From area. Employee wages marked Exempt From 

do not need to be reported to SUTA, State or Federal government 

agencies. However, if the employee is exempt from allowances, you 

can change the withholding to “99” so no taxes are taken out. 
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Note For more information on state taxes, click the Additional Web 

Information button. This will open a page on CheckMark’s 

website. An internet connection is required.  
 

7 Enter the number of state allowances that the employee is claiming. 
 

For most states, after the cursor leaves the State 

Allowances field, CheckMark Payroll automatically 

calculates the Exemption or Tax Credit Totals. 
 

You can also withhold an additional amount per paycheck as 

a dollar amount or as a percentage of wages. 
 

8 Check any appropriate W-2 Options for the employee. 
 

9 Check any appropriate Exempt From options for the employee. 
 

10 If the employee qualifies for the HIRE Act, mark the Qualified checkbox. 
 

11 If the employee is an agricultural employee, mark the Agricultural 

(943) checkbox. 
 

12 Select a local tax for the employee from the Local Tax drop-down 

list if necessary. 
 

13 Enter the number of local allowances that the employee is 

claiming if needed. 
 

For some local taxes, after the cursor leaves the Local 

Allowances field, CheckMark Payroll automatically calculates 

the Exemption or Tax Credit Totals. 
 

14 Select another view mode to continue setting up the employee or 

click Save after you’ve finished entering the employee’s tax 

information, including the SUTA State.   

Items in the Taxes View Tab 
 

Federal Taxes 
 

Federal Table Use the drop-down list to select the appropriate federal tax table 

for the employee that coincided with the status claimed on the W-

4. If Exempt is selected, federal tax will not be withheld when the 

employee’s pay is calculated. 
 

W-4 Allowances Enter the number of allowances claimed on the employee’s Form W-4. 
 

Additional W/H If you want to withhold additional federal withholding for the employee 

(beyond the calculated amounts), enter the additional amount that you 

want to withhold per pay period. You can also enter the amount as a 

percentage of wages if the % checkbox is checked. 
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State Taxes 
 

SUTA State Use the drop-down list to select the appropriate state for SUTA 

reporting. The states that appear are those that have been 

added to the company with the State Taxes window.  
 

Important SUTA State must be selected for each employee before saving employee 

information or a default SUTA State will be assigned to the employee. 
  

State Table Use the drop-down list to select the appropriate state tax table 

for the employee. The tables that appear in the list are those 

that have been added on the State Taxes window. 
 

If “None” is selected, state tax will not be withheld when the employee’s 

pay is calculated and employee information will not appear on the state 

wage reports or W-2 reports including the EFW2 State File. 
 

Note: If your employee is exempt from state withholding but you need 

to report employee’s wages, DO NOT leave the State Table as “None”. 

Create a state table on the State Taxes window under Setup of zero. 

For example: You have an employee that is exempt from state w/h and 

you are in MD. You can create a table and call it something such as 

“MD-Exempt”. Select this table on the Employees setup screen. 
 

Allowances Enter the number of state allowances that the employee is 

claiming (usually, this is the number of federal allowances 

claimed on the employee’s Form W-4, Employee’s Withholding 

Allowance Certificate). CheckMark Payroll uses this number, 

when possible, to calculate the Exemption Total or Tax Credit 

Total for a selected state tax table. 
 

Exemption and Tax        When possible, the Exemption Total or Tax Credit Total is 

     calculated Credit Total for you and placed in the correct edit box. 

    The total equals the annual 

exemption or tax credit amount for the selected table times the 

number of state allowances entered for State Allowances. This 

is not applicable for all states and there are some states where 

this information must be manually calculated and entered. In the 

State Taxes window when selecting your state, the program will 

give a message for those states telling you to manually calculate 

and enter the figure in the Employee Set Up. More details are 

available by opening up the State Taxes window and selecting 

the Additional Web Information button. An internet connection is 

required to use the Additional Web Information button. 
 
 

Important Exemption Total does not refer to the number of allowances claimed 

by an employee. The number of state allowances claimed by an 

employee should be entered in the State Allowances edit box. 
 
 

Additional W/H       If you want to withhold additional state withholding for the 

     employee (beyond the calculated amounts), enter the  

     additional amount that you 
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want to withhold each pay period. You can also enter the amount 

as a percentage of wages if the % checkbox is checked. 
 

W-2 Options  
You should use a Circular E, Employer’s Tax Guide to verify 

the requirements for the following W-2 options. 
 

Retirement Plan If Retirement Plan is checked, an ‘x’ will be printed in the 

appropriate box on the employee’s W-2 Statement. 
 

Statutory Employee If Statutory Employee is checked, an ‘x’ will be printed in 

the appropriate box on the employee’s W-2 Statement. 
 

Sick Pay If Sick Pay is checked, an ‘x’ will be printed in the appropriate 

box on the employee’s W-2 Statement. 
 

Exempt From Options  
You should use a Circular E, Employer’s Tax Guide to verify the 

requirements for the following federal withholding options. 
 

Soc. Sec. Check the Soc. Sec. Exempt option if an employee is exempt 

from Social Security. 
 

Medicare Check the Medicare Exempt option if an employee is 

exempt from Medicare. 
 

FUTA Check the FUTA Exempt checkbox if the employee is exempt 

from Federal unemployment tax. 
 

SUTA Check the SUTA Exempt checkbox if the employee is exempt 

from State unemployment tax. 
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Local Taxes 
 

Local Use the drop-down list to select the appropriate local tax 

for the employee. 
 

The taxes that appear in the list are those that have been set 

up on the Local Taxes window under Setup.  
If “None” is selected, local tax will not be withheld when the 

employee’s pay is calculated and employee earnings will not 

appear on the local taxes report. 
 

Allowances Enter the number of local allowances that the employee is claiming. 
 
Exemption and Tax              This amount should be calculated and entered into the 

Credit Total            correct box depending on how the local tax has been setup. 
 
 

Note Many local taxes are fixed amounts or percentages of wages 

and not all fields are necessarily applicable to your local tax. 

This is dependent upon how the local tax has been setup on the 

Local Taxes window under Setup.  
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Setting Up Employee Additional Income 
 

Use the Additional Income view tab to set up income other than 

salary or hourly wages for your employees. Before an 

Additional Income category can be assigned to an employee, it 

must be set up on the Additional Income window. For more 

information on setting up Additional Income categories, see 

“Chapter 10 Setting Up Additional Income” on page 49. 
 

Assigning Additional Income Categories to an 

Employee 
 

You can assign a maximum of eight Additional Income 

categories to each employee. 
 

1 Select the Income view tab on the Employees window.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select an employee from the employee list if one is not already selected. 
 

3 Select the Additional Income category for the employee 

from the Company Categories list. 
 

The categories that appear in the Company Categories list 

are those that were set up with the Additional Income window. 
 

4 Click Assign.  
 

Tip You can also double-click an Additional Income category to 

assign it to an employee. 
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Select the category assigned to the employee and click Modify 

to modify a category’s values. Modify the rate/amount in the edit 

box and click OK.  

 

The value for a Variable Amount Additional Income category is entered 

when you calculate the employee’s pay on the Calculate Pay window. 
  

5 Click another view tab to continue setting up the employee or click Save 

after you have finished setting up Additional Income for this employee. 
 

Modifying an Additional Income Category 

from an Employee 
 

You can change the amount of an existing Income category if 

it’s not setup as V-Variable. This amount is entered when you 

calculate the employee’s pay on the Calculate Pay screen. 
 

1 Highlight the employee you want to adjust. 
 

2 Select the Additional Income category from the list of incomes 

already assigned to an employee. 
 

3 Click Modify and adjust the rate/amount. 
 

4 Click OK. 
 

Removing an Additional Income Category 

from an Employee 
 

You can remove an Additional Income from an employee as long as 

the employee does not have any income associated with it. The only 

time to remove an Income category from an employee is after you 

have started a new year, but before you have created a payroll in the 

new year. To stop the category from being applied mid year, simply 

modify the amount/rate to zero in the Employee set up. 
 

1 Select the Additional Income category from the Employee’s 

Additional Income list. 
  

2 Click Remove. 
 

3 Click Save.  
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Setting Up Employee Deductions 
 

In addition to tax deductions, you can set up Deduction 

categories for an employee. 
 

Assigning a Deduction to an Employee 
 

You can assign a maximum of 16 Deduction categories to 

each employee. Before a Deduction category can be assigned 

to an Employee, it must be set up on the Deductions window. 

For more information on setting up deductions, see “Chapter 

11 Setting Up Deductions” on page 59. 
 

1 Select the Deductions view tab on the Employees window.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select an employee from the employee list if one is not already selected. 
 

3 Select the Deduction category for the employee from the 

Company Categories list. 
 

The categories that appear in the Company Categories list 

are those that were set up with the Deductions window. 
 

4 Click Assign.  
 

Tip You can also double-click a Deduction category to assign 

it to an employee. 
 
 

Select the category assigned to the employee and click Modify 

to change a category’s values. Modify the rate/amount, limit, or 

employer match in the edit box and click OK.  

 

The value for a Variable Amount Deduction is entered when you  
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calculate the employee’s pay on the Calculate Pay window.  
 

5 Click another view tab after you’ve finished assigning deductions to 

this employee to continue setting up the employee or click Save. 
  

Modifying a Deduction Category from an 

Employee 
 

You can change the amount of an existing Deduction category if 

it’s not setup as V-Variable. This amount is entered when you 

calculate the employee’s pay on the Calculate Pay screen. 
 

1 Highlight the employee you want to adjust. 
 

2 Select the Deduction category from the list of incomes already 

assigned to an employee. 
 

3 Click Modify and adjust the rate/amount, limit (if applicable) and 

match (if applicable). 
 

4 Click OK. 
 

Removing a Deduction Category from an 

Employee 
 

You can remove a Deduction category from an employee as long 

as the employee doesn’t have any paychecks associated with it. 

The only time to remove an Deduction category from an employee 

is after you have started a new year, but before you have created a 

payroll in the new year. To stop the category from being applied mid 

year, simply modify the amount/rate to zero in the Employee set up. 
 

1 Select the Deduction from the Employee’s Deduction list. 
 

2 Click Remove.  
 

3 Click Save.  
 

 

Note If you want to zero out a deduction for just one paycheck, you can use 

the Disable Deductions feature in the Calculate Pay window instead of 

changing it in the employee setup, “Disable Calculation” on page 127. 
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Setting Up Employee Accruals 
 

CheckMark Payroll accommodates up to six accrued hours per 

employee. Accrued Hours are hour categories where you track hours 

earned and used for each employee such as vacation or sick. 
 

Assigning Accruals to an Employee 
 

1 Select the Accrued Hours view tab on the Employees window. 
 

.  
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 

 

2 Select an employee from the employee list if one is not already selected. 
 

3 Select the hour category for the employee from the Company 

Categories list. 
 

The categories that appear in the Company Categories list 

are those that were set up with the Hour Categories window. 
  

4 Click Assign.  
 

Tip You can also double-click an hour category to assign it to an employee.  
 

5 Define the accrued hour category. 
 

6 Repeat steps 3–5 for each accrued hour category for the employee. 
 

7 Click another view tab after you’ve finished setting up the accrued hours   
for this employee to continue setting up the employee or click Save.  
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Modifying an Accrual 
 

You can modify an existing accrual assigned to an employee. 
 

1 Select the employee from the list. 
 

2 Highlight the accrual you want to modify. 
 

3 Change the status of the accrual information. 
 

4 Click Save. 
 

Remove an Accrual from an Employee 
 

1 Highlight the employee from the list. 
 

2 Select the hour category from the Employee Hours Accrual list. 
 

3 Select Remove. 
 

4 Click Save 
 

 

Items in the Accrued Hours View Tab 
 
Total Accrued Hours Setup 
Total Accrued Hours Available for Use – This is a current total of accrued hours available.  It will include the 
carry over hours plus the hours accrued in the current year.  Hours that are used will deducted from the value. 
 
Total Accrued Hours Maximum – Select the checkbox if there are a maximum number of hours that an 
employee can have.  If the checkbox is not selected, then the hours will not have a cap and continue to grow 
until hours are used. 
 
Continue to Accrue after Hours are Used– Select this checkbox if the hours should begin to accrue again 
after an employee has reached a maximum for the Total Accrued Hours.  An employee will begin to accrue 
hours again after some time has been used and they their total accrued hours drops below the maximum.  
(Example – Allowed to carry over 4 weeks PTO.  Employee has 160 hours PTO.  He can start accruing again 
after PTO hours have been used and he drops below the maximum.  It would not reward retro time, but would 
only start accruing after time has been used.)  If an employee has reached the Annual Maximum, then no 
additional hours will accrue, even if this box is checked. 
 
Carry-Over Hours Limit – Select the checkbox if there is a limit for the number of hours that carry over after 
the Carry-Over Date.  Carry-over hours can be based on the payroll year or on an anniversary date.  If the 
checkbox is not selected, then all hours will carry over.  If the Total Accrued Hours Available for Use is larger 
than the Carry-Over Hours Limit, the employee will lose the hours over the limit. 
 
Carry-Over Date - Enter the date that the carry over hours will be based on.  The 1st check that is created after 
the carry-over date, will remove any additional hours over the number of Carry-Over Hours Limit that is entered.   
Note: The Carry-Over Date is a required field if you have the checkbox selected for Carry-Over Hours Limit. 
 

Annual Accrued Hours Setup 
Current Year Accrued Hours – This is the accrued hours that have been earned in the current payroll year. 
 
Annual Accrual Maximum – Select the checkbox if there are a maximum number of hours that an employee 
can accrue in a calendar or payroll year.  If the checkbox is not selected, then the hours will not have a cap and 
continue to grow until hours are used in the current year.  Once a maximum is reached in the year, it will not 
continue to accrue after hours have been used.  
 
Annual Use Maximum – Select this checkbox if an employer chooses to limit the number of hours that an 
employee can use in a year.  Many Sick Time laws have a minimum amount that an employer must allow in a 



year.  An alert would be given in Calculate Pay if an employee tries to use more than the maximum allowed in a 
year.  The employer can override and allow the hours to be used. 
 
 

Calculation Method 
 
Start Receiving Date – Hours will begin to accrue on the first check after this date.  If no date is entered, the 
accrual will begin on the next check. 
 
Hours Available for Use – Select this checkbox if an employer chooses set a minimum requirement before an 
employee can use the accrued time.  From the drop-down, choose either Date or # of Hours Worked.  If you 
select Date, you will need to enter the date that an employee can begin to use the hours that are accrued.  
Many sick time policies stipulate that hours must begin to accrue immediately, but are not available to use until 
after 90 to 120 days.  If # of Hours is selected, you will need to enter the minimum number of hours that an 
employee must work before the accrued time is available.  If the checkbox is not selected, then the accrued 
hours are available for use as soon as they are earned.  An alert would be given in Calculate Pay if an 
employee tries to use hours before the setup requirement.  The employer can override and allow the hours to 
be used. 
 
When importing Prior year data (Year 2019 and after) 

1. Current Year Accrued Hours will be set to zero. 
2. If Carry-Over Hours Limit is selected, then the Total Accrued Hours Available for Use will carry over up 

to the Carry-Over Hours Limit. 
Note:   If there is no limit to the hours that are carried over, you will not select the Carry-Over Hours 
Limit checkbox.  All hours will carry over. 

3. If Carry-Over Hours Limit is selected, then the employer has a “Use It or Lose It” policy and Total 
Accrued Hours Available for Use will be adjusted, depending on the limit that is set. 

4. All other setup items will carry forward to the new payroll year. 

 
  

Earn Hours Per Enter the number of hours the employee should had added 

onto their Current Accrued Hours based on the frequency 

selected in the Per drop down list. Choose from 1st Chk of 

Month, Year, Hour Worked, Pay Period or Quarter. 
 

1st Chk of Month If you choose Month, the employee will receive the number of 

accrued hours entered in the edit box on the first paycheck of each 

month. The employee will start receiving the accrued hours on the 

first paycheck after the date entered in the Start Receiving box. If no 

date is entered, the employee will start receiving the accrued hours 

on the next paycheck. 
 

Year If you choose Year, the employee will receive the number of 

accrued hours entered in the edit box at one time. The 

employee will start receiving the accrued hours on the first 

paycheck after the date entered in the Start Receiving box. A 

Start Receiving date in the current payroll year is required.  
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Hour Worked If you choose Hour Worked, the employee will receive the number 

of hours entered in the edit box per hour worked. You can also limit 

the maximum hours that are used to determine the earned hours 

for each pay period. The employee will start receiving the accrued 

hours on the first pay period dated after the date in the Start 

Receiving box. If no date is entered, the employee will start 

receiving the accrued hours on the next paycheck. 
 

If you choose Hour Worked as the accrual calculation method, you 

should select the Use in Calculations Based on Hours Worked 

option on the Hour Categories window for each Hour Category that 

should be included in the accrual. For example, let’s say that you 

have two hour categories defined as Regular and Vacation and you 

would like Vacation to accrue at a rate of .025 hours for every hour 

worked. You should check the Use in Calculations Based on Hours 

Worked option for the Hour Category Regular in order for the 

Regular hours to be included in the Vacation accrual. 
 

Pay Period If you choose Pay Period, the employee will receive the number of 

accrued hours entered in the box each paycheck. The employee will 

start receiving the accrued hours on the first paycheck after the date 

entered in Start Receiving. If no date is entered in the Start 

receiving date box, the employee will start receiving the accrued 

hours on the next paycheck. 

Quarter If you choose Quarter, the employee will receive the number of 

accrued hours entered in the box on the 1st check or the quarter.. 

The employee will start receiving the accrued hours on the first 

paycheck after the date entered in Start Receiving. If no date is 

entered in the Start receiving date box, the employee will start 

receiving the accrued hours on the next paycheck. 

 
 

Setting Up Employee YTD Balances Mid Year 
 

Depending on when you process your first payroll with 

CheckMark Payroll, you might need to set up year-to-date 

balances for your employees’ income and deductions. 
 

You don’t need to enter year-to-date balances if: 
 

• The first payroll you process with CheckMark Payroll is the 

first payroll of the year. 
 

• You are using CheckMark Payroll to process the first 

payroll for a new business. 
 

• You aren’t using CheckMark Payroll for keeping 

employee records. 
 

By carefully setting up your employees’ year-to-date balances 

and entering after-the-fact paychecks from the current quarter, 

you can help ensure accurate records for reports, such as 941s 

and W-2s. Here’s a brief overview of what to do:  
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Note YTD balance figures in the Employee Set Up tab affect annual reports. 

Quarterly reports are calculated on the actual paychecks created in 

CheckMark Payroll. YTD balances are needed for accurate calculation 

of taxes with an annual wage limit such as SS, FUTA and SUTA taxes. 
 
 

1 Enter starting balances as of the last completed quarter in the current year. 
 

For example, if you are going to process your first payroll with 

CheckMark Payroll on August 16th, enter the starting 

balances as of June 30th. 
 

2 Calculate and Save after-the-fact paychecks that were issued in 

the current quarter. 
 

After-the-fact paychecks are paychecks that were issued prior 

to using CheckMark Payroll. 
 

Again, if you are going to process your first payroll with 

CheckMark Payroll on August 16th, enter after-the-fact 

paychecks issued between July 1st and August 15th. 
 

For details, see “Calculating Pay for After-the-Fact 

Checks” on page 133. 
 

If you are going to process your first payroll with CheckMark 

Payroll at the beginning of a quarter, you don’t have any after-

the-fact paychecks in the current quarter. 
 

3 Create the after-the-fact payroll checks in CheckMark Payroll. 
 

Paycheck calculations do not affect an employee’s record 

until you create the paycheck in CheckMark Payroll. 
 

For details, see “Creating Payroll Checks” on page 138.  
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Entering Year-to-Date Income and  

Deductions 
 

1 Select the YTD view tab on the Employees window.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select an employee from the employee list if one is not already selected. 
 

3 For a salaried employee, enter the employee’s year-to-date salary 

as of the last completed quarter in the Salary edit box. 
 

4 Fort an hourly employee, click the Hours Detail button and enter the 

year-to-date hours and amounts for each hour category as of the 

last completed quarter.  
 

Tip If you don’t want to enter the year-to-date amounts in for each hour 

category, you could enter the total amount in the Salary edit box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Note When setting up, you don’t have to enter year-to-date hours to calculate  
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the value shown for Amount on the YTD Totals view tab.  
 

5 Click Save to close the Hours Detail window and update the 

Hours and Amount fields on the YTD view tab. 
  

6 Enter the year-to-date amounts for the Additional Income categories. 
 

The Additional Income categories that appear are those that were 

assigned to the employee in the Additional Income view tab. 
 

7 Enter the year-to-date amounts for the Deduction categories. 
 

The Deduction categories that appear are those that were 

assigned to the employee in the Deductions view tab. 
 
 

Note The Additional Income or Deduction categories will not show in 

the YTD tab unless the Save button has been selected for the 

employee. If the categories do not show up in the YTD tab, click 

Save, then re-select the employee from the list.  
 

8 Enter the year-to-date amounts for each tax category. 
 

The state and locality names that appear are those that were 

set up for the employee with the Taxes view tab. 
 

9 Click Save or select another view tab and continue setting up the 

employee when you’ve finished entering the year-to-date balances. 
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Chapter 13 Setting Up Employer 

 

Payees 
 

This chapter shows you how to set up the payees for employer 

payments, such as Federal, State and Local taxes as well as 

other employee deductions. Setting up and using employer 

payees is optional as using this feature in CheckMark Payroll in 

no way affects any report in the program. 
 

You can pay multiple items to the same payee, but the payee 

will need to be setup separately in the list, once for each item. 

You can combine up to 5 items on an employer payment check 

with the exceptions of 940 and 941 payments.For more 

information, see “Creating Employer Payments” on page 155 
 

CheckMark Payroll allows you to add new payees, modify 

payees and delete payees as long as there are no payment 

checks associated with the payee in the current year. 
 

Setting up a New Payee 
 

1 Click Setup in the Command Center, then select Employer Payees.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Click New.  
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3 Enter the name of the payee that will receive the payment and click OK. 
 

4 Click Save after you’ve finished setting up the Payee Information and   
Type of Payment. 

 
After you’ve set up an employer payee, you can use the 

Create Payments to calculate the amount of the payment. For 

details, “Creating Employer Payments” on page 155. 
 
 

Note Punctuation marks such as a comma (,) or period (.) in a 

payee’s name and address can cause errors when posting 

payment information into certain accounting programs.  
 

Payee Information 
 

Address Line 1 Address Line 1 will accommodate up to 30 characters. It is 

recommended that you use postal service guidelines when 

entering address information 
 

Address line 2 Address line 2 will accommodate up to 30 characters. 
 

City Enter the employee’s city. City will accommodate up to 25 characters. 
 

State Enter the 2-letter postal abbreviation for your employee’s state. 
 

ZIP Enter the 5-digit ZIP code, plus 4-digit extension. 
 

Reference/ID # Enter account #, identification #, federal or state ID number to 

print on the payment check. Reference/ID # will accommodate 

up to 17 characters. 
 

Type of Payment 
 

Federal Tax Federal withholding, Social Security and Medicare taxes. 
 

940 Tax - FUTA Federal unemployment tax. 
 

State Withholding The drop-down displays the states that are available in the 

State Taxes list. Select the state(s) that you withhold taxes in. 

A separate payee must be setup for each state in your list.  
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Local Withholding The drop-down list displays local taxes that are available on the 

Local Taxes list. Select the local tax that you withhold taxes for. 

A separate payee must be setup for each local tax in your list. 
 

SUTA The drop-down displays the states that are available in the State 

Taxes list. SUTA refers to the state unemployment tax. A 

separate payee must be setup for each state in your list. 
 

Employee Deduction The drop-down list displays deductions that are on the Deduction list.  
A separate payee must be setup for each deduction in your list. 

 

Modifying an Employer Payee 
 

1 Click Setup in the Command Center, then select Employer Payees. 
 

2 Select the name from the Payee list. 
 

3 Modify the information for the payee. 
 

4 Click Save.  
 

 

Deleting an Employer Payee 
 

You can delete a payee as long as no checks in the current year are associated 

with the payee. 
 

1 Click Setup in the Command Center, then select Employer Payees. 
 

2 Select the name from the Payee list. 
 

3 Click Delete in the tool bar.  
 

An alert appears asking you to verify that you want to delete the payee. 
 

4 Click OK.  
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Types of Employer Payments 
 

Here are the types of employer payments that you can set up. 
 

Federal Tax This refers to the deposit that you make for federal income tax 

withheld, Social Security, and Medicare taxes. 
 

940 Tax - FUTA This refers to the deposit that you make for the Federal 

unemployment tax (FUTA). 
 

State Withholding The drop-down list shows the states that were added to your 

company on the State Taxes window. If you don’t see the state 

you need, you can add the state to your company using the 

State Taxes window. For details, see “Setting Up State Tax 

Values and SUTA Values” on page 37 
 

  Local Withholding The drop-down list shows the local taxes that have been added to 

your company. If you don’t see the local tax that you need, you can 

add the local tax to your company using the Local Taxes window. 

For details, see “Setting Up Local Tax Values” on page 41 
 

SUTA This refers to the deposit that you make for the state 

unemployment tax. The drop-down list shows the states that 

were added to your company on the State Taxes window. 
 

Employee  This refers to the deposits that you make for employee 

Deductions     deductions, such as United Way or Health Insurance. The drop-

down list shows your company’s Deduction categories that 

were added on the Deductions Setup window. 
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Chapter 14 Setting Up Ledger 

Accounts 

 
This chapter shows you how to set up accounts that allow you 

to post your payroll to an accounting program. 
 

If you won’t be posting your payroll to an accounting program, 

or your accounting program doesn’t use account numbers, you 

don’t need to set up ledger accounts. However, you might find 

ledger accounts useful on Posting Summary reports to 

manually transfer your payroll data to an accounting system. 
 

You can assign accounts to the following payroll categories: 
 

• General, such as the cash account for employee paychecks 
 

• Additional Income, such as tips or mileage 
 

• Employee Taxes, such as federal, state, and local 

withholding and Social Security and Medicare 
 

• Deductions, such as 401(k) plans or health insurance 
 

• Employer Taxes, such as employer portions of Social 

Security and Medicare, FUTA, and SUTA 
 

• Department wages and tax expense 
 

• Job wages and tax expense (can be used only with 

CheckMark’s MultiLedger) 
 

Assigning the Posting Accounts 
 

Items displayed under the Payroll Categories radio buttons 

are directly affected by the setup on other windows on the 

Command Center. 
 

1 Click Setup in the Command Center, then select Ledger Accounts.  
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2 Select an option under Payroll Categories. 
 

After selecting the payroll category, items associated with the 

category appear in the Items list: 
 
 
 
 
 
 

 

3 Select an item from the Items list box. 
 

4 Click Modify Account...  
 

Tip You can also double-click an item to open the Modify Account 

Number dialog. 
 
 

5 Enter an account for the selected item and click OK.  
 
 
 
 
 
 
 
 
 

 

Accounts can be up to 16 alpha-numeric characters. 
 

6 Repeat steps 3–5 for each item in the payroll category. 
 

7 Click Save after you have finished entering the accounts in a 

payroll category. 
  

Repeat steps for 2–7 for each payroll category.  
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Modifying a Posting Account 
 

1 Select an option under Payroll Categories. 
 

2 Select an item from the Items list.  
 

 

4 Modify the account number in the edit box and click OK. 
 

5 Repeat steps 2–4 for each account in the payroll category. 
 

6 Click Save after you’ve finished modifying accounts in the 

payroll category. 
  

7 Repeat steps 1– 6 for each payroll category. 
 

Deleting a Posting Account 
 

1 Select an option under Payroll Categories. 
 

2 Select an item from the Items list.  
 

 

4 Press the DELETE key on your keyboard. 
 

5 Click OK. 
 

6 Repeat steps 3–5 for each account in the payroll category. 
 

7 Click Save after you’ve finished deleting accounts in the payroll category.  
 

8 Repeat steps 1–7 for each payroll category.  
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Posting Account Descriptions 
 

General 
 

Cash Account The cash account from which payroll checks are paid. 
 

Wages An expense account for gross wages. 
 

EIC An expense account for Earned Income Credit. 
 

Additional Income 
 

The Additional Income items that appear in the list are those that 

were set up on the Additional Income window. You can assign 

an account to each item, typically an expense account. 
 

Employee Taxes 
 

Federal A liability account for employee federal taxes withheld. 
 

Social Security A liability account for the Social Security tax withheld. 
 

Medicare A liability account for the Medicare tax withheld. 
 

Liability accounts for employee state and local taxes 

withheld also appear in the list. 
 

Deductions 
 

The Deduction items that appear in the list are those that were 

set up on the Deductions window. You can assign an account 

to each item, typically a liability account. 
 

Employer Taxes 
 

Cash Account The cash account from which employer expenses and 

liabilities are paid. 
 

Social Security A liability account for the employer portion of Social Security.  
Liability 

 
Social Security An expense account for the employer portion of Social Security.  

Expense 
 

Medicare Liability A liability account for the employer portion of Medicare. 
 

Medicare Expense An expense account for the employer portion of Medicare. 
 

FUTA Liability A liability account for employer federal unemployment tax. 
 

FUTA Expense An expense account employer federal unemployment tax. 
 

SUTA Liability A liability account for State Unemployment appears for each state.  
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SUTA Expense An expense account for State Unemployment appears for each state. 
 

Departments 
 

Wages An expense account for department wages. 
 

Tax Expense An expense account for department taxes for employer 

portions of Social Security and Medicare, FUTA, and SUTA. 
 
 

Note Department or job wage and tax expense accounts override 

general wage expense and employer tax expense accounts. 
 

 

Note If department or jobs are setup, the employer taxes will not be 

posted by tax expense, but by department/job liability and will be 

broken out by tax for the entire payroll.  

 

Jobs  
 
 

Note Use this option if you distribute employee wages to jobs in  
MultiLedger.  

 
Wages An expense account for job(s) wages. 

 
Tax Expense An expense account for job(s) taxes for employer portions of 

Social Security and Medicare, FUTA, and SUTA. 
 
 

Note Department or job wage and tax expense accounts override 

general wage expense & employer tax expense accounts. 
 

 

Deduction Match Expense 
 

Expense An expense account for the employer deduction expense, that is 

not broken out by department/job expense, for deductions set up 

with an employer matching amount or percentage. 
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Chapter 15 Importing and Exporting 

 

This chapter shows you how to import and export 

employee information. For information on importing hours, 

see Chapter 13. 
 

Import Employee Information 
 

You can import employee personal and wage information into 

your CheckMark Payroll company. The employee information 

that you import must be in a text file, with tabs between fields 

and a return after each employee record.  
 

Note Before importing information into your payroll company, you 

should make a backup of your company files. 
 

 

To import employee information: 
 

1 Choose Import Employees from the File 

menu. The following window appears: 
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2 Copy each field that you want to import in the order that it 

appears in the text file. 
 

Highlight the field in the Available Fields list, then click Copy. 

You can also double click a field in the Available Fields list to 

copy it to the Selected Fields list. The only required fields for 

importing are Last Name and First Name. 
 

To copy all fields in the order that they appear in the Available 

Fields list to the Selected Fields list, click the Copy All button. 
 

Since there are no field names in a text file, you should carefully 

determine the order that you want to import the data. 
 

As you copy each field, it appears in the Selected Fields list 

on the right: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

To remove a field from the Selected Fields list, highlight the 

field and click Remove. You can also double click a field in the 

Selected Fields list to remove it. Fields below the removed field 

will automatically move up in the Selected Fields list. 
 

3 (optional) Click Save if you want to save the order that the fields 

appear in the Selected Fields list for future importing. 
 

4 After selecting the appropriate fields for the Selected Fields list, 

click Import. 
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An Open dialog appears:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

5 Select the appropriate text file to import and click 

Open. The Import Preview window appears: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

This window allows you to see the Selected Fields list with the 

contents of the selected text file by record. This can help you 

find any trouble spots before you actually import the data. 
 

You can click the Next Employee button to see more 

information in the text file. 
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6 (optional) Check the Replace Existing Employees checkbox if you 

want the information in the text file to replace existing employee 

information in your company. 
 

7 When you’re finished previewing the text file, click Import to 

read the information into your company. 
 
 

Note If you intend to import employee hours, in the Enter Hours window, and 

use employee name as part of your import parameter(s), exporting 

employee names from your time clock program and importing into 

CheckMark Payroll is one way of assuring that they are identical and 

avoid errors. Or you can export employee names from CheckMark 

Payroll and import into your timeclock program if the program allows. 
 

 

Warning Importing an employee’s department choice only works if a department 

with the same name is already setup in the Deductions screen. 
 
 

Export Employee Information 
 

You can export employee information to a text file, allowing you 

to import the information into other programs or into another 

CheckMark Payroll company. 
 

To export employee information: 
 

1 Choose Export Employees from the File menu. 
 

2 Select the employee names you want to export. 
 

To select a consecutive or non-consecutive series of 

employees, see “Making Selections in a List Box” on page 13. 
 

If no employee names are highlighted, information for all 

employees will be exported. 
 

Copy each field that you want to export in the order that you 

want it to appear in the text file. 
 

Highlight the field in the Available Fields list, then click Copy. 

You can also double click a field in the Available Fields list to 

copy it to the Selected Fields list. 
 

To copy all fields in the order that they appear in the Available 

Fields list to the Selected Fields list, click the Copy All button. 
 
 

Note If your intent is to export employee information for import into 

another CheckMark Payroll company, take note that there are 

more fields available for exporting than there are for importing.  
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Since there are no field names in a text file, you should carefully 

determine the order that you want to export the data. 
 

As you copy each field, it appears in the Selected Fields list 

on the right: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

To remove a field from the Selected Fields list, highlight the 

field and click Remove. You can also double click a field in the 

Selected Fields list to remove it. Fields below the removed field 

will automatically move up in the Selected Fields list. 
 

3 (optional) Click Save if you want to save the order that the fields 

appear in the Selected Fields list for future exporting. 
 

4 Click Export. 
 

A Save As dialog appears:  
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5 Enter a name for the text file, choose where you want to save the 

text file, then click Save. 
 

The extension “.txt” is automatically added to the file name. 
 

Export Employee Information into CheckMark Forms 1099 
 

CheckMark Payroll allows you to export employee information into 

the CheckMark Forms 1099 application. To learn more about the 

CheckMark Forms 1099 software, please call our sales department 

at 800-444-9922 or visit our website at www.checkmark.com. 
 

To export employee information: 
 

1 Choose Export Employees from the File menu. 
 

2 Select the employee names you want to export. 
 

To select a consecutive or non-consecutive series of 

employees, see “Making Selections in a List Box” on page 13. 
 

If no employee names are highlighted, information for all 

employees will be exported. 
 

 

Note: If the recipients to be imported are using different types of 1099 

forms, you should create multiple export files for each type of form. 

Example, one export file for 1099 MISC, one file for 1099 INT, etc. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3 Click the Export to 1099 button. 

A Save As dialog appears. 
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4 Enter a name for the text file, choose where you want to save the 

text file, then click Save. 
 

The extension “.txt” is automatically added to the file name 
 

5 The file is now ready to be imported into the CheckMark 

Forms 1099 application. 
 
 

Warning Exporting employee comments may hae an adverse effect on 

the generated file if there are tabs or carriage returns within the 

text of the comments.  

 

Warning You can export more fields out of CheckMark Payroll than you can 

import. If you are importing/exporting data between companies, 

make sure your import and export field lists are the same. 
 



110 Chapter 15 Importing and Exporting  



Steps to Processing a Payroll 111  
 

Part 3 
 

Processing Your Payroll 

 
 

 

Now that you have everything setup, it is time to process 

payroll. Almost all the windows under Payroll on the Command 

Center are optional with the exception of Calculate Pay. You 

are able to calculate and create a pay check all within the 

Calculate Pay window. CheckMark Payroll does not require 

that you print a pay check to affect employee YTD balances or 

payroll reports.You only have to create a check. 
 

Steps to Processing a Payroll 
 

Optional 1 Enter or Import employee hours. 
 

or 
 

Optional 2 Distribute Hours by Department or Job. 
 

3 Calculate Pay. 
 

Optional 4 Review pay calculations. 
 

5 Create paychecks. 
 

Optional 6 Allocate Wages or Re-allocate Hours to Departments or Jobs. 
 

Optional 7 Print paychecks. 
 

Optional 8 Modify paychecks.  
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Chapter 16 Distribute Hours 

 

To distribute hours by department or MultiLedger Job, use the 

Distribute Hours window on the Command Center. Hours 

distributed on the Distribute Hours window cannot be edited on 

the Calculate Pay window. If you need to edit an employee’s 

hours, you will need to return to the Distribute Hours window. 
 

Distribute Hours 
 

1 Click Payroll in the Command Center, then select Distribute Hours.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 The default is to distribute hours by Department. If you are 

paying by MultiLedger job, select the Job radio button. 
 

3 Select an employee in the list and enter the number of hours 

for the department/job and click the TAB key. 
 

Hourly employees are indicated by a ”greater than” symbol (>). 
 

4 Select the Hour Category that coincides with the hours you just 

entered. Click OK or press ENTER. 
 

5 Select the Department/Job that coincides with the hours you just 

entered and click OK or press ENTER. 
 
 

Note If you selected Job when you entered the window and jobs have 

not been previously loaded during this payroll session, you will be 

prompted to select and open the MultiLedger company job list that 

you wish to use during this payroll session. 
 
 

6 Continue with the selected employee until distribution is complete. Click  
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Save. 
 

Employees whose hours have been distributed and saved are 

marked with an asterisk (*). 
 

7 Repeat steps 3-6 for each employee.  
 

Note The Hour Categories and Department lists that appear while 

distributing hours are the Hour Categories and Departments 

that were setup on their respective windows on the Command 

Center. If you do not see an Hour Category or Department, you 

will need to set those up in the appropriate window.  

 

Modifying a Distribution 
 

1 Select the employee name in the list. 
 

Employees whose hours have been distributed are marked 

with an asterisk (*). 
 

2 Select the line you want to modify. 
 

3 Modify the Hours, then click Update. 
 

Undoing a Distribution 
 

1 Select the employee name in the list. 
 

Employees whose hours have been distributed are marked 

with an asterisk (*). 
 

2 Click Undo. 
 

The following alert appears:  
 
 
 
 
 
 
 
 
 
 
 

3 Click Yes to delete the employee’s hours distribution, or click No 

to leave the distribution unchanged. 
 

Moving Around the Hour Fields 
 

You can use your mouse to highlight any field by simply clicking the  
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field, or you can press the following keys on your keyboard:  
 

Keystroke Result  

 

TAB or RIGHT ARROW  
SHIFT + TAB or LEFT ARROW 

 
ENTER (WIN)/RETURN (MAC) or 

 
DOWN ARROW  
SHIFT + ENTER(WIN)/RETURN  
(MAC) or UP ARROW 
CTRL(WIN)/COMMAND (MAC) + 

ENTER 

 

 

Next hour field to the right 
Next hour field to the left 
Next hour field below 

 

Next hour field above 
 

First hour field for next 

employee below 
 
  

A total column will show you total hours per employee and total 

hours entered for the period. 
 
 

Note You can also allocate wages to Departments or Jobs after 

checks have been created. For more information, see 

“Allocating Wages After Paychecks are Created” on page 151  

 

Important If you’ve changed any hours for an employee whose calculated 

pay has already been saved, CheckMark Payroll will automatically 

undo the saved calculation. You must recalculate the employee’s 

pay with the new hours on the Calculate Pay window. 
 

 

Important Hours distributed on Distribute Hours cannot be edited on the Calculate 

Pay window. If you need to edit the hours, you must close the Calculate 

Pay window and edit the hours in Distribute Hours. 
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Chapter 17 Entering Employee 

 

Hours 
 

This chapter shows you how to enter the number of hours 

employees use for such hour categories as regular, overtime, 

sick, and vacation. You can also import hours from third party 

program using a tab-delimited text file.  
 

Note If you open this window and do not see your employee list or 

header columns, you have not setup Hour Categories for your 

company. You must first set up Hour Categories. For more 

information on setting up Hour Categories, see “Chapter 9 

Setting Up Hour Categories” on page 45  

 

Moving Around the Hour Fields 
 

You can use your mouse to highlight any field by simply clicking 

the field, or you can press the following keys on your keyboard: 
  

Keystroke Result  

 

TAB or RIGHT ARROW  
SHIFT + TAB or LEFT ARROW 

 
ENTER (WIN)/RETURN (MAC) or 

 
DOWN ARROW  
SHIFT + ENTER(WIN)/RETURN  
(MAC) or UP ARROW 
CTRL(WIN)/COMMAND (MAC) + 

ENTER 
 

 

 

Next hour field to the right 
Next hour field to the left 
Next hour field below 

 

Next hour field above 
 

First hour field for next 

employee below 
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Entering Hours for an Employee 
 

1 Click Payroll in the Command Center, then select Enter Hours.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A total column will show you total hours per employee and total 

hours entered for the period. 
 

2 Select an hour category for an employee. 
 

Hourly employees are indicated by a ”greater than” symbol (>). The 

hour categories that were set up with the Hour Categories window 

appear across the top of the hour fields. These categories appear in 

the order that you set them up in the Hour Categories window. 
 
 

Note To show hourly employees first in the list, check the Sort 

Hourly Employees First When Entering Hours option on the 

Preferences window.  
 

3 Enter the number of hours for the category. 
 

Numbers to the right of the decimal point are treated as 

hundredths of an hour. For example, enter “30.75” for an 

employee who worked thirty hours and forty-five minutes. For 

detailed information on the decimal equivalent to how many 

minutes an employee worked see “Conversion Chart: Number 

of Minutes and Decimal Equivalent” on page 120. 
 

4 Continue entering employee hours. 
 

5 Click Save in the tool bar after you’ve finished entering employee 

hours for the pay period. 
 

After the hours are saved, they can be used for pay calculations on the  
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Calculate Pay window. 
 

Fill Down Column You can quickly enter the same number of hours, such as eight 

hours of holiday pay, for each employee. First, select the first hour 

field under Holiday. Next, enter “8” and click the Fill Down Column 

button. A message appears asking if you want to replace values 

for all cells; click Yes. Starting with the currently selected 

employee, each value in the column is replaced with “8”. 
 
Retain Hours for Next If you want the same number of hours for each employee to  

Pay Period automatically appear for the next pay period, check the Retain 

Hours for Next Pay Period option.  
 

 

Important If you’ve changed any hours for an employee whose calculated 

pay has already been saved, CheckMark Payroll will automatically 

undo the saved calculation. You must recalculate the employee’s 

pay with the new hours on the Calculate Pay window. 
 
 
Importing Employee          CheckMark Payroll can import hours from a spreadsheet or 

timeclock Hours                program, as long as the hours have been saved in a tab- 

delimited text file format. The hours you import should be total 

hours     for the pay period. The order of the hours in the text file 

must match the order in which they appear on the Enter Hours 

window. If an employee does not have any hours for a particular 

hour category, you still need to separate the categories by a tab 

or enter a zero (0). The text file must have a TAB between each 

field and a RETURN at the end of each employee record. Hours 

can have up to two places to the right and three places to the 

left of the decimal point (000.00).  
 

Important You cannot import hours directly to Jobs or Departments, but you 

can allocate the pay to the appropriate Jobs or Departments after 

you have created a paycheck. For more information, see, 

“Allocating Wages After Paychecks are Created” on page 151. 
 
 

You can choose to import hours by the following match. 
 

Employee Name - Employees in your text file are saved 

in alphabetical order with the last name first, first name 

and then employee hours for each hour category. 
 

Social Security # - Employees in your text file are saved by Social 

Security Number followed by hours for each hour category. 
 

Employee Name and Social Security # - Employees in your text file 

are saved in alphabetical order with last name, first name, Social 

Security Number followed by the hours for each hour category. 
 

Here is an example of an acceptable text file format, if the Employee  
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Name option is selected: 
 

Browne[TAB]Jennifer[TAB]32[TAB]2[TAB]3.25[TAB]8[TAB]40[RETURN] 

Wilcox[TAB]James[TAB]40[]3.5[TAB][TAB][TAB]40[RETURN] 
 

Conversion Chart: Number of Minutes and Decimal  
Equivalent  



Entering Hours for an Employee 121  

 

To import employee hours into CheckMark 

Payroll 
 

1 Click Setup in the Command Center, then select Enter Hours. 
 

2 Select the appropriate Import Hours using the following match option. 
 

You can choose Employee Name, Social Security #, or 

Employee Name & Social Security #. 
 

3 Click the Import Hours button. 
 

4 Select the appropriate text file to import, then click Open.  
 

Note If an employee’s information appears in the text file, but is not 

found in CheckMark Payroll, a message appears telling you that 

the employee could not be found. Click OK to continue importing 

or click Cancel to stop the import process.  
 

5 After the employees’ hours have imported, click Save.  
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Chapter 18 Calculating Employee Pay 

 
 

 

This chapter shows you how to calculate the pay for 

employee paychecks and special checks, such as 

bonuses and after-the-fact paychecks. 
 

CheckMark Payroll can calculate the pay for one employee at a time 

or all employees for any combination of pay frequencies at one time. 
 

After you’ve entered employee hours with the Enter Hours or 

Distribute Hours window (you can also enter hours on the 

Calculate Pay window), the next step is to have CheckMark 

Payroll calculate employee wages, additional income and 

deduction amounts, taxes, and net pay for the current pay period. 
 

Check Dates 
 

When you first open the Calculate Pay screen, you will see the 

Claculate Pay Dates window. You need to enter the Check Date, 

Period Start and Period End dates. Use the DOWN ARROW buttons to the 

right of the Check Date, Period Start and Period End fields to use the 

pop-up calendars. Click on the date of the calendar window for the 

date to fill in the appropriate field. When the dates are filled in, Click 

OK to continue to the Calculate Pay window. Dates entered in the 

Check Dates window are displayed on the Calculate Pay window 

while you are calculating your employee paychecks. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Next Period This button will calculate Check Date, Period Start and Period 

End based on the pay frequency set on the first employee in the 

employee list and dates currently being displayed.  
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Change Frequency If you have multiple pay frequencies, you can click the Change 

Frequency link to open up a option to change the pay 

frequency when selecting the Next Period button. 
 

 

Calculate Pay 
 

Once you are in the Calculate Pay window, you will see all 

employees in your employee list displayed on the right side of the 

screen. Employee names displayed in “black” indicate that there is 

no calculation saved for that employee. If the employee name is 

displayed in “green” with a “$” on the left side, there is a saved 

calculation for that employee. If that calculation is not correct, or 

needs to be modified, you must first Undo the saved calculation. 
 

Make any changes to the payroll on the Calculate Pay 

window by clicking the box with the field you need to modify 

and insert the change. Save changes and review the 

calculation on the Review/ Create Paychecks window.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Edit Hours Select Edit Hours if you need to adjust the number of hours or 

wage per hour for the pay period. Hours entered on the Enter 

Hours window can be edited directly in Calculate Pay, but if 

hours were entered in Distribute Hours, you will need to edit 

hours on the Distribute Hours window. An employee name 

must be selected before this option is available. 
 

Changing the hourly rate on the Edit Hours window affects only the  
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current calculation and does not change the employee’s hourly 

rate for future pay calculations. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Edit Income Select Edit Income if you need to enter information for an additional 

income that is setup to calculate based on further information, such 

as mileage, commission, piecework or tips. An employee name 

must be selected before this option is available. 
 
 
 
 
 
 
 
 
 
 
 

 

Import Income Select Import Income if you wish to import the additional 

incomes for your employees using a tab-delimited text file. An 

example is listed below for two employees. One employee, 

Jennifer Brown, has additional Commission and the other, 

James Wilcox, has additional Piecework and Mileage. 
 

Brown[TAB]Jennifer[TAB]Commission[TAB]2500.00[RETURN] 

Wilcox[TAB]James[TAB]Piecework[TAB]127.5[TAB]Mileage[TAB]105. 

9[RETURN] 
 

Import Deduction Select Import Deductions if you wish to import the variable 

deductions for your employees using a tab-delimited text file. 

An example is listed below for two employees. One 

employee, Jennifer Brown, has a reimburse deduction and 

the other, James Wilcox, has Office supplies. 
 

Brown[TAB]Jennifer[TAB]reimburse[TAB]2500.00[RETURN] 

Wilcox[TAB]James[TAB]Office[TAB]127.5[RETURN] 
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Numbers that are imported in this way will be used in calculations 

setup on the Additional Income window or as the number used as 

additional income in the payroll calculation. These numbers can be 

modified, if necessary under the Edit Income option. 
 

Disable Calculation Select this option if you wish a deduction to be turned off for 

this payroll, for hour accrual to not accrue on this check or to 

disable all the calculations when entering checks such as after-

the-fact payroll checks. Items selected in this window will affect 

all calculations made while you are in the Calculate Pay 

window. To deselect any or all of the options in this window, 

close Calculate Pay and re-enter the window. 
 

If this option is unavailable, you probably have an employee 

selected in the list. Deselect the employee and try again. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Select any or all deductions that you do NOT wish to calculate on this 

paycheck. For example, when calculating special checks such as bonus 

checks, you may not wish for items such as health insurance or 401(k) 

to be deducted. Select those items from the list then click OK. 
 

Disable Hour Accrual - Select this option if you are doing a special 

check and do not wish employee accruals to calculate on this 

check. An example is an employee that has accrual based on a 

per pay period basis and you are calculating a bonus check in 

addition to a regular paycheck on the same check date. 
 

Disable All Calculations - Select this option if you wish to 

manually enter all of the employee income, tax and deduction 

fields such is the case when entering after-the-fact checks.  
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Note An employee’s Social Security and Medicare withholding are exact 

computations based on values shown for Federal Tax Parameters 

on the Federal Taxes Setup window and should NOT be manually 

changed for an individual check. There are, however, times when 

this is necessary specifically when entering after-the-fact checks 

since items already distributed MUST be matched exactly. 

CheckMark Payroll will warn you that these items do not match the 

calculated value, even when Disable Calculations is selected, BUT 

will allow the change to be saved.  
 

Calculate All Select this option if you wish to have CheckMark Payroll calculate 

all employees in the pay period at one time based on your 

company and employee setup. When you select this option, a list 

of possible pay frequencies appears. Select any or all pay 

frequencies that you wish to calculate pay. All frequencies enabled 

are those that appear and have been assigned to employees on 

the Wages tab of the Employees window.  
 
 
 
 
 
 
 
 
 
 

 

Save Select this option after you have finished editing the 

employee’s pay calculation. 
 

Undo Select this option if you wish to undo an employee’s saved calculation. 

CheckMark Payroll deletes the saved calculation and removes the “$” 

from the employee’s name turning from “green” to “black” again. If you 

select Undo with no employee name selected from the employee list, 

ALL calculations that have been saved will be deleted. 
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Create Check Select this option if you wish to create the employee’s paycheck 

directly in this window and not on the Review/Create Paychecks 

window. CheckMark Payroll will not affect employee YTD balances 

or create reports without creating an employee paycheck. Once 

the check or direct deposit number is entered, click Create. 
 

Calculating Pay for an Employee 
 

1 Click Payroll in the Command Center, then select Calculate Pay.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 Enter the check date for this payroll and press TAB. 
 

3 Enter the pay period start date and pay period ending 

date and click OK. 
 
 

Note To make date entry more accurate, you can select the down 

arrows next to Check Date, Period Start, and Period End date 

fields to reveal a calendar. Then, simply click the date on the 

calendar to fill in the appropriate date field. You can also use the 

Next Period advance button to move ahead one pay period at a 

time. The Next Period button will calculate check date, period start 

and end dates based on the pay frequency set on the first 

employee in the employee list and dates currently being displayed.  
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The Calculate Pay Window appears.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

4 Select an employee from the Employees list.  
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Important An employee’s Social Security and Medicare withholding are 

exact computations based on values shown for Federal Tax 

Parameters on the Federal Taxes window and typically should 

not be manually changed for an individual check. 
 

CheckMark Payroll calculates the tax withholding amounts using a 

percentage method, which is more accurate than manual calculations 

based on the bracket method used in the Circular E, Employers Tax 

Guide or state tax guide. You might find small differences (up to one or 

two dollars for federal or state withholding) between manual 

calculations and CheckMark Payroll’s calculations. You don’t need to 

be concerned about these minor differences. 
 
 

The employee’s net pay is shown at the bottom of the window. 
 

5  Make any necessary changes to the wages shown for the employee. 
 

To enter or modify hours for the employee, click the Edit 

Hours button. 
 
 

Note Hours entered in the Distribute Hours screen cannot be modified 

on the Calculate Pay screen. Close the Calculate Pay screen 

and modify in the Distribute Hours screen.  
 

Hours shown for salaried employees do not affect the wage 

calculations unless the employee has also been set up with 

hourly pay rates. 
 

6 Make any necessary changes to the Additional Income amounts. 
 

Don’t forget to enter amounts for any Variable Amount 

Additional Income for this pay period. 
 

Whenever a taxable Additional Income amount is changed, 

CheckMark Payroll recalculates the appropriate taxes and net pay 

when the cursor leaves the edit box or the calculated pay is saved. 
 

7 Make any necessary changes to Deduction amounts. 
 

Don’t forget to enter amounts for any Variable Amount 

Deductions for this pay period. 
 

Whenever a pre-tax Deduction amount is changed, CheckMark 

Payroll recalculates the appropriate taxes and net pay when 

the cursor leaves the edit box or the calculated pay is saved.  
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Important Do not enter negative amounts to account for mistakes made in prior 

payrolls. Example, if you over paid or over deducted someone on the 

prior payroll, don’t enter a negative amount to compensate for the over 

deduction or payment. This will adversely affect the tax reporting. You 

should create a new Deduction or Additional Income category to 

properly handle the misappropriated amount. 
 
 

Employer Match Fields in Calculate Pay Screen 
 

Modifying hours worked and other income amounts will force 

employer match amounts to recalculate. Changing a regular 

deduction amount will also force the employer match amount to 

recalculate, even if disabling deduction calculations. You can 

modify match amounts for Deductions, but not Taxes. 
 

Fixed % employer matches cannot be modified, unless disabling 

calculations (which works the same as regular Deduction amounts. 
 

The match amount cannot be modified on a deduction where the 

deduction amount is zero, and the “match if no employee deduction” 

checkbox is NOT checked, unless using Disable Calculations. 
 
 

Note Employer match amounts for taxes are calculated at the time reports are 

generated, not when checks are created. Changing employer tax rates 

though Federal Tax Values at any time will result in the employer match 

amounts for all previously created checks to change as well. 
 
 

8 Click Save after you’ve finished editing the employee’s pay calculations. 
 

Employees whose calculated pay has been saved are shown 

in green and prefaced with a dollar sign ($): 
 
 
 
 
 

 

You can verify these calculations on the Review/Create 

Paychecks window before creating the paychecks. For details, 

see “Reviewing Payroll Calculations” on page 137. 
 

After calculating employee pay, you can create the paychecks with the  
Review/Create Paychecks window. For details, see “Creating Payroll  
Checks” on page 138.  

 

Note CheckMark Payroll does not add the calculated pay to 

employee records until you create the paychecks. 
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Calculating Pay for Special Checks 
 

You can use the Calculate Pay window to calculate the pay for 

special checks, such as after-the-fact or bonus checks. 
 

Calculating Pay for After-the-Fact Checks 
 

After-the-fact paychecks are paychecks that were issued in the 

current quarter prior to using CheckMark Payroll. If you have 

started using CheckMark Payroll mid-year and have used 

another program or service for previous payrolls, any check in 

the current quarter needs to be calculated and created in order 

to get accurate quarterly reports. If you want CheckMark 

Payroll to keep accurate records for quarterly reports, such as 

941s and state reports, you should record these paychecks. 
 

CheckMark Payroll automatically calculates net pay based 

on the amounts you enter for Wages, Additional Income, 

Deductions, and Taxes.  
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1 Click Payroll in the Command Center, then select Calculate Pay.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Enter the check date from the original paycheck and press TAB. 
 

3 Enter the period start date and period ending date from the 

original paychecks and click OK. 
 

4 The Calculate Pay window appears.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 Select Disable Calculations, then choose the Disable All 

Calculations check box. 
 

6 Select an employee from the list.  
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7 Enter the check amounts from the employee’s paycheck in the 

appropriate fields. 
 

If you don’t want to enter the hours to calculate the wages for hourly 

employees, you can enter the amount in the Salary edit box. 
 
 

Note Social Security and Medicare are exact computations based on values 

entered for Federal Tax Parameters on the Federal Taxes window. If 

you enter Social Security and Medicare amounts that differ from what 

the federal tax parameters calculate, CheckMark Payroll warns you 

that Social Security and Medicare are not correct. Typically, you would 

override the amount to reflect what was actually paid, but you should 

know that the difference will appear in the Fractions of Cents line on 

the 941. For more information, see “Types of Federal Tax Reports” on 

page 186 
 
 

8 Click Save after you have finished filling in the paycheck amounts. 
 

Employees whose calculated pay has been saved are shown 

in green and prefaced with a dollar sign ($). 
 
 

Important Do not forget to use the Review/Create Paychecks window to 

create the paycheck since CheckMark Payroll updates 

employee records after the paycheck is created. Use the same 

check number that was originally disbursed for accuracy. For 

details, see “Creating Payroll Checks” on page 138.  

 

Calculating Pay for a Bonus Check 
 

Before calculating a bonus check, the bonus should have 

been set up for employees as an additional income category. 

For details, see “Adding Pre-Defined Additional Income 

Categories to Your Company” on page 50 
 

To calculate the pay for a bonus check, do the following: 
 

1 Click Payroll in the Command Center, then select Calculate Pay. 
 

2 Enter the date for the bonus check and press TAB. 
 

3 Enter the period start and period ending date and Click OK. 
 

4 Select Disable Calculations and select any deductions that don’t 

apply to this bonus. 
 

Note: It may be necessary to select the Disable Accrual check box 

while on the Disable Calculations window. If you accrue hours such 

as vacation on a per pay period basis and you are doing a regular 

paycheck with a bonus check on the same check date, this check 

box will prevent accruals to occur twice, once for each check created. 
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5 Select an employee from the list. 
 

6 If necessary zero out the salary and/or saved hours. 
 

7 Enter the bonus amount in the edit box for the Additional Income 

category that was set up for the bonus and press TAB. 
 
 
 
 

 
8 Change the amounts shown for federal, state, or local taxes if necessary. 

 
For guidelines about how much federal tax should be withheld, 

consult the “Supplemental Wages” section in your Circular E, 

Employer’s Tax Guide. 
 

For guidelines about how much state or local tax should be 

withheld, consult your state or local tax guides. 
 

9 Click Save. 
 

Employees whose calculated pay has been saved are shown 

in green and prefaced with a dollar sign ($). 
 

10 Repeat steps 4–8 for each employee who is receiving a bonus for 

the pay period. 
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Paychecks 
 

After you’ve calculated the pay for the pay period on the Calculate 

Pay window, use the Review/Create Paychecks window to check 

saved calculations for your employees and create paychecks. Once 

paychecks are created, CheckMark Payroll updates employee 

records with the new paycheck information. 
 

Reviewing Payroll Calculations 
 

1 Click Payroll in the Command Center, then select 

Review/Create Paychecks. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select one or more employees from the list. 
 

If no names are highlighted, all employees listed will be reported. 
 

You can select a consecutive or non-consecutive series of employees.  
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Note Only those employees whose pay has been calculated and 

saved on the Calculate Pay window appear in the list. If you 

don’t see the employee you want, go to the Calculate Pay 

window and make sure that the employee’s calculated pay has 

been saved. Employees with calculated pay are shown in green 

and prefaced by a dollar sign ($) on the Calculate Pay window. 
 

If any information is incorrect, you must return to the Calculate 

Pay screen and make the changes. For more information on 

calculating pay, see “Calculate Pay” on page 124  
 

3 Click View or Print. 
 

Creating Payroll Checks 
 

You can create one paycheck at a time or all of them at the same time. 
 

1 Click Payroll in the Command Center, then select 

Review/Create Paychecks. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select one or more employees from the list. 
 

If no names are highlighted, paychecks for all employees listed 

will be created. 
 

You can select a consecutive or non-consecutive series of employees.  
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Note Only those employees whose calculated pay has been saved 

on the Calculate Pay window appear in the list. If you don’t see 

the employee you want, go to the Calculate Pay window and 

make sure that the employee’s pay has been saved. 

Employees whose pay has been saved are shown in green and 

prefaced by a dollar sign ($) on the Calculate Pay window.  
 

3 Change the Next Check # or Next Direct Deposit #, if necessary. 
 

When creating multiple checks, CheckMark Payroll 

consecutively assigns check numbers starting with the 

check number entered. Pay calculations for employees set 

up with Direct Deposit are consecutively numbered starting 

with the direct deposit number entered. 
 

Keeping Check # and Direct Deposit # numbering systems 

different allows for easier identification of what items print on 

which stock when printing.  
 

Note Review Calculations is displaying/printing the calculation saved at 

the time it is viewed/printed. Calculations can still be modified and 

do not affect employee YTD totals until the paycheck is created. 

There are no company totals in Review Calculations. 
 
 

4 Click Create. 
 

Creating checks updates the year-to-date totals to include the 

current check calculations. The employee names for which 

paychecks have been created no longer appear in the list 

since the paycheck’s calculation data has been used. 
 

You can print the check with the Print Paychecks window. 
 

Once created, a paycheck’s calculations cannot be changed. 

However, you can use the Modify Paychecks window to modify 

the check number, delete or void the check.  
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Printing the Payroll Checks 
 

After you’ve created the paychecks, you can print them with the 

Print Paychecks window. Printing paychecks is an optional step 

because it’s not necessary for posting check information to the 

employee’s earnings records. 
 

Paychecks can be printed or reprinted. Reprinting a paycheck 

doesn’t affect employee records. In the list, checks that have 

already been printed have an asterisk (*) after the check 

number. 
 

You can select the print font and size for printing checks on the 

Select Print Font window located under the File menu. 
 

1 Click Payroll in the Command Center, then select Print Paychecks.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select the check date for the checks that you want to display in the list. 
 

3 Select one or more checks from the list. 
 

If no checks are highlighted, all checks listed will be printed.  
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Note If you have some employees set up for ACH or Web Direct Deposit, 

you should make sure they are not selected. Otherwise, you will print 

actual checks for them unnecessarily. You can always print their check 

information on blank paper, separate from the check run. Or select the 

Email button to email a stub to those employees. 
 
 

4 Select and set any necessary email, format and print options 

and click Print. 
 

If one or more checks jam in your printer, you can reprint the 

check with a new check number. For details, see “Modifying 

Payroll Checks” on page 147. 
 

Emailing Paystubs to Employees 
 

You may wish to send paystubs to employees via email, 

especially employees who participate in direct deposit. 
 

1 Click Payroll in the Command Center, then select Print Paychecks. 
 

2   Select check date(s). 
 

3 Select check or series of checks from list. 
 

4 Review the different Printing Options and Email Options. 

Select or change as needed. 
 

5 Click the Email button. 
 

An alert will appear for any paystub you try and send where no 

email address is entered in the employee setup window. The 

alert will include the employee’s last name.  
 
 
 
 
 
 
 
 
 
 

Windows: Uses Messaging Application Program Interface (MAPI) 

that is a part of the Windows operating system. This feature may 

require additional setup in your email program. This feature does 

not necessarily interface with an internet based email program. 
 

Macintosh: Emailing paystubs will only work with the Apple Mail 

program.To set Mail as the default mail program first launch the Mail 

program. Under the Mail menu, select Preferences. On the General 

tab, select the Mail program as the default. Close the Preferences 

window. 
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Email Options 
 
Send Without Prompt If you would like to have the email sent automatically without 

having to select the Send button in your email program for 

each employee, select this option. (Windows users may 

require some preference selection in your email program.) 
 

Include Non Direct         Allows you to email paystub information to employees not set 

 Deposit        up as direct deposit employees. 
 

Check Format 
 

Default Select this option if you use pre-printed laser checks that have 

the check positioned in the middle third of the page. Stubs are 

positioned top and bottom. 
 
 

Check at Top Select this option if you use a laser check that has the check 

positioned in the top third of the page, but you would like to 

align the printing fields on the check to coincide with pre-

printed positions OR your check stock is blank and your are 

printing all fields on the check. If you have more than four 

Additional Incomes and/or eight Deductions for an employee, 

we recommend using check stock with the check on top. 
 

Check at Middle Select this option if you use a laser check that has the check 

positioned in the middle third of the page, but you would like to 

align the printing fields on the check to coincide with a pre-

printed position OR your check stock is blank and you are 

printing all fields on the check. 
 

Check at Bottom Select this option if you use a laser check that has the check 

positioned in the bottom third of the page, but you would like to 

align the printing fields on the check to coincide with a pre-

printed position OR your check stock is blank and you are 

printing all fields on the check. 

 

Edit Check Format This option is only available when Custom - Check in Middle 

or Custom - Check at Top is selected. Click this button to 

access the printing fields and be able to adjust their position 

and/or enable or disable the fields from printing. For details, 

see “Formatting Checks, W-2s, and W-3s” on page 227. 
 

Printing Options 
 
Print 2nd Check Stub If Print 2nd Check Stub is checked, a second stub will be 

printed on the bottom third of an 8 1/2 by 11 inch laser check. 

 
 
Print Metafile (Win) or        If Print Metafile or Print PDF/PICT File is checked, an Open 

    dialog will appear when you print checks that allows you to 

Print PDF/PICT File      select a Metafile or PDF/PICT to print along with the check.  
(Mac)   
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Note: Windows Metafiles and Mac PICT files are graphic files 

created outside the Payroll program using a graphics/drawing 

type program. These files can be created by you to add items 

to your checks such as company logos or special messages. 

Mac will also read/print a PDF file. When selected, the Metafile 

or PDF/PICT file will print on all checks selected.  
 

Suppress Check Stub If Suppress Check Stub Frame is checked, the frame around the  
  Frame check stub that normally prints will be omitted. 

 
   Suppress SS#    If Suppress SS# is checked, employees’ Social Security 

                             numbers will not print on the check stub. 
 

Suppress Accrued   If Suppress Accrued Hours is checked, the accrued Hours Available 

   Hours       and YTD Used hours will not print on the check stub. 
 
    Company Info on Stub      If Company Info on Stub is checked, your company’s name, 

address, city, state, zip and phone number from the Company 

Information window will appear across the top of the check stub. 
 
 

Note: If check box “Use on reports and checks” on the 

Company Information screen is selected, the Trade Name will 

print on the check stub.  
 

Print Blank Check Fields      If Print Blank Check Fields is checked, “Pay”, “To the Order  

      of”,“Amount”, and “Authorized Signature” field labels on 

      blank check stock used for MICR encoding will print. 

      Available with middle check layout only. 
 

Show Direct Deposit If Show Direct Deposit Account is checked. 
Account 

MICR Encoding 
 

CheckMark Payroll will print the MICR Encoding information on 

blank check stock. To enable MICR printing, you must select 

the print MICR checkbox and fill in the appropriate bank 

information fields. 
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Note The MICR encoding will not print on checks for employees 

who are marked to receive direct deposit. 
 
 

Bank Routing #  This is a nine digit number to identify your bank. It is usually the first  
  nine digits at the bottom on a pre-printed check. 

 
Company Account# This is your company account number at the bank. This 

field will accommodate up to 15 digits. 
 

Bank Name, Bank This is the information that identifies your bank.  
Address, Bank City  

State, Zip 
 

Fractional Routing # Almost all checks have a fraction at the top right side of the 

check. Some do not. The fraction is shown as a hyphenated 

numerator (top) over a three to four digit denominator 

(bottom. This number is also called a Non-MICR ACH#.  
 

Note In most cases, the MICR software automatically prints the symbols. 
 

Manually enter the symbols as: 
 

Enter a “D” (capital D) to type a MICR hyphen: DS 
 

Enter a “C” (capital C) to type this symbol: C 
 

Enter an “A” (capital A) to type this symbol: A  
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Modifying Payroll Checks 
 

Once paychecks have been created, you can use the Modify 

Paychecks window to modify check numbers, modify and void 

check numbers, change period start and end dates, void or 

delete employee paychecks. 
 

When you open the Modify Paychecks window, checks already 

created in CheckMark Payroll are listed on the left with the 

coordinating check date selected. By default, the last check date 

created is the date selected when entering the window. To see 

details of an individual check, select the check on the left and 

details will be displayed on the right side under Check Details.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Once selected, a check’s calculations appear in Check Details. 

Items displayed in this part of the screen cannot be modified. If 

more than one check is selected, nothing will be displayed in 

Check Details. 
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Modifying a Check Number 
 

1 Click Payroll in the Command Center, then select Modify Paychecks. 
 

2 Select the check date for the check(s) that you want to display in the list. 
 

3 Select one or more checks to modify. 
 

You can select a consecutive range of checks from the list. 
 

4 Enter the new starting check number in the Check # edit box, 

then click Modify. 
 
 

Note An alert will appear if duplicate check numbers are entered 

in the current list. 
 

 

Note If you selected a range of checks, they will all be renumbered 

consecutively. If the checkbox for Direct Deposit is checked, 

make sure you use the numbering sequence for your Direct 

Deposit checks. 

 
If you need to print this check on check stock, de-select t5he check 

box, change the Check # displayed in the Check # box and then 

select Modify. When prompted, select whether you wish to save 

the direct deposit number as a void item in your list. 
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Note An alert appears asking if you want to retain existing check 

number as “Void” before renumbering. 
 

 

Modifying Period Start and End Dates 
 

1 Click Payroll in the Command Center, then select Modify Paychecks. 
 

2 Select the check date for the check(s) that you want to display in the list. 
 

3 Select one or more checks to modify. 
 

You can select a consecutive range of checks from the list. 
 

4 Enter the new Period Start and/or Period End dates in the 

Date(s) edit box, then click Modify. 
 
 

Note If a check date was entered incorrectly, you must delete checks with 

incorrect date and then re-enter the paycheck with correct check date. 
 
 

Voiding a Check 
 

You can void an employee’s paycheck, which retains the check 

number, replaces the employee’s name with “Void,” and subtracts 

the check amounts from the employee’s year-to-date balances. 
 

1 Select the check date for the check(s) that you want to display in the list. 
 

2 Select one or more checks to void. 
 

You can select a consecutive range of checks from the list. 
 

3 Click Void. 
 

An alert appears asking if you want to mark the check(s) as void. 
 

4 Click Yes.  
 

Note There is not a general ledger in CheckMark Payroll. Voided paychecks 

may still need to be recorded in your accounting program as certain 

programs will not allow for posting of a $0.00 item. 
 
 

Deleting a Check 
 

Deleting a check removes all information associated with the 

check and subtracts the values from the employee’s year-to-

date balances. 
 

1 Select the check date for the check(s) that you want to display in the list. 
 

2 Select one or more checks to delete. 
 

You can select a consecutive series of checks from the list.  
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3 Click Delete. 
 

An alert appears asking if you want to remove the amounts 

from the employee’s YTD balances. 
 

4 Click Yes.  
 

Note If you Void or Delete a check for an employee after another 

check has been created for that same employee, you will receive 

an alert warning that the limits for Social Security, SUTA and 

FUTA could be adversely affected.  
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Allocating Wages After Paychecks are Created 
 

You can use the Allocate to Depts/Jobs window to allocate an 

employee’s wages and employer taxes to more than one 

Department or MultiLedger Job after a check has been created. 
 

You can also use the Allocate to Depts/Jobs window to re-

allocate an employee’s hours that were allocated using the 

Distribute Hours window. If you re-allocate hours for hourly 

employees on this window, the employee’s wages are re-

allocated automatically as well. 
 

Please note that re-allocating hours for salaried employees 

does not automatically allocate their wages by department 

or job. 
 

Re-allocating Hours for Hourly Employees 
 

If you created a check for an employee after entering hours by 

Department or Job on the Distribute Hours window, you can 

re-allocate those hours to Departments or Jobs on the Allocate 

to Depts/ Jobs window without having to delete the check and 

recalculate pay for that employee. 
 

1 Click Payroll in the Command Center, then select Allocate to 

Depts/ Jobs. 
 

2 Select Department or Job. 
 

3 Select the appropriate check date from the Check Dates list. 
 

4 Select the appropriate check from the list on the left. 
 

Checks that have already been allocated to Departments or Job 

on the Distribute Hours window are prefaced with an asterisk 

(*). A window similar to the following appears 
 

:  
 
 
 
 
 
 
 
 
 
 

 

5 Select the hours you want to change, enter the correct hours 

for each Department or Job, then press TAB. 
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6 If Department is selected, a list of Departments appears.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

If Job is selected, an Open File dialog appears when you tab 

to the Job number field. Locate the MultiLedger company 

containing the Jobs you wish to use, then click Open. 
 

You may have to change folders in the dialog box to locate the 

MultiLedger company. The MultiLedger company you select must be 

closed in order for the Jobs to be loaded into your Payroll company. 
 

7 When you are finished re-allocating hours, press TAB to leave the 

last field, then click Save. 
 

When you re-allocate hours, the employee’s wages are re-

allocated automatically too. 
 

Allocating Wages and Taxes for Salaried 

Employees 
 

You can allocate a salaried employee’s wages and employer 

taxes to Departments or MultiLedger Jobs using the Allocate 

to Depts/Jobs window after a check has been created. 
 

1 Click Payroll in the Command Center, then select Allocate to 

Depts/ Jobs. 
 

2 Select Department or Job. 
 

3 Select the appropriate check date from the Check Dates list. 
 

4 Select the appropriate check from the list on the left. 
 

Checks that have already been allocated to Departments or 

Jobs are prefaced with an asterisk (*). 
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If the check has been allocated already, you’ll need to 

select the amount to be re-allocated. If the check has not 

been allocated, the amount appears in the edit box.  
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If you are allocating by Department, skip to step 5. 
 

If you are allocating by MultiLedger Job, and you have not 

already loaded the jobs into your Payroll company, an Open 

File dialog appears. 
 

You may have to change folders in the dialog box to locate the 

MultiLedger company. The MultiLedger company you select must be 

closed in order for the Jobs to be loaded into your Payroll company. 
 

Click Open to load the Jobs into your Payroll company. 
 

5 Enter the wage amount that you want to allocate to a Department 

or Job, then press TAB. 
 
 

Important The Wage amount that appears consists of salary wages only, 

and does not include any Additional Income amounts, unless 

the Additional Income category is set up with the Include with 

Wages for Dept/Job Posting option checked.  
 

If you are editing an existing allocation, you can select the desired 

line of allocation for editing, then enter the correct wage amount. 
 

To delete a line of allocation, select the line, then click Delete Line.  
You will need to re-allocate the remaining wages amounts. 

 
6 Select the Department or Job from the list and click OK. 

 
7 When the remaining wages amount is zero, click Save. 

 

Deleting Allocations 
 

1 Click Payroll in the Command Center, then select Allocate to 

Depts/ Jobs. 
 

2 Select the appropriate check date from the Check Dates list. 
 

3 Click Undo. 
 

Checks that have already been allocated to Departments or 

Jobs are prefaced with an asterisk (*). 
 

The check will no longer have an asterisk next to it indicating 

that it no longer has allocated amounts. 
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After an employer payee is setup on the Employer Payees window 

and at least one paycheck has been created, you can calculate the 

amount of liability based on a single check date or range of check 

dates and create payment checks on the Create Payments 

window. CheckMark Payroll allows you to override the amount of 

liability by selecting the amount box and changing the amount you 

wish to submit on the payment check. Calculations are based on 

the paychecks created for the check date(s) selected. 
 

You can select up to five payee categories at one time, but types 

Fed and 940 payments have to be made as individual checks and 

cannot be combined with each other or any other liability payment. 
 
 

Important Creating payment check in the CheckMark Payroll program in 

no way affects your employer reports. 
 

 

Creating Employer Payments 
 

1 Click Payroll in the Command Center, then select Create Payments.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select the date or range of dates for the employer payment 

calculation from the Check Dates list. 
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3 Select the Payee(s) for the payment from the Payees list. 
 

You can select up to five different payees per check by dragging 

through the list for consecutive selections, or using the CTRL key 

(Windows) or Command (  ) key (Mac) for a non-consecutive 

selections. If you don’t see the payees you want in the list, they 

haven’t been set up on the Employer Payees window. For details, 

see “Chapter 13 Setting Up Employer Payees” on page 93  
 

Note You cannot combine 941 and 940 payments.  
 

4 Click Calc Amount. 
 

The calculated amount appears in the edit box.  
 

Note You can override the calculated amount shown for the payment by 

editing the value in the Amount edit box. However, if you override 

the calculated amount on this window, it will not change any 

reports, as they are based solely on paychecks created. 
 

Once calculated, an employer payment’s calculations appear in the 

middle box. You cannot edit the calculation details. The calculation 

details for State W/H do not appear, only the amount due. 
 
 
 
 
 
 
 
 
 
 

 

5 Verify the check number and date and change if necessary. 
 

Check numbers can be up to 8 numbers in length. Letters 

and other characters entered will be truncated. 
 

6 Click Create Check.  
 

Important Employer Payments can only be created with a check date in 

the current payroll year. 
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Printing Employer Payment Checks 
 

After you’ve created the employer checks, you can print them 

with the Print Payments window. Printing checks is optional 

because it’s not necessary for employer check reports. 
 

Checks can be printed or reprinted. Reprinting a check doesn’t 

affect employer check reports. In the list, checks that have 

already been printed have an asterisk (*) after the check number. 
 

You can select the print font for printing checks on the Select 

Print Font window located under the File menu. 
 
 

Note Formatting and printing options for payments are based on format and 

printing options set in Print Paychecks including the MICR encoding. 
  

1 Click Payroll in the Command Center, then select Print Payments.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select the month for the checks that you want to display in the list. 
 

3 Select one or more checks from the list. 
 

If no checks are highlighted, all checks listed will be printed. 
 

You can select a consecutive or non-consecutive series of checks. 
 

4 Make sure you’ve loaded checks (or blank paper) into your printer. 
 

5 Click Print.  
 

Tip To verify the print alignment on your specific printer, print a check 

on a blank piece of paper. Then hold a blank check underneath 

the printed check values to test the alignment.  
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Modifying Employer Payment Checks 
 

The Modify Payments window allows you to modify check 

numbers, change dates, void or delete employer payment checks. 
 

When you open the Modify Payments window, payments 

already created in CheckMark Payroll are listed on the left 

with the month of the last payment selected. 
 

Check Number The Check Number field displays the number of the items 

selected. If more than one item has been selected, the check 

number displayed will coincide with the first item in the list 

selected. If a group has been selected, all checks will be 

renumbered consecutively. When prompted, select whether 

you wish to save the “old” check number(s) as void in your list. 
 

Check Date The Check Date field displays the dates entered on the Check 

Dates window when you entered the Calculate Pay window. You 

can change the month and day, but the year must coincide with 

the payroll year displayed on the Company Information window. 
 

 

Important: You cannot modify the Check Date of a paycheck. If 

the Check Date was entered incorrectly, you will need to delete 

the checks with the incorrect Check Date and re-enter the 

paycheck with the correct check date.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Modifying the Check Number or Date for 

an Employer Check 
 

1 Click Payroll in the Command Center, then select Modify Payments. 
 

2 Select the month for the check that you want to display.  
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3 Select the check that you want to modify from the list. 
 

4 Modify the check number or check date in the edit boxes.  
 
 
 
 
 
 
 

 

5 Click Modify.  

Voiding an Employer Check 
 

Voiding an employer check retains the check number, 

replaces the payee’s name with “Void,” and subtracts the 

amounts from the employee’s YTD balances. 
 

1 Select the month for the check that you want to display. 
 

2 Select the check from the list.  
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3 Click Void. 
 

An alert appears asking if you want to mark the check as void. 
 

4 Click Yes. 
 

Deleting an Employer Check 
 

Deleting removes all information associated with the selected check 

and subtracts the amounts from the employee’s YTD balances. 
 

1 Select the month for the check that you want to display. 
 

2 Select the check from the list. 
 

3 Click Delete. 
 

An alert appears asking if you want to delete the check. 
 

4 Click Yes.  
 

Note If you Void or Delete a check for an employee after another 

check has been created for that same employee, you will receive 

an alert warning that the limits for Social Security, SUTA and 

FUTA could be adversely affected.  
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Information to 

MultiLedger 
 

This chapter shows you how to post employee check and 

employer payment information to CheckMark’s MultiLedger 

accounting package. 
 

Posting Employee Checks to MultiLedger 
 

Employee check information from CheckMark Payroll can be 

posted to MultiLedger by following these instructions. 

Paychecks post to MultiLedger as two general journal entries. 
 

Set up Ledger Accounts in CheckMark 

Payroll 
 

Before posting to MultiLedger, you should assign account 

numbers to payroll categories in CheckMark Payroll. 
 

1 In CheckMark Payroll, click Setup in the Command Center, then 

select Ledger Accounts. 
 

2 Assign MultiLedger account numbers to all applicable Payroll Categories. 
 

For more information on setting up Ledger Accounts, see 

“Chapter 14 Setting Up Ledger Accounts” on page 97 
 

Review Posting Summary 
 

After you have calculated payroll and created checks in CheckMark 

Payroll, you should review the Posting Summary to make sure the 

information is correct before you post to MultiLedger. 
 

3 In CheckMark Payroll, click Reports in the Command Center, then 

select Employee Paychecks, then select Posting Summary. 
 

4 Select the appropriate Check Date(s). 
 

5 Highlight the checks that you want to review from the list on the left. 
 

If no checks are highlighted, information for all checks 

will be reported. 
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6 Click View or Print. 
 

The Posting Summary report shows check information in a 

summarized format. The net for each check is shown, along 

with totals for wages, income, taxes, and deductions. Employer 

payroll taxes are shown as an entry at the bottom of the report. 

These are accrued tax liabilities and total expense for Social 

Security, Medicare, FUTA, and SUTA. 
 

7 Verify that all ledger accounts are assigned correctly. 
 

Posting to MultiLedger 
 

8 Make sure you have your MultiLedger company files open. 
 

9 In CheckMark Payroll, click Reports in the Command Center, 

then select Employee Paychecks if you haven’t already. 
 

10 Select the appropriate Check Date(s). 
 

11 Select CheckMark from the Format drop-down list. 
 

12 Highlight the checks that you want to post to MultiLedger from the 

list on the left. 
 

If no checks are highlighted, all checks will be posted/sent to  
MultiLedger to be posted. 

 
13 If you distribute wages or hours to jobs, you should check the 

Include Jobs in Post Summary option. 
 

14 Check the Mark Posted Checks option. 
 

That way, checks that have been posted to MultiLedger will be 

marked with an "x". Using this feature does not prevent posting 

again if you delete the general journal entries in MultiLedger. 
 

15 Verify that the Checks Reference #, Taxes Reference #, Checks 

Posting Date, and Taxes Posting Date are correct. 
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You can use these edit boxes to enter reference numbers and 

posting dates for checks posted to MultiLedger. The default 

name for the Checks Reference # is "PR" followed by the date 

of the first unmarked check in the list. The default name for the 

Taxes Reference # is "ET" followed by the date of the first 

unmarked check in the list. For information on marking checks 

that have been posted to MultiLedger, see step 13 above. 
 

The default date for the Checks Posting Date and Taxes Posting 

Date is the date of the first unmarked check in the list. If 

necessary, you can change the information in these edit boxes. 
 
 

Note If you need to post payroll checks that have the same date as checks 

you've already posted, you should change the Checks Reference # 

and Taxes Reference #. Otherwise, you will receive an error message 

and the posting will fail, as MultiLedger cannot accept entries with 

both the same reference number and same date. 
 
 

16 Click Post to MultiLedger. When the posting is complete, a 

message appears, "Post command sent to MultiLedger". The 

checks will be posted to the general journal in MultiLedger. 
 

Voided checks will also post over to MultiLedger as 0.00 in the general 

journal entry and appear as 0.00 in the bank reconciliation window. 
 

17 Click OK.  
 

Note When you receive the message that the posting has been sent, it does 

not necessarily mean that the posting was successful. The posting 

process sends information from CheckMark Payroll to MultiLedger, but 

does not send information from MultiLedger back to CheckMark 

Payroll. You should check the General Journal in MultiLedger to make 

sure the PR and ET entries were sent correctly. You should see two 

entries in the General Journal in MultiLedger. A PR-[date] entry for 

employee paychecks and an ET-[date] entry for employer taxes. 
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Posting Employer Checks to MultiLedger 
 

Employer payment checks from CheckMark Payroll can be 

posted to MultiLedger by following these instructions. Employer 

Payments post to MultiLedger’s Disbursements journal. 
 

Set up Ledger Accounts in CheckMark 

Payroll 
 

Before posting to MultiLedger, you should assign account 

numbers to payroll categories in CheckMark Payroll. 
 

1 In CheckMark Payroll, click Setup in the Command Center, then 

select Ledger Accounts. 
 

2 Assign MultiLedger account numbers to all applicable 

Payroll Categories. 
 

Review Posting Summary 
 

After you have created employer payment checks in CheckMark 

Payroll, you should review the Posting Summary to make sure the 

information is correct before you post to MultiLedger. 
 

3 In CheckMark Payroll, click Reports in the Command Center, 

then select Employer Payments, then select Posting Summary. 
 

4 Select the month. 
 

5 Highlight the checks that you want to review from the list on the left. 
 

If no checks are highlighted, information for all checks 

will be reported. 
 

6 Click View or Print. 
 

7 Verify that all ledger accounts are assigned correctly. 
 

Posting to MultiLedger 
 

8 Make sure you have your MultiLedger company files open. 
 

9 In CheckMark Payroll, click Reports in the Command Center, 

then select Employer Payments if you haven’t already. 
 

10 Select the month or series of months. 
 

11 Highlight the checks that you want to post to MultiLedger from the 

list on the left. 
 

If no checks are highlighted, all checks will be posted/sent to 

be posted to MultiLedger. 
 

12 Select CheckMark from the Format pull-down menu.  
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13  Click Post to MultiLedger. 

 

If a vendor does not exist in MultiLedger, you will be asked to 

add the vendor. When the posting is complete, a message 

appears, "Post command sent to MultiLedger". The checks will 

be posted to the Disbursements Journal in MultiLedger. 
 

14 Click OK.  
 

Note When you receive the message that posting has been sent, it does not 

necessarily mean that the posting was successful. The posting process 

sends information from CheckMark Payroll to MultiLedger, but does not 

send information from MultiLedger back to CheckMark Payroll. 

You should check the Disbursements Journal in MultiLedger 

to make sure the checks were sent correctly.  
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Part 4 
 

Reports 

 
 

 
CheckMark Payroll offers a variety of reporting options. Most reports 

can be viewed on screen, printed, saved as a text or .xls file. 
 

Using the Report Windows 
 

This brief section shows you how to use the tool bar on the 

report windows and how to look for items in lists and on-screen 

reports with the Find command. 
 

Using CheckMark Payroll’s Tool Bar with 

Reports 
 
 
 
 
 
 

 

When you click View, the report appears on your screen. You 

can then use the Find command under the Edit menu to look 

for specific items on the report. To close an on-screen report, 

choose Close from the window’s Control menu or click the 

close box in the corner of the report window.  
 
 

When you click Print, a Print dialog appears. Select the print 

options that you want, and click Print. 
 

 

When you click Text File, a Save dialog appears. Enter a name for the 

text file and choose a directory in which to save it. Then, click Save. 

 

When you click XLS File, a Save dialog appears. Change the 

name of the .xls file if you want and click Save. It is recommend 

that you use the import function, instead of just opening, the .xls 

file into a spreadsheet program. This can provide better formatting. 
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Using the Find Command with Reports 
 

Some on-screen reports allow you to use the Find and Find 

Again commands under the Edit menu. You can search for 

anything that can be entered from your keyboard, such as 

check numbers, names, or amounts. 
 

You can also use the Find and Find Again commands for 

screens that list your employee list such as the Employee Set 

Up screen or the Employee Earnings window. 
 

When you choose Find from the Edit menu, the following 

window appears: 
 
 
 
 
 
 
 
 
 
 
 
 

 

Enter the characters that you want to search for and click 

Find. The report line containing those characters is 

highlighted. The Find command is not case sensitive. 
 

Find Again looks for the next occurrence of the last characters 

entered in the Find edit box. 
 
 

Note If the report is long enough to create a scroll bar along the right hand 

side of the report, you can scroll down using your mouse’s scroll wheel. 
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Copy and Paste Report Information 
 

For each report, you can use the View command button to 

view the information. Using your mouse, you can highlight all 

or any specific information listed in the report and Copy that 

information to your computers clipboard. You can then open 

up any word processing or spreadsheet program and Paste 

the information into that system for further modification. 
 

This can be helpful if you want to create a report on specific 

information in a report instead of exporting all the information 

as a .txt or .xls file. 
 

Example of Employee’s Information Copy and Paste 
 

1 Open up the Employee Information report screen. Select the 

Personal Information option and click View. 
 

2 Using your mouse, highlight the information you want to Copy by 

holding down the mouse button and dragging the cursor until all 

content is highlighted.  
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3 Go under the Edit menu at the top of the screen and select Copy.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 Open up a word processor or spreadsheet program and use 

the Paste function in that program to insert the information. 
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Types of Employee Information Reports 
 

Personal Information The Personal Information report shows the employee personal 

data, including name, address, phone number, Social Security 

number, birth date, employee number, employment status, 

email address and default department. 
 

Wage Information The Wage Information report shows the employee’s salary or 

hourly rates, pay frequency, hire date, last raise date, 

termination date, accrued hours available, and department/job 

distribution percentages, and direct deposit if marked. 
 

Tax Information The Tax Information report shows the tax set up for the 

employee including, W-2 options, selected federal, state, 

SUTA state, local tables, and more. 
 

Income/Deduction        The Income/Deduction Information report shows the Additional 

Information                   Income and Deduction categories and their associated 

       definitions that have been set up for the selected employees. 
 

Creating Employee Information Reports 
 

1 Click Employee Information in the Command Center.  
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2 Select the employee or employees for the report. 
 

You can select a consecutive or non-consecutive series of 

employees from the list by dragging through the list or using 

the CTRL key (Windows) or Command (  ) key (Mac). 
 

If no employee names are highlighted, all employees will be reported. 
 

3 Select the type of report. 
 

4 Click View, Print, Text File or XLS File.  
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Types of Employee Earnings Reports 
 

Earnings Register For the range of check dates selected, the Earnings Register 

report shows the employee’s selected check period along with 

YTD income, deductions, taxes, and net pay, as well as any 

employer matching amounts. Totals for the company are listed 

at the end of the report. You can see this report arranged by 

department by selecting the By Department checkbox. 
 

Hours Register For the range of check dates selected, the Hours Register report 

shows the employee’s selected check period and year-to-date 

hours for hour categories as well as accrued hours available. 
 

You can also get an Hours Register report that contains only Hours 

Worked. Simply check the Hours Worked Only box. This report is 

helpful in filling out worker’s compensation reports or SUTA 

reports in states where this information is required. 
 

Check Summary The Check Summary report shows an employee’s income, 

taxes, deductions, and net, vacation and sick pay for each 

check in the selected check dates. Totals for all categories 

are also shown by employee. 
 

Check Details The Check Details report shows income, tax amounts, deductions, 

total tax amounts, total deductions, and net pay by check for each 

selected employee for the selected check dates. Totals for 

selected employees are listed at the end of the report. 
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Creating Employee Earnings Reports 
 

1 Click Employee Earnings in the Command Center.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select the employee or employees for the report. 
 

You can select a consecutive or non-consecutive series of 

employees from the list by dragging through the list or by 

using the CTRL key (Windows) or COMMAND (  ) key (Mac). 
 

If no employee names are highlighted, all employees will be reported. 
 

3 Select the type of report. 
 

4 Choose one or more check dates. 
 

You can select a consecutive series of check dates from the list 

by dragging through the list. For details, see “Making 

Selections in a List Box” on page 13 
 

5 Click View, Print, Text File or XLS File.  
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Types of Employee Paycheck Reports 
 

Check Register The Employee Check Register report shows check data for the 

selected check dates, including number of hours, hourly rates, 

income, deductions, net pay, and department/job distribution 

percentages and amounts. Company totals are shown at the 

bottom of the report, including 941 liability and the number of 

checks in the selected period. 
 

Posting Summary The Posting Summary report shows check information in a 

summarized format and can be used to create manual journal 

entries in your accounting system. (You can also save the 

posting summary information as a text file that can be imported 

into an accounting program.) 
 

The net for each check is shown, along with totals for wages, 

income, taxes, and deductions. 
 

Ledger accounts are also shown with their associated 

amounts. If you have ledger accounts set up for department or 

job wages and taxes, then the ledger accounts and amounts 

for each department or job are shown. The total debits and 

credits are shown on the last two lines. 
 

ACH Direct Deposit CheckMark Software allows you to utilize direct deposit for 

your employees through your financial institution. Payroll 

creates an ACH file that you can submit directly to your bank. 

For more information on setting up CheckMark Payroll for 

Direct Deposit, see “Using CheckMark Payroll for ACH Direct 

Deposit” on page 247. 
 

The ACH Direct Deposit text file contains only checks created 

for employees who are set up as Direct Deposit employees on 

the Personal tab of the Employees window. 
 

Web Direct Deposit You can export a file for use with National Payment 

Corporation’s Web Direct Deposit. For more information on 

Web Direct Deposit, see “Using CheckMark Payroll for Web 

Direct Deposit” on page 250. 
 

The Web Direct Deposit text file contains only checks for 

employees who are set up as Direct Deposit employees on the 

Personal tab of the Employees window. 
 
           ACH NPC Direct        You can export a file for use with National Payment 

                  Deposit               Corporation’s Direct Deposit. For more information on ACH 

NPC Direct Deposit, see “Using CheckMark Payroll for ACH 

NPC Direct Deposit” on page 251. 
 

The ACH NPC Direct Deposit text file contains only checks for 

employees who are set up as Direct Deposit employees on the 

Personal tab of the Employees window.  
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Employee Checks Report Options 
 

Include Jobs in Post         If you distribute wages or hours to MultiLedger Jobs, you     

Summary                 should check this box before posting to MultiLedger. For more       
information on posting to MultiLedger, see “Chapter 26 Posting 

Payroll Information to MultiLedger” on page 163 
 

Mark Posted Checks If you post paychecks to one of the accounting packages 

listed in the Format menu, you can check this box so that 

each time you post paychecks, they will be marked with an 

“x.” 
 

Use Employee # If using Web Direct Deposit and you would rather use an employee 

ID number instead of the Social Security number, you can mark 

this checkbox. You must also set up to use Employee ID # on 

National Payment Corporation’s Web Direct Deposit set up page. 

For more information on using Web Direct Deposit, see “Using 

CheckMark Payroll for Web Direct Deposit” on page 250. 
 

    Checks Reference #    These boxes are for posting information to Multiledger. For Taxes  
 

Posting File Formats 
 

Quicken (QIF) You can export posting information to Intuit’s Quicken. Select 

the Quicken (QIF) option and click Text File. Enter Bank 

Account Name and whether you want to print checks from 

Quicken. A Save dialog appears. Enter a name for the text file 

and choose a directory in which to save it. Then, click Save. 
 

QuickBooks (IIF) You can export posting information to Intuit’s QuickBooks program. 
 

1 Select the QuickBooks Format option from the dropdown menu 

and click Text File. A pop up screen opens with a list of Expense 

and Liability accounts. You can use the Default Account Names or 

if you want to post to your current QuickBooks accounts, you can 

change the QuickBooks Account Name. To change the name, 

click the account you want to change under the QuickBooks 

Account Name column and type in a new name. 
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2 Enter Bank Account Name and check the box if you want to print 

checks from QuickBooks. 
 

3 Click Save once you have finished entering your data. 
 

4 Click Ok. Enter a name for the text file and choose a directory in 

which to save it. Then, click Save. 
 

Moneyworks You can export posting information to Moneyworks. Select the 

Moneyworks format option and click Text File. A Save dialog 

appears. Enter a name for the text file and choose a directory 

in which to save it. Then, click Save. 
 

Peachtree 3.0 (Windows only) You can export posting information to 

Peachtree Accounting for Windows, version 3.0. Select the 

Peachtree 3.0 Format option and click Text File. A Save dialog 

appears. Enter a name for the text file and choose a directory 

in which to save it. Then, click Save. 
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Peachtree 3.5, 5.0 (Windows only) You can export posting information to 

Peachtree Accounting for Windows, version 3.5 or 5.0. Select 

the Peachtree 3.5, 5.0 Format option and click Text File. A 

Save dialog appears. Enter a name for the text file and 

choose a directory in which to save it. Then, click Save. 
 

Sage 50 / Peachtree You can export posting information to Sage 50. Select the Sage 

50 format option and click Text File. A Save dialog appears. 

Enter a name for the text file and choose a directory in which to 

save it. Then, click Save. 
 

M.Y.O.B. You can export posting information to Best!Ware’s M.Y.O.B.™ 

Select the M.Y.O.B. Format option and click Text File. A Save 

dialog appears. Enter a name for the text file and choose a 

directory in which to save it. Then, click Save. 
 

Big Business You can export posting information to Big Business. Select the 

Big Business Format option and click Text File. A Save dialog 

appears. Enter a name for the text file and choose a directory 

in which to save it. Then, click Save. 
 

CheckMark You can post information to CheckMark’s MultiLedger program. 

For more details about exporting to CheckMark’s MultiLedger, 

see “Chapter 26 Posting Payroll Information to MultiLedger” on 

page 163. 
 

Rakefet (Windows only) You can export posting information to Rakefet. 

Select the RAKEFET Format option and click Text File. A Save 

dialog appears. Enter a name for the text file and choose a 

directory in which to save it. Then, click Save. 
 

DBA Software (Windows only) You can export posting information to DBA 

Software. Select the DBA SOFTWARE Format option and click 

Text File. A Save As dialog appears. Enter a name for the text 

file and choose a directory in which to save it. Then, click Save. 
 

POS/OE 4 You can export posting information to POS/OE 4. Select the 

POS/OE 4 Format option and click Text File. A Save dialog 

appears. Enter a name for the text file and choose a directory 

in which to save it. Then, click Save. 
 

Connected You can export posting information to Connected accounting. 

Select the Connected Format option and click Text File. A Save 

dialog appears. Enter a name for the text file and choose a 

directory in which to save it. Then, click Save.  
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Creating Employee Paycheck Reports 
 

1 Click Employee Paychecks in the Command Center.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select one or more consecutive check dates for the report. 
 

You can select a consecutive or non-consecutive series of 

checks from the list. 

 
 

3 Select the type of report. 
 

4 Click View, Print, Text File or XLS File.  



182 Chapter 29 Employee Paychecks  



Types of Department Job Reports 183  
 

Chapter 30 Departments /Jobs 

 

Types of Department Job Reports 
 

Wages & Hours This report shows wages and number of hours for each 

department or job for each income category, including salary, 

all hour categories, and other income amounts. Totals for 

wages and hours for the selected report range appear after 

each department/job, and company totals appear at the end of 

the report. 
 

Check Summary This report shows detail for each department’s or job’s expense 

for wages and employer taxes (employer portions of Social 

Security, Medicare, FUTA, and SUTA). Details include 

employee name, check date, check number, hours, wages and 

employer taxes. Totals for wage expense and employer tax 

expense for the selected report range appear after each 

department/job, and company totals appear at the end of the 

report 
 

Creating Department/Job Reports 
 

1 Click Departments/Jobs in the Command Center.  
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2 Select either the Departments or Jobs radio 

button. If you selected Departments, 

proceed to step 3. 

  
If you selected Jobs, an open dialog appears. Locate your 

MultiLedger company, then click Open. The Jobs from the 

MultiLedger company appear in the list. 
 

3 Select the departments or jobs for the report. 
 

You can select a consecutive or non-consecutive series of 

departments or jobs from the list. 
 

If no departments or jobs names are highlighted, all 

departments or jobs will be reported. 
 

4 Select one or more consecutive check dates for the report. 
 

5 Select the type of report. 
 

You can select either Wages & Hours or Check Summary 

for the report. 
 

6 Click View, Print, Text File or XLS File. 
 

.  
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Chapter 31 Federal Taxes 

 

You can print forms 941, 943 and 944 from the Federal Taxes 

window along with a Tax Summary report. 
 
 

Note The latest version of Adobe Acrobat Reader must be installed 

and set as the default .pdf application on your system to print 

forms 941, 943 and 944 from CheckMark Payroll.  

 

Setting an Application as the Default Program 
 

 
Mac OS X Users: You set the default in the Get Info screen on 

any .pdf file you have on your computer. Select any .pdf file 

and then go under the File menu to Get Info. Under the Open 

With section, select the Adobe Reader program and then select 

the box that will have wording similar to ‘use the application to 

open all documents like this’. The wording may vary depending 

on which version of OS X you are using. 
 

You may also have to set the actual files to open with Adobe 

Reader. CheckMark Payroll creates .pdf and .fdf files when 

printing forms such as 940, 941, 943 and 944. These files are 

generated in the folder where you save your data files. Select 

these files and assign Adobe Reader as the default program to 

open correctly. Refer to your operating system’s owner’s 

manual for more detail about setting defaults. 

   
Windows 7 or higher: Open the Control Panel and/or select 

Default Programs. Choose Associate file type or protocol with a 

program. Scroll down to .fdf in the list. If necessary, select, 

choose program and browse for Adobe Reader. Repeat steps 

for .pdf file extension. Close. Refer to your operating system’s 

owner’s manual for more information.  
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Types of Federal Tax Reports 
 

Tax Summary The Tax Summary report shows tax information, including 

employee names, total wages and tips, federal withholding, 

Advance EIC, Social Security wages, Social Security tips, and 

Medicare wages and tips for the selected quarter or current 

payroll year. You can use this tax data for filling out the Federal 

941 form or use the annual report for filing form 943 or 944. 
 

Each type of withholding is summarized and the total taxes due 

are shown after the employee list. An amount shown for 

Adjustment for Fractions will print on line 7a of the 941 (6a on 

Form 944) report in the Fractions of Cents field. An amount on 

the Adjustment for Fractions line is usually due to Social 

Security and Medicare rounding and is typically less than one 

dollar. If the amount is larger, a warning will come up and you 

should research the cause. For more information, see “What 

can cause an amount to appear on the “Adjustment for 

Fractions” line?” on page 192. 
 

The second half of the report is the Employer’s Record of 

Federal Tax Liability. This section shows tax liability information 

based on actual payroll checks that have been created for the 

quarter only. If you view the annual Tax Summary report, this 

part of the report gives monthly liabilities. 
 

State Withholding amounts, as well as the number of 

employees for each month of the quarter are shown at the 

bottom of each quarterly tax summary report.  
 
 
 
 
 

 

 
Form 941 Choose this option to print the 941 on plain paper. 

 
Form 943 Choose this option to print the 943 on plain paper. 

 
Form 944 Choose this option to print the 944 on plain paper. 
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Creating 941 Reports 
 

The Federal Taxes window prints the Form 941, Employer’s 

Quarterly Federal Tax Return form and gives you information 

that’s useful for filling out the form manually. 
 

1 Click Federal Taxes under Reports in the Command Center.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 Enter the 2 letter state postal code where you make your deposits 

or MU if you make deposits in multiple states. 
 

3 If necessary, enter information for Third-party designee and/or For 

paid preparers only (optional). 
 

4 Select the quarter for which you are reporting. 
 

5 Select the Form 941 Report Option. 
 

6 Click Print. A pop up window appears.  
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Note Be sure to change the amount in the Line 11 Total Deposits 

field, if different than the program calculation. 
 

If you change the Total Deposit to a number $0.40 higher or 

lower than the program calculation, the difference will show in 

fractions of cents (line 7a 941, or 6a 944). If the difference is 

more than $0.40, it will show as either a balance due (line 12) or 

an overpayment (line 13).   
7 Fill in all appropriate fields. When finished, click OK. The filled in 

Form will open in Acrobat Reader. If necessary, modify/edit any 

field in Acrobat Reader, save the file if you wish, and/or print out 

pages from Acrobat Reader.  
Changes made to Form 941 in the Adobe Reader program 

are not reflected in Payroll.  
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Creating 943 Reports 
 

The Federal Taxes window prints the Form 943, Employer’s 

Annual Federal Tax Return for Agricultural Employees and 

gives you information that’s useful for filling out the form 

manually. 
 

1 Click Federal Taxes under Reports in the Command Center.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 If necessary, enter information for Third-party designee and/or For 

paid preparers only (optional). 
 

3 Select the Form 943 Report Option. 
 

4 Click Print. A pop up window appears.  
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5 Fill in or change all appropriate fields if needed. 
 

6 Click Ok. 
 

The filled in Form will open in Acrobat Reader. If necessary, 

modify/ edit any field in Acrobat Reader, save the file if you wish, 

and/or print out pages from Acrobat Reader.  
Changes made in Adobe Reader are not reflected in Payroll.  
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Creating 944 Reports 
 

The Federal Taxes window prints the Form 944, Employer’s 

Annual Federal Tax Return and gives you information that’s 

useful for filling out the form manually. 
 

1 Click Federal Taxes under Reports in the Command Center.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Enter the two letter state postal code where you make your 

deposits or MU if you make deposits in multiple states. 
 

3 If necessary, enter information for Third-party designee and/or For 

paid preparers only (optional). 
 

4 Select the Form 944 Report Option. 
 

5 Click Print. A popup window appears.  
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If applicable, enter amounts into the fields corresponding to: 
 

• 10. Total deposits for the year, including overpayment 

from prior year 
 

• 14. If your business has closed or you stopped paying wages… 

 you need to check this box and fill in the final date you paid wages. 
 
 

6 Click Ok. 
 

The filled in Form will open in Acrobat Reader. If necessary, 

modify/ edit any field in Acrobat Reader, save the file if you wish, 

and/or print out pages from Acrobat Reader. 

 

Changes made in Adobe Reader are not reflected in Payroll. 
 

What can cause an amount to appear on 

the “Adjustment for Fractions” line? 
 

Any amount on the Adjustment for Fractions line on the Tax 

Summary report will be printed on Line 7a of the 941 on the 

Fractions of Cents field or 6a, Current Year’s Adjustments, of 

the 944. If the amount is under one dollar, the difference is 

probably due to rounding and is nothing to be concerned about. 

If the amount is large, however, you should research the 

discrepancy. Amounts of more than one dollar can be caused 

by the following: 
 

• After checks have been created, a deduction or income 

category defined as exempt has been re-defined as non-

exempt. Or a deduction or income item defined as non-

exempt has been re-defined as exempt.  
• Social Security or Medicare amounts have been manually 

adjusted on the Calculate Pay window to override the 

calculated amounts. These amounts are exact calculations 

and should not be manually adjusted.  
• An employee who was marked as Exempt from Social 

Security and/or Medicare was changed to Non-exempt. Or 

an employee who was set up as Non-exempt from Social 

Security and/or Medicare was changed to Exempt.  
• If you change the Total Deposit to a number $0.40 higher 

or lower than the program calculation, the difference will 

show in fractions of cents (line 7a 941). If the difference is 

more than $0.40, it will show as either a balance due (line 

12) or an overpayment (line 13). 
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Reporting of Third-Party Sick Pay 
 

Since no checks have been calculated and created in the 

CheckMark Payroll program for employees receiving third-party 

sick pay, their wages are not included in reports such as the 

Form 941, Form 944 and W-2/W-3 statements. Information 

regarding sick pay and federal reporting also applies to state 

reports. For more information about how your state requires 

reporting of third- party sick pay, see your state instructions or 

contact your state for more information. 

 

The information included here is for employers where the 

liability has been transferred to the employer and no optional 

rules for W-2 have been implemented. For more details about 

reporting sick pay with special rules, see IRS Publication 15A. 

 

Form 940 Annual Report 
 

Include all wages paid to each employee, including third-party 

sick pay paid to any employee during the year on your annual 

Form 940 up to the maximum wages. Wages entered in the 

Employee window YTD tab are included when calculating Form 

940 annual report. These wages will not show on the quarterly 

breakdown report unless you modify YTD totals for each 

employee prior to printing the report for 940 deposits. 

 

Form 941 Quarterly report or Form 944 

Annual report 
 

Third-party sick pay must be reported on the Form 941 

quarterly report (Form 944 annual report) of wages. You will 

need to report both the employer and the employee parts for 

both Social Security tax (up to the maximum wages) and 

Medicare tax for sick pay on lines 5a and 5c of the Form 941 

(lines 4a and 4c of Form 944). On line 7b of the Form 941 (line 

6a of Form 944) you will need to show a negative adjustment 

for the employee portion of the Social Security and Medicare 

taxes withheld from sick pay by the third-party payer. You will 

also need to report federal withholding wages on line 2. There 

is more information in Publication 15, Publication 15A or 941 

instructions at www.irs.gov.  
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Steps for Form 941 (Form 943 or 944) reporting in Payroll 
 

1 Open Federal Taxes on the Command Center. 
 

2 Select Form 941, 943 or 944 and applicable quarter or annual. 
 

3 If necessary, fill in Third-Party Designee information and/or Paid 

Preparer information and state abbreviation.  
4 Select Print, a setup screen opens. Enter Social Security and 

Medicare amount withheld by third-party as a negative number in 

edit box 7b. (See Publication 15A at www.irs.gov for more 

information about reporting Third-Party Sick Pay) Adjust amount of 

deposits on line 11 for the quarter if you have already deposited 

the employer amount of the Social Security and Medicare taxes. 

Click OK. The form opens in the Adobe Reader program. 
 

5 Modify line 2, federal withholding wages to include sick pay. 

 

6 DO NOT modify line 3 to include federal withholding withheld by 

third-party on sick pay wages. This will be reconciled later on the 

W-3 statement. 

 

7 Modify lines 5a and 5c (on Form 944, lines 4a and 4c) to include 

sick pay wages paid by third-party payer. Include sick pay wages on 

line 5a (4a on Form 944) up to the Social Security maximum taxable 

wages for the year. 

 

 

Note Modifications made in the Adobe Reader fill-in form will not 

automatically carry through the form. Adjust calculations 

through the end of all pages of the form. If necessary, you will 

also need to adjust deposits recorded on page 2 of Form 941 

(also Form 944) if you are a monthly depositor for employer 

portions of Social Security and Medicare taxes that were 

reported to you by the third-party payer.  
 

8 If you are a semi-weekly depositor, you will need to make 

adjustments for any deposits made on the Schedule B. 
 
 

Note Calculations made in the Adobe Reader program do not 

automatically calculate through the form. Be sure to make any 

necessary adjustments to calculations throughout all pages.  
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Chapter 32 940 FUTA Tax 

 

CheckMark Payroll can produce form 940 as well as a wage 

summary and quarterly liability report. 
 
 

Note A newer version of Adobe Acrobat Reader must be installed 

and set as the default .pdf application on your system to print 

form 940 from CheckMark Payroll.  

 

Setting an Application as the Default Program 

 

Mac OS X Users: You set the default in the Get Info screen on 

any .pdf file you have on your computer. Select any .pdf file 

and then go under the File menu to Get Info. Under the Open 

With section, select the Adobe Reader program and then select 

the box that will have wording similar to ‘use the application to 

open all documents like this’. The wording may vary depending 

on which version of OS X you are using. 

 

You may also have to set the actual files to open with Adobe 

Reader. CheckMark Payroll creates .pdf and .fdf files when 

printing forms such as 940, 941, and 944. These files are 

generated in the folder where you save your data files. Select 

these files and assign Adobe Reader as the default program to 

open correctly. Refer to your operating system’s owner’s 

manual for more detail about setting defaults. 

 

Windows 7 or higher: Open the Control Panel and select 

Default Programs. Choose Associate file type or protocol with a 

program. Scroll down to .fdf in the list. If necessary, select, 

choose program and browse for Adobe Reader. Repeat steps 

for .pdf file extension. Close. Refer to your operating system’s 

owner’s manual for more information. 
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Types of 940 FUTA Tax Reports 

 

Wage Summary This report shows the total annual wages, wages exempt from 

FUTA, wages over the annual limit, and total taxable wages by 

employee. 

 

Quarterly Liability This report shows total taxable wages per quarter by 

employee. In addition, this report shows total FUTA liability 

per quarter. 

 

Form 940 Choose this option to print the Form 940 on plain paper. 
 

Creating 940 Reports 
 

The 940 FUTA Taxes window prints the Form 940, Employers 

Annual Federal Unemployment (FUTA) Tax Return and gives 

you information that is useful for filling out the return manually. 
 

1 Click 940 FUTA Tax in the Command Center.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select Form 940 Report Option. 

 

3 Fill in necessary information in the 940 FUTA Tax Window as 

appropriate for your report. For more information see “Fields on the 

940” on page 197. 

 

4 Click Print. The filled in form will open in Acrobat Reader.If 

necessary, modify/edit any field in Acrobat Reader, save the file if 

you wish, and/or print out pages from Acrobat Reader. 

 

Changes made in Adobe Reader are not reflected in Payroll.  
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Fields on the 940 
 

1a Mark this box if you pay unemployment tax (SUTA) in only 1 

state. Also, fill in the two (2) letter postal abbreviation in the box 

to indicate which state you pay the unemployment taxes in. 

 

If box 1a is not selected, CheckMark Payroll will automatically 

mark box 1b on Form 940 indicating that you pay 

unemployment taxes to more than one (1) state. You are then 

required to fill in Part 1 Schedule A (940) and submit with your 

Form 940. Schedule A (940) is not printable from CheckMark 

Payroll directly so you will need to download from irs.gov 

(press link above), or fill in this form that was sent to you by the 

IRS in the mail. 

 

9 Check this box if all FUTA wages were exempt from 

state unemployment (SUTA). 

 

If line 9 is selected, line 10 does NOT apply. 

 

10 Enter the amount to print on Line 10 if some of the FUTA 

wages you paid were excluded from state unemployment or if 

you paid any state unemployment tax (SUTA) late. This 

amount is from line 7 of the worksheet included in the Form 

940 instructions. 

 

13 Enter an amount to print on Line 13 for your FUTA tax 

deposited for the year. 

 

Part 6-Third-party 

Designee 

 

Part 8: For paid 

preparers only 

(optional) 

 

Overpayment 

 

 

Enter information that will print in the appropriate section on the 

940 if you use a third-party designee. 

 

Enter information here that will print in the appropriate section 

on the 940 if you are a paid preparer. 

 

If there is an overpayment on Line 15, select whether it is to 

Apply to next return or Send a refund. 
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Chapter 33 State Taxes 

 

The State Taxes window allows you to produce a SUTA report, 

wage summary, California DE-6 Form and the MMREF file for 

NY and CA DE-6. 
 

Creating SUTA Taxes Reports 
 

The SUTA report shows wages exempt from SUTA (state 

unemployment), wages subject to SUTA, wages in excess of 

the SUTA maximum, and SUTA taxable wages. It also shows 

your SUTA rate, SUTA tax amount, number of employees per 

month and number of employees in the pay period including 

the 12th of the month for each month of the quarter. 
 

1 Click State Taxes in the Command Center.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select one or more states for the SUTA report. 
 

You can select a consecutive or non-consecutive series of 

states from the list. 
 

If no states are highlighted, all states will be reported. 
 

3 Make sure that the SUTA radio button is selected. 
 

4 Select the quarter for which you are reporting, or select Annual.  
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5 Select the Sort Employees by option. 
 

If Last Name is selected, the report will be organized by 

employees’ last name. 
 

If Social Security # is selected, the report will be 

organized by employees’ Social Security Number. 
 

6 Click View, Print, or Text File.  
 

Note You can omit social security number for employees on all reports 

by selecting Omit SS# on Reports in the Preferences option 

located under the File menu. For information on setting 

preferences see “Chapter 39 Setting Preferences” on page 231 
 

 

Creating State Withholding Reports 
 

The Wage Summary report shows the employee’s Social 

Security number, employee name, total wages, wages subject 

to state withholding, and state withholding by employee for the 

selected quarter, with a subtotal after each state. 
 

1 Click State Taxes in the Command Center.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select one or more states for the Wage Summary report. 
 

You can select a consecutive or non-consecutive series of 

states from the list. 
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If no states are highlighted, all states will be reported. 
 

3 Select the Wage Summary radio button. 
 

4 Select the quarter for which you are reporting, or select Annual. A 

list of check dates appears for the selected quarter. Check dates in 

the quarter are selected by default. If wage reporting for less than 

the full quarter is required, select the desired range of check dates. 
 

5 Select the Sort Employees By option. 
 

If Last Name is selected, the report will be organized by 

employees’ last name. 
 

If Social Security # is selected, the report will be 

organized by employees’ Social Security Number. 
 

6 Click View, Print, or Text File.  
 

Note You can omit the Social Security number from these reports 

by choosing Omit SS# on Reports in the Preferences section 

under the File menu.  

 

Creating California DE-9 Form for Printing 
 

You can print a DE 9 form for filing with the EDD directly 

from CheckMark Payroll. 
 

To print the DE-9 Form, do the following: 
 

1 Click State Taxes in the Command Center. 
 

2 Select the CA DE-9 Form option and select the desired Period option. 
 

3 Select CA in the States list. 
 

4 Click Print. A popup window appears.  
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5 Fill in all appropriate fields and click OK.  
 

Note Even if the Preference to Omit SS# on Reports is selected 

under the File menu, the Social Security number for each 

employee will still appear when printing this report.  

 

Creating California DE-9 XML File 
 

Employers who are set up with California’s EDD to file their 

Quarterly Wage and Withholding Reports electronically, can 

save a file from CheckMark Payroll to submit to the EDD in the 

DE-9 XML format. For more information on submitting the DE-9 

XML information electronically, contact the EDD. 
 

To save the report as an XML file, do the following: 
 

1 Click State Taxes in the Command Center. 
 

2 Select the CA DE-9 XML option and the desired Period. 
 

3 Select CA in the States list. 
 

4 Click Text File. The following dialog appears:  
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5 Fill in all appropriate fields and click OK. 
 

6 A Save As dialog box opens. Chose a save location and click Save. 
 

Creating California DE-9C MMREF File 
 

Employers who are set up with California’s EDD to file their 

Quarterly Wage and Withholding Reports electronically, can 

save a file from CheckMark Payroll to submit to the EDD in the 

DE-9C MMREF format. For more information on submitting the 

DE-9C MMREF information electronically, contact the EDD. 
 

To save the report as an MMREF file, do the following: 
 

1 Click State Taxes in the Command Center. 
 

2 Select the CA DE-9C MMREF option and the Period. 
 

3 Select CA in the States list. 
 

4 Click Text File. 
 

The following dialog appears:  
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5 Fill in all appropriate fields and click OK. 
 

6 A Save As dialog box opens. Chose a save location and click Save.  
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Creating New York MMREF File 
 

CheckMark Payroll can create the New Work MMREF file. New 

York requires submission of the test file with notification that 

the test was certified and successfully processed. Contact the 

New York State Department of Tax and Finance for complete 

filing instruction. Additional information is included in NY 

Publication 911 available www.tax.state.ny.us. 
 

1 Click State Taxes in the Command Center. 
 

2 Select the NY MMREF option in the drop down menu under the 

Report section. 
 

3 Select NY in the States list and choose what Quarter you want 

to save from the Period section (annual option not available). 
 

4 Click the Text File button and choose the location where you want 

to save the file. The file is named MMREF by default. 
 
 

Note Even if the Preference to Omit SS# on Reports is selected 

under the File menu, the Social Security number for each 

employee will still appear when printing this report.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

5 Enter the appropriate information for your company in the edit 

boxes, then click OK. 
 

If you are filing the MMREF file on behalf of another company, 

you can enter your own information in Submitter fields. 

Otherwise, CheckMark Payroll will use the Federal ID, Company, 

and Address information from the Company Information window. 
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A Save dialog appears. The file is named MMREF by default. 
 

6 Choose where you want to save it. 
 

7 Contact the EDD for complete instructions on filing.  
 

Note Even if the Preference to Omit SS# on Reports is selected 

under the File menu, the Social Security number will still be 

included in the MMREF file.  
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Chapter 34 Local Taxes 

 

Creating Local Taxes Reports 
 

This report shows the employee social security number, 

employee name, wages exempt from local taxes, total wages, 

wages subject to local tax and amount of the local tax withheld. 

There are totals by local tax at the bottom of the report. 
 

1 Click Local Taxes in the Command Center.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select one or more local taxes for the report. 
 

You can select a consecutive or non-consecutive series of 

local taxes from the list. 
 

If no local taxes are highlighted, all taxes will be reported. 
 

3 Select one or more check dates for the report. 
 

You can select a consecutive series of check dates from the list. 
 

4 Click View, Print, or Text File.  
 

Note You can omit the Social Security number from these reports 

by choosing Omit SS# on Reports in the Preferences section 

under the File menu.  
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Chapter 35 Income and Deductions 

 

Types of Income and Deduction Reports 
 

Deduction Detail The Deduction Detail reports shows the deduction name, 

employee SSN, employee name, employee deduction 

amount and employer match amount for individual checks, 

along with the total for each deduction. 
 

Income Detail The Income Detail report shows income name, employee 

social security number, employee name, check number, check 

date and total amount of income. 
 

Deduction Summary The Deduction Summary report shows the deduction name, 

employee SSN, employee name, deduction amount, match and 

total for the selected period. 
 

Income Summary The Income Summary report shows the income name, 

employee social security number, employee name, income 

amount for selected period and total for the selected period.  
 

Note To suppress the Social Security number from the report, go to 

the File menu and select Preferences. Choose the Omit SS# on 

Reports option. 
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Creating Income and Deduction Reports 
 

1 Click Income & Deductions in the Command Center. 
 

2 Select either the Deduction or Income radio button.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3 Select one or more items for the report. 
 
 
 
 

 

4 Select either the Detail or Summary radio button. 
 

5 Select one or more consecutive check dates for the report. 
 

6 Click View, Print, or Text File.  
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Chapter 36 Employer Payments 

 

Types Employer Payments Reports 
 

Check Register The Check Register report shows check data for the selected 

month, including check number, check date, payee, payment 

description, and the check amount. 
 

Posting Summary The Posting Summary report shows check information in a 

summarized format and can be used to create manual journal 

entries in your accounting system. (You can also save the 

posting summary information as a text file that can be imported 

into an accounting program.) 
 

Ledger accounts are shown with their associated amounts. 
 

The total debits and credits are shown on the last two lines. 
 

Posting File Formats 
 

Quicken (QIF) You can export posting information to Intuit’s Quicken. Select 

the Quicken (QIF) option and click Text File. A Save dialog 

appears. Enter a name for the text file and choose a directory 

in which to save it. Then, click Save. 
 

For Quicken 2005 for Windows and higher users: CheckMark 

Payroll creates a QIF file for importing into Quicken. Quicken will 

no longer accept QIF importing directly into a bank/checking 

account; it will only accept Open Financial Exchange (OFX) file 

formats used for downloading information directly from the 

internet. This file format is not available in CheckMark Payroll. 
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QuickBooks (IIF) You can export posting information to Intuit’s QuickBooks. 

Select the QuickBooks (IIF) Format option and click Text File. A 

Save dialog appears. Enter a name for the text file and choose 

a directory in which to save it. Then, click Save. 
 

CheckMark Payroll creates an Informational Interchange Format (IIF) 

file for importing checks into QuickBooks. The posting file format 

includes account names and account types to post all payroll 

information into the general ledger. The accounts named in the file are 

based on the set up of your payroll company in CheckMark Payroll. If 

these accounts DO NOT exist in your QuickBooks chart of accounts 

list, QuickBooks by default, will create the accounts upon import. 

Inserting ledger accounts into the Payroll program will not override the 

accounts created in the IIF file. We suggest that before importing 

payroll the first time you make a backup of your QuickBooks data. 

After successfully importing payroll into QuickBooks, carefully look 

through the transaction(s) imported and also evaluate the changes, if 

any, to your chart of accounts. If you do not wish these changes to 

occur, restore your QuickBooks backup and manually post your 

payroll data to QuickBooks. 
 

Peachtree 2.0 (Windows only) You can export posting information to 

Peachtree Accounting for Windows, version 2.0. Select the 

Peachtree 2.0 Format option and click Text File. A Save dialog 

appears. Enter a name for the text file and choose a directory 

in which to save it. Then, click Save. 
 

Peachtree 3.0 (Windows only) You can export posting information to Peachtree 

Accounting for Windows, version 3.0. Select the Peachtree 3.0 Format 

option and click Text File. A Save dialog appears. Enter a name for the 

text file and choose a directory in which to save it. Then, click Save. 
 

Peachtree 3.5, 5.0 (Windows only) You can export posting information to Peachtree 

Accounting for Windows, version 3.5 and 5.0. Select the Peachtree 

3.5, 5.0 Format option and click Text File. A Save dialog appears. 

Enter a name for the text file and choose a directory in which to 

save it. Then, click Save. 
 

M.Y.O.B. You can export posting information to Bestware’s M.Y.O.B.™ 

Select the M.Y.O.B. Format option and click Text File. A Save 

dialog appears. Enter a name for the text file and choose a 

directory in which to save it. Then, click Save. 
 

Big Business You can export posting information to Big Business. Select the 

Big Business Format option and click Text File. A Save dialog 

appears. Enter a name for the text file and choose a directory 

in which to save it. Then, click Save.  
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CheckMark You can post information to CheckMark’s MultiLedger. For 

more information on posting to MultiLedger see “Posting 

Employer Checks to MultiLedger” on page 166 
 

Rakefet (Windows only) You can export posting information to Rakefet. 

Select the RAKEFET Format option and click Text File. A Save 

As dialog appears. Enter a name for the text file and choose a 

directory in which to save it. Then, click Save. 
 

DBA Software (Windows only) You can export posting information to DBA 

Software. Select the DBA SOFTWARE Format option and click 

Text File. A Save dialog appears. Enter a name for the text file 

and choose a directory in which to save it. Then, click Save. 
 

POS/OE 4 You can export posting information to POS/OE 4. Select the 

POS/OE 4 Format option and click Text File. A Save dialog 

appears. Enter a name for the text file and choose a directory 

in which to save it. Then, click Save. 
 

Connected You can export posting information to Connected accounting. 

Select the Connected Format option and click Text File. A Save 

dialog appears. Enter a name for the text file and choose a 

directory in which to save it. Then, click Save. 
 

Creating Employer Payments Reports 
 

1 Click Employer Payments in the Command Center.  
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2 Select the month(s) for the report. 
 

3 Select the checks for the report. 
 

You can select a consecutive or non-consecutive series of 

checks from the list. 
 

If no checks are highlighted, all employer checks will be reported. 
 

4 Select the type of report. 
 

5 Click View, Print, or Text File.  



Types of W-2/W-3 Reports 215  
 

Chapter 37 W-2 & W-3 Statements 

 

Types of W-2/W-3 Reports 
 

W-2 on Blank Paper Select from this drop-down list, according to the following guidelines: 
 

4-up Employee All Copies- This is for printing employee 

Copies B, C, and 2 on 4-up blank, perforated paper. 
 

2-up Employer Copy A- This is for printing employer Copy A 

on 2 plain paper. 
 

2-up Employer Copy 1- This is for printing employer Copy 1 on 

2-up blank, perforated paper. 
 

2-up Employer Copy D- This is for printing employer Copy D 

on 2-up blank, perforated paper. 
 

2-up Employee Copy B- This is for printing employee Copy B 

on 2-up blank, perforated paper. 
 

2-up Employee Copy C- This is for printing employee Copy C 

on 2-up blank, perforated paper. 
 

2-up Employee Copy 2- This is for printing employee Copy 2 

on 2-up blank, perforated paper. 
 

W-2 on Preprinted This is for printing employee and employer W-2s on preprinted W-

2s. Forms 
 

W-3 on Plain Paper Select this option for printing on a W-3 form on plain paper 

(minimum 20 lb. weight). 
 

W-3 on Preprinted Select this option if you are printing on a preprinted W-3.  
Form 

 
EFW2 File Select this option if you are required to file electronically 

with the Social Security Administration or your state. 
 
 

Note Not all states are supported using the EFW2 method.  
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Creating W-2 and W-3 Reports 
 

The W2 & W3 Statements window allows you to print W-2 and 

W-3 information on blank perforated sheets or pre-printed 

forms. You can also save your W-2/W-3 information in the 

EFW2 file format for electronic filing.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Withholding for Two States 
 

CheckMark Payroll will print State wages and State withholding 

for up to two states as long as you have not started mid-year or 

edited YTD totals on Employee Setup. If an employee has 

income in two states, at least one state needs to have at least 

$0.01 withheld for the program to recognize both states. If you 

have withheld for more than two states, you need to prepare 

multiple W-2s. This can be accomplished by setting up a new 

employee for each state requiring wages and withholding. 
 

Verify Company Information 
 

Before printing W-2s, you should verify your company name, 

address and Federal ID are correctly entered on the Company 

Information window. Your State ID can be verified by selecting 

State Taxes under the Setup menu. Select each state table 

from the State Taxes section and verify the State ID.  
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Dependent Care Benefits - Box 10 
 

If you have a dependent care assistance program (section 129 

or section 125 cafeteria plan), the expenses paid or fair market 

value of those services should be shown in Box 10. Check the 

applicable box in Additional Income or Deduction setup. 
 

Non-Qualified Plans - Box 11 
 

This box shows distributions to an employee from a non-qualified 

plan, or deferrals under a non-qualified plan, that became taxable 

for social security or medicare taxes during the year, but were for 

services in a prior year. Check this box under the Additional 

Income set up screen. Also in the Additional Income set up, mark 

the check box if plan is a Section 457(b) plan. 
 

Deductions Appearing in W-2 Boxes 12a - 

12d 
 

Certain deductions should be listed in Box 12 with their 

appropriate letter code. Refer to the IRS publication Instructions 

for Form W-2 for a reference guide of Box 12 Codes. 
 

The code “D” that is associated with the 401(k) contribution does 

not have any bearing on the position in box 12 that the information 

prints. From the IRS W-2/W-3 instructions: “Box 12-Codes. 

Complete and code this box.Note that the codes do not relate to 

where they should be entered for boxes 12a-12d on Form W-2.” 
 

If you wish more explanation regarding printing of your W-2 

information, there is a copy of the W-2/W-3 instructions in .pdf 

format located in the IRS forms folder inside the Payroll folder 

on the hard drive of your computer, or you can download a 

copy from the IRS website at www.irs.gov. 
 

Box 13 Check Boxes 
 

On the Employee Setup window, under the Taxes tab, check the box 

Statutory Employee for employees whose earnings are subject to social 

security and Medicare taxes but not subject to Federal income tax 

withholding. There are workers who are independent contractors under 

the common-law rules but are treated by statute as employees. These 

are called statutory employees. See Pub. 15-A for details. 
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Check the box Retirement plan if the employee was an “active 

participant” (for any part of the year) in any of the following 

retirement or annuity plans: 401(a), 401(k), 403(a), 403(b), 408(k) 

(SEP), 408(p) (SIMPLE), 501(c)(18), or a plan for Federal, state, or 

local government employees. Do not check this box for 

contributions made to a nonqualified or section 457(b) plan. 
 

Check the box Sick Pay if any employee received sick pay 

benefits during the year from a third party. 
 

Box 14 – Other 
 

Box 14 can be used for information (Income or Deduction items) that 

you wish to identify for your employees. Examples include state 

disability insurance taxes withheld, union dues, uniform payments, 

health insurance premiums deducted, nontaxable income, educational 

assistance payments, or a clergy’s parsonage allowance and utilities. 

Check the Box 14 W-2 Options in the Setup window for the Additional 

Income or Deduction you wish to report. 
 

On the W-3 in Box 14, employers that had employees with 

Federal withholding by a third party payer will show amount 

withheld on sick pay of all employees this applies to. This 

amount is also included as part of the total in box 2 for the W-3. 

This amount must be reported in both places. 
 

Box 15 
 

Box 15 shows State/State ID#. If you withhold in more than one state, 

there will be an ‘X’ showing in this box and no state ID entered. 
 

An ‘X’ will appear on the W-3 in box 15 if you withhold for more 

than one state in a single payroll company. 
 

Furnishing Copies B, C, and 2 to 
 

Employees 
 

Furnish copies B, C, and 2 of Form W-2 to your employees, generally, 

by January 31st. You will meet the “furnish” requirement if the form is 

properly addressed and mailed on or before the due date. 
 

If employment ends before December 31st, you may furnish 

copies to the employee at any time after employment ends, but no 

later than January 31st. If an employee asks for Form W-2, give 

him or her the completed copies within 30 days of the request or 

within 30 days of the final wage payment, whichever is later. If you 

terminate a business or are unable to furnish W-2s by the due 

date, see the IRS Instructions for Forms W-2 and W-3.  
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Printing on Blank, Perforated W-2s and W-3s  
 

Note A laser or high quality printer is needed for printing W-2/W-3s 

on blank paper. 
 
 

1 Click W-2 & W-3 Statements in the Command Center. 
 

2 Select the employees from the list. 
 

You can select a consecutive or non-consecutive set of 

employees in the list. For a non-consecutive series of 

employees, hold down the Ctrl (Windows) key or Command (  

) key (Mac) while clicking individual employees in the list. 
 

If no employees are selected, W-2s for all employees will be printed.  
 

Note Employees with no wages paid in the calendar year will not be 

reported nor have a W-2 printed. 
 
 

3 Load your printer’s paper tray with 4-up perforated blank sheets. 
 

4-up perforated blank sheets are used to print the 

employee W-2 copies. 
  

Note You may want to select one employee to print a sample 4-up 

perforated blank sheet first before printing all your employees to 

make sure that the sheets are loaded into your printer correctly. 
 
 

4 Make sure the W-2 on Plain Paper radio button is selected and 4-

up Employee All Copies is selected in the drop-down list. 
 

5 Click Print.  
 

 

Note You can also print Employee Copies B, C and 2 on 2-up perforated 

paper by selecting the desired item in the drop down menu. 2-up 

perforated blank sheets print two different employees per page. 
  

6 After you have printed the employee W-2 copies on the 4-up 

perforated blank sheets, load the 2-up perforated blank sheets into 

your printer's paper tray. 
 

2-up perforated blank sheets print two different employees 

per page and are used for employer W-2 copies D and 1.  
7 (for 4-part, 6-part, & 8-part W-2s) 

button then select 2-up Employer 
 

8 Click Print.  

  
Select the W-2 on Plain Paper radio 

Copy 1 from the drop-down list. 
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9 (for 6-part & 8-part W-2s) When Copy 1 is done printing, select 

2-up Employer Copy D from the drop-down list. 
 

10 Click Print. 
 

11 (for 8-part W-2s) When Copy D is done printing, select 2-up 

Employer Copy 1 from the drop-down list. 
 

12 Click Print.  

 

Note If you are filing using EFW2 you do not need to complete steps 

13-15, as you do not need to submit Copy A. For more 

information on EFW2, see “Saving Federal and State 

Electronic Information in the EFW2 Format” on page 224.   
13 (for 4-part, 6-part & 8-part W-2s) Load your printer's paper tray with 

plain paper*. 
 

14 Select 2-up Employer Copy A from the drop-down list. 
 

15 Click Print. 
 

Printing the W-3 Form 
 

1 Make sure your printer's paper tray is loaded with plain paper*. 
 

2 Select the W3 on plain paper radio button. 
 

3 Click the EFW2/W3 Setup button. 
 

4 Enter your company's contact, phone, fax, and email information 

in the fields. 
 

5 Click OK. 
 

6 Click Print.  
 

Note * Plain Paper: Use to print the W-2 Federal Copy A and W-3 

Transmittal Copy. Red printed copies are no longer required for these 

two forms. CheckMark does not sell Plain Paper. You can use the 20 

lb. white paper found in most offices for copiers or printers.  

 

Important To print W-2s and W-3 on blank perforated paper, the most current 

version of CheckMark Payroll must be installed to be assured that 

the format being printed is acceptable for submission. If you are 

running an older version, the pre-printed forms option is available. 

Pre-printed forms for prior years can be obtained from the IRS.  
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Printing on Preprinted W-2s and W-3s 
 

Important Print a Sample W-2 and W-3 
 

Before you print the W-3 and W-2s for all of your employees, you should 

print a sample W-2 and a sample W-3 on blank paper to make sure that 

the alignment is correct, and that the amounts are printing in the correct 

boxes. Each type of printer will print slightly different, and you may need to 

adjust the fields for your specific printer. If the alignment is incorrect, see 

the section below, “Fixing Alignment Problems.” 
 

Resetting the Default 
 

You can reset the default on the pre-printed W-2 or W-3 form by going 

into the W-2 & W-3 Statements window, clicking on either the W-2 on 

preprinted forms or W-3 on preprinted form option, hold down the Shift 

key on the key board and click the Edit Format button. 
 

Fixing Alignment Problems 
 

If the alignment on the sample W-2 or sample W-3 you printed 

above is incorrect, follow these steps: 
 

1 Click W-2 & W-3 Statements in the Command Center. 
 

2 Select the W-2 on preprinted forms or W-3 on preprinted form 

radio button, then click Edit Format. 
 

The Format window appears. 
 

3 Move the field or fields that need adjustment. 
 

For more information on repositioning fields on the Format 

window, see “Formatting Checks, W-2s, and W-3s” on page 227 
 

Printing W-2s with a Laser or Ink-jet Printer 
 

1 Click W-2 & W-3 Statements in the Command Center. 
 

2 Select the employees from the list. 
 

You can select a consecutive set of employees. 
 

If no employees are selected, W-2s for all employees will be printed. 
 

3 Load your printer’s paper tray with the appropriate set of forms. 
 

Laser and ink-jet printers can’t print on multiple-part forms. You 

need to print each set of forms individually. For example, if you are 

printing 4-Part Laser forms, you would load the set of Copy As into 

the paper tray and print Copy A for all of your employees. Then, 

when Copy A is finished, you would load the set of Copy Bs into 

the paper tray and print Copy B for all of your employees. Then 

you would repeat this process with Copy C and Copy D. 
 

4 Select the W-2 on preprinted forms radio button.  
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5 Click Print. 
 

6 Repeat steps 3–5 for each set of forms. 
 

Printing W-2s with a Dot Matrix Printer 
 

1 Click W-2 & W-3 Statements in the Command Center. 
 

2 Select the employees for the W-2s. 
 

You can select a consecutive set of employees. 
 

If no employee names are highlighted, all employees will be reported. 
 

3 Load your printer’s paper tray with the appropriate set of forms. 
 

Dot matrix printers are impact printers and can print multiple 

copies at once. W-2 forms for dot matrix printers come as Twin 

Sets. One set is the employee set and the other is the employer 

set. You will make two passes through your printer. 
 

4 Select the W-2 on preprinted forms radio button. 
 

5 Click Print. 
 

A Windows Print dialog appears. Select All for the Print Range. 

Set the Print Quality to the appropriate dpi and set the number 

of Copies to 1. 
 

6 Load the other set of W-2s into the printer and print them the same 

way as the first set. 
 

Printing on the Form W-3 
 

1 Load the pre-printed W-3 form into your printer. 
 

2 Select the W3 on preprinted form radio button. 
 

3 Click the EFW2/W3 Setup button. 
 

4 Enter your company's contact, phone, fax, and email information in the fields. 
 

5 Click OK. 
 

6 Check the Preprinted W-3 checkbox. 
 

7 Click Print.  
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Third-Party Sick Pay Reporting on the W-2 and W-3 

Statements 
 

1 Select Additional Income on the Command Center window. 
 

2 Select New. Enter a description of the income such as “Sick Pay”. 

You are limited to 12 characters. Set the Calculation Method as 

Variable. Close Additional Income window. 
 

3 Select Employees on the Command Center window. 
 

4 Select an employee from the list on the right and then select the 

Taxes tab at the top. 
 

5 Mark check box for the W-2 box 13 Sick Pay. 
 

6 Select Income tab. Under Company Categories select “Sick Pay” 

then Assign and Save. 
 

7 Reselect the same employee from the list and the YTD tab. In the box 

labeled “Sick Pay” modify the amount from 0.00 to gross wages paid 

by third-party payer. Also, modify Social Security and Medicare 

amounts to amount shown plus the amount withheld by third-party 

payer. If necessary, enter the amount of federal withholding withheld 

on sick pay in the box labeled “3rd Party Federal W/H”. Save. 
 

8 Repeat steps 3-7 for all employees paid sick pay by a third-party payer. 
 

9 Select W-2/W-3 Statements on the Command Center window. 
 

10 Print W-2’s and W-3 statements. For more information on printing 

W-2s and W-3s see “Creating W-2 and W-3 Reports” on page 216 
 

Creating Electronically Filed Reports 
 

You can save a file from CheckMark Payroll that you can use to 

submit W-2 information to the SSA electronically in the EFW2 format. 

For more information on submitting W-2 information electronically, see 

the Social Security Administration (SSA) publication about Electronic 

Filing (EFW2) online at http://www.ssa.gov/employer. 
 

CheckMark Payroll also allows you to save State information for 

filing electronically. For a list of available states, click the pull-

down list next to the EFW2 File button.  
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Saving Federal and State Electronic  

Information in the EFW2 Format 
 

Before you save the information as a file, you should verify 

some information for your company and your employees. 

Generally, if you’ve already printed W-2s for your 

employees and all of the information is correct, you can 

save the information as a file. You should make sure that: 
 

• Your company name, address, and Federal and State ID numbers 

are correct on the Company Information and State Taxes windows. 
 

• Each employee should have a valid 9-digit Social Security Number. 
 

• Any deferred compensation or pension plans have been set up 

correctly in CheckMark Payroll and correctly assigned to the 

employees. For more information, see Chapters 7, 8, and 9. 
 

When you’re ready to save the electronic file information in the 

EFW2 format, do the following: 
 

1 Click W-2 & W-3 Statements in the Command Center. 
 

2 Select the EFW2 File radio button. 
 

3 Select Federal or your state from the pull-down list.  
 

Note Some state require <CR><LF> between each record in order to 

file electronically. If necessary, select check box Add CR/LF to 

EFW2 before creating your state’s EFW2 file. For more 

information, check with your state or see your states website. 
 
 

4 Click the EFW2/W3 Setup button.  
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5 Enter the correct data for your company, then click OK. 
 

If you are filing the EFW2 file on behalf of another company, you 

can enter your own Submitter information in the Submitter EIN, 

Submitter Company, Submitter Address, City, State, and Zip fields. 

Otherwise, CheckMark Payroll will use the Federal ID, Company, 

and Address information from the Company Information window. 
 

6 Click Text File. 
 

A Save dialog appears. The default name for the file is 

“W2REPORT.TXT.” Do not change this name unless your 

state requires a different file name. 
 

7 Choose the directory in which you want to save the text file. 
 

8 Click Save. 
 

Follow the instructions in the SSA publication about Electronic Filing 

(EFW2) or your state publication for complete instructions on filing. 
 
 

Note For Federal Filing: After saving the W2REPORT.TXT text file, 

you should run the Social Security Administration’s software, 

AccuWage, to make sure that the information is correct before 

submitting the file. For more information on AccuWage, see 

http://www.ssa.gov/ employer/accuwage/index.html. Available 

for Windows computers only.  
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Chapter 38 Cus tomizing Checks and 

Reports 

 

Formatting Checks, W-2s, and W-3s 
 

You can reposition items that print on checks, or pre-printed W-

2s, and W-3s to align printing for your particular printer or form. 
 

1 Click the Edit (Win) or Edit Check Format (Mac) button on 

the appropriate window. 
 

To format employee paychecks and employer payment checks, use the  
Print Paychecks window. To format W-2s and W-3s, use the W-2 &  
W-3 Statements window. 

 
A format window appears that allows you to reposition the fields. 

 
For example, clicking the Edit button (Win) associated with the 

Custom Check Format area on the Print Paychecks window 

opens the following window:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Use this Format window to position the fields that print on 

checks. Employer checks use the field positions set up for 

employee paychecks.  
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2 Drag the print fields to their new positions. 
 

To move a single field to a new position, position your mouse 

pointer over the field, hold your mouse button down and move your 

mouse in the direction of the new position. You can also use the 

directional arrows on your keyboard to move the selected field. 
 

To select a group of print fields, hold down the SHIFT key while 

clicking individual fields or drag over the fields until all the 

desired items are at least partially contained within the box. 

The selected fields should be highlighted. Holding down the 

SHIFT key and moving one field will move the entire group. 
 

To restrict movements to vertical positioning, hold down the ALT 

key (Windows) or OPTION key (Mac) while moving dragging the 

field or fields. To restrict movements to horizontal positioning, 

hold down the CTRL key (Windows) or Command (  ) key (Mac) 

while dragging the field or fields. 
 

To prevent a field from printing, double-click the field or select the 

field and press the space bar. The field’s name will become red. To 

re-enable the field for printing, double-click the field again or select 

the field and press the space bar. Its name will become black. 
 

3 When you’ve finished repositioning the print fields, close the window. 
 

4 Click Yes to save the format changes. 
 

Resetting the Default 
 

You can reset the default format placement for checks and 

W-2/W-3 reports. 
 

Checks 
 

To reset the default check format, open the Print Paychecks 

window. Click either the Custom-Check in Middle or Custom-

Check on Top option. Hold down the Shift key on the keyboard 

and click the Edit... button. 
 

W-2 and W-3 
 

You can reset the default on the pre-printed W-2 or W-3 form by going 

into the W-2 & W-3 Statements window, clicking on either the W-2 on 

preprinted forms or W-3 on preprinted form option, hold down the Shift 

key on the key board and click the Edit Format button. 
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Part 5 

Customizing and 

Maintaining CheckMark 
 

Payroll 

 
 

 

In Part 5, you’ll find out how to do the following: 
 

• Position print fields to format checks, W-2s, and W-3s 
 

• Set preferences and select the print font for reports 
 

• Change the Command Center’s color 
 

• Increase or Decrease the font size for windows 
 

• Make a backup 
 

• Restore a backup 
 

• Set up a password 
 

• Find Payroll data files 
 

• Start a new year  
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Chapter 39 Setting Preferences 

 
This chapter shows you how to set various CheckMark Payroll 

preferences and view options and select the font for printing. 
 

Payroll Preferences 
 

You can use the Preferences window under the File menu 

to set various CheckMark Payroll options. 
 

1 Choose Preferences from the File menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Check or uncheck the preferences. 
 

3 When you have finished setting the preferences, close the 

window, then click Yes when prompted to save changes. 
 

Application Preferences 
 

Open Last Database When checked, the last used Payroll database will open 

automatically on Launch when you launch CheckMark Payroll. 
 

Open Last Company When checked, the last used Payroll company will open 

automatically on Launch when you launch CheckMark Payroll. 
 

Remind to Reload This option will prompt you to reload all setup categories after an 

Setup Categories after update making sure you stay current with any tax table, deduction or 

Update income changes. 
 

Remind to Backup When checked, you will be prompted to make a backup of the 

database when Closing you’re in when you close. 

Database  
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Show Check Printing When checked, a warning appears if you have Middle Check selected 

Warning on the Print Paychecks window and you have more than four Additional 

 Incomes or eight Deductions assigned to an employee. If you have more 

 than four Additional Incomes and/or eight Deductions for your 

 employees, we recommend you buy check stock with the check on top. 

Prompt to Mark When checked, you will see a prompt when you print checks asking if 

Checks as Printed you want to mark the checks as printed. You can select Yes or No to 

 mark or not mark the checks as printed. If this preference is NOT 

 checked, all checks will be automatically marked as printed after you 

 print them. 

Show Critical News When checked, the newsfeed on the Command Center window will 

Only show only critical information posts. 

View Preference File Select this option to view all the Preferences settings for the open  

 company. 

Change Configuration When selected, you can move the "CheckMark" Directory that contains 

Directory Location the company database to another location of your choosing. 

 

View Preferences 
 

1 Choose Preferences from the File menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Click the View tab. Check or uncheck the preferences. 
 

3 When you have finished setting the preferences, close the 

window, then click Yes when prompted to save changes. 
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Show Employer When checked, this option will display the employer matches in the  

Matches in Calculate Calculate Pay screen when creating checks. 

Pay  

Display Font Size You can customize the window size in CheckMark Payroll by 

 increasing or decreasing the font size for all windows. Simply enter a 

 number, a lower number will decrease the window size and a higher 

 number will increase the window size. 

Change Display Font You can change the size and display font for most screens throughout 

 payroll. Click on the Change Display Font button and choose which  

 font and size you would like. 

Command Window You can change the Command Screen (main screen) from the new 

 command view or use the classic view by clicking the corresponding 

 radio button. 

Change Background Clicking on the Change Background Color button allows you to change  

Color the color of reset to the default color for the Command Screen view. 

Save Command List With the New Command Screen View, you can select this box to save 

Drop-Downs (New whatever drop down menus you had open before closing. Those menus 

View) will re-open automatically when you open Payroll back up. 

Save Window When selected, if you reposition windows within the payroll program, 

Placement the new positions are saved. 

Manage Window When selected, you can choose the following option from the drop- 

Placement down menu: 

 Center on Screen (Default)- When selected, the Command Center will 

 appear in the center of your screen and all report windows when open 

 will appear one on top of the other. 

 Cascade from Right (Classic)- When selected, the Command Center 

 appears in the top left of screen and reports appear to the right of the 

 command center cascading from left to right down the screen. 

 Cascade from Left- When selected, the Command Center appears in 

 top left of screen and reports appear on top of command center 

 cascading from left to right down the screen. 

Save Window Size When checked, if you resize windows within the payroll program, the 

 new sizes are saved.  
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Company Preferences 
 

1 Choose Preferences from the File menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Click the Company tab. Check or uncheck the preferences. 
 

3 When you have finished setting the preferences, close the 

window, then click Yes when prompted to save changes. 

 
 

Sort Hourly When checked, CheckMark Payroll shows hourly employees first 

in Employees First When the employee list on the Enter Hours window. 

Entering Hours 
 
Sort Employee List by When checked, the employee number will appear before the 

employee Employee Number name. Lists and reports will be sorted by employee 

number. 
 
Sort Employee List by When checked, the Department assigned on the Personal view tab 

(on Department the Employees window) will appear above employee names  
(employees will be listed alphabetically within the department), 

and employee lists and reports will be sorted by department. 
 
 

Note If both the Sort Employee List by Employee Number and Sort 

Employee List by Department options are checked, employee lists and 

reports will be sorted by department first, then by employee number 

within each department. Employees with no department or employee 

number assigned will appear alphabetically at the top of the list. 
 
 
Use Company Specific Select this option if you keep separate formats for each separate 

W2/W3/Check Formats company. If this option is not checked, one format will be used for all 

companies within the database.  
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Omit SS# on Reports When checked, employee social security numbers will not appear on 

any reports except W-2 reporting and the California DE-6. 
 
Show Last 4 of SS# on When selected, this option will only show the last 4 digits of the 

Social Checks and Reports Security number on Checks and Reports. 
 

Selecting the Print Font 
 

You use the Select Print Font window under the File menu to 

select the font for printing checks and reports. 
 

1 Choose Select Print Font from the File menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Select the font, font style, and font size. 
 

The fonts listed are the fonts installed in your system. You can 

use fonts sizes from 8 to 14 points with CheckMark Payroll. 

To install or remove fonts, see your computer’s owner’s guide. 
 

3 Click OK. 
 

View Menu Options 
 

You can use the options under the View menu to set the 

Command Center Window color, as well as increase or 

decrease the screen font size for Payroll windows. 
 

Changing the Window Font Size 
 

You can customize the window size in CheckMark Payroll 

by increasing or decreasing the font size for all windows. 
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1 Choose Increase Font Size CTRL = (Windows) or COMMAND = (Mac) 

from the View menu. 
 

Or, choose Decrease Font Size CTRL - (Windows) or 

COMMAND - (Mac) from the View menu. 
 

Changing the Display Font 
 

You can change the display font for better, more customized 

viewing on your screen for most areas. 
 

1 Choose Change Display Font... from the View menu. 
 

2 Select which font from the list you would like to change to. You 

can also select the Font Size. 
 

3 Click OK. 
 

Changing the Command Center Window 

Color 
 

1 Choose Change Color from the View menu. 
 

The Choose Color window appears:  
 
 
 
 
 
 
 
 
 
 

 

2 Use the arrows to move change the color as you like. 
 

3 Click OK to save the color, or click Cancel to leave the window 

without changing the color. 
 
 

NOTE You can always reset to the default Command Center Color by 

clicking Default, then OK. 
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Chapter 40 Protecting Your Files 

 
This chapter shows you how to protect your company files by backing 

them up, setting up a password and helping you locate payroll files. 
 

Backing Up Your Company Files 
 

There are two types of people: those who make back ups and 

those who wish they had. Backing up your database is not only 

prudent, but it’s easy to do on a regular basis. 
 

CheckMark Payroll makes an automatic backup of the 

database everytime you quit out of the software. This backup 

is saved in the _Backups folder located in the default 

database location. The default database backup location is: 
 

Windows - C:\CheckMark\Payroll\”year”\_Backups 
 

Mac - HD/CheckMark/Payroll/”year”/_Backups  
 

 

Important We cannot stress enough the importance of making frequent backups. 

Backups are sometimes the only way restore data that is lost due to a 

crash or power failure. CheckMark highly recommends you make 

additional backups on a flash drive or CD that are not stored on the 

same computer as payroll in case of computer failure. 
 

 

Suggestions for Backing Up 
 

At a minimum, we suggest that you make a back up after 

each pay period. 
 

You can use the Create Backup... to create your own backups. 

You should back up to a disk other than the drive that contains 

the original company files, such as a server, another hard 

drive, a CD, or a flash drive. 
 

Making a Backup 
 

1 Choose Backup Database from the File 

menu. On Windows, it will look like this: 
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. 
 

Use the pop-up menu and list   
below to choose where you want   

to save the backup. 
 
 

 

The default name for your 

backup is an auto generated  

name from the software. You 

can change this name if you 

want. 

 
 
 
 
 

On Macintosh, it will look like this:  
 
 
 

The default name for your 

backup is an auto generated 

name from the software. 

You can change this name if 

you want. 

 
Use the pop-up menu to choose 

where you want to save the  

backup. You can even backup to 

a CD or flash drive 

 
 
 
 
 
 
 

 

2 The default name for the archive is auto generated by the software. 
 

You can change the name of the backup archive, but you 

cannot change the file type. 
 

3 Choose where you want to save the backup archive. 
 

Be sure to pay attention to where you save the backup. You may want 

to change the folder using the pull-down menu and list below. You can 
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save the backup archive anywhere, such as on your hard 

drive, an external drive, a flash drive or burn to a CD ROM. 
 

4 Click Save. 
 

When the backup is complete you will receive a message 

showing the location where the backup database was saved. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Restoring Backup Database  
 

Important If you try to double click the “.db” backup file to open, you will most 

likely get the message that it can’t find an application to open. The 

.db files must be opened using the “Restore Backup...” command 

as described below before they can be opened. 
 
 

1 Launch the Payroll program. 
 

2 Choose Restore Backup from the File 

menu. An Open dialog appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note If there are no existing databases in the database manager, 

you will receive a message that you need to Create a New 

Database and the create database screen will open.  
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Restore over the Choosing this option will allow you to select the backup .db file 

and currently open overwrite the current database that is open. 

database 
 

1 Locate the backup .db archive using the dialog box. 
 

If you backed up your company files on a CD, flash drive, or 

other external media you should insert it now. Use the Look in 

pop-up menu and list below to locate the backup archive.  
 

Note Payroll makes automatic backups of the database each time you 

quit out of the program. These are saved in the _Backups folder. 
  

On Windows, it will look like this:  

 

You may have to  use 

the pop-up menu and 

list to locate the .db 

backup archive saved 

using the Create 

Backup...  
command, then  

click Open  
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On Macintosh, it will look like this:  
 
 

 

You may have to 

use the pop-up 

menu and list to 

locate the .db 

backup archive 

saved using the  
Create Backup...  

command, then 

click Open 
 
 
 
 
 
 
 
 
 
 

 
Note If your backups are stored on a CD, it may be necessary to copy and 

paste the backup file to your computer before restoring the archive. 
  

2 Click Open. A warning message appears about overwriting all 

data in the current database. 
 
 
 
 
 
 
 
 
 
 
 
 

 

Important Unless your intent is to replace your current database with the 

restored backup, you should avoid continuing with the restore. 

Restoring the backup .db will replace the current database 

along with all set up companies within that database. 
 

If you do not want to replace the entire database and all set up 

companies, you can add the database for viewing using the Database 

Manager command. For information on using the Database Manager, 
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see “Exiting CheckMark Payroll” on page 13.  
 
 

I  
 
 
 
 
 
 
 
 
 
 
 

 
Do Not click Yes if you do not want to overwrite the current database 

and all set up companies in that database. To view a backup database 

without overwrighting the current database, you can add the database 

to open in the Database Manager. For information on using the 

Database Manager, see “Exiting CheckMark Payroll” on page 13. 
 

3 Click Yes to restore the backup database. 
 

4 Click OK to begin working in the restored database. 
 

Setting Up a Password 
 

You can set up a password to restrict access to your company 

files. The password is not case sensitive. For example, an 

upper case “T” is treated the same as a lower case “t”. 
 

1 Click Company Information in the Command Center. 
 

2 In the Password edit box, enter a password up to 40 characters long.  
 
 
 
 

3 Close the window and save changes when prompted. 
 

When you open the company, you will be prompted for the password.  
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Enter the password and click OK. As you enter the password, 

the characters in the edit box appear as asterisks (*) to 

prevent the password from being seen by others. 
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Chapter 41 Starting a New Year 

 

The Start New Year (Import Prior Year) command 

automatically advances your payroll to next year and retains 

your previous payroll files for easy access. 
 

When you start a new year for a company, the following happens: 
 

• The payroll year is incremented to the next year for all 

companies in the current database. 
 

• A new database is created from the current database for 

the new year. The new year database is saved in the same 

location as the current database. 
 

• You can access prior year databases under the Database 

Manager located under the File menu. 
 

• All employee and employer checks are cleared. 
 

• All employee earnings are zeroed. 
 

• All employees marked as Inactive in the Employee setup 

screen are deleted. 
 

• Checks for the new year can be entered. 
 

Starting a New Year 
 

1 Choose Start New Year [year] (Import Prior Year) from the File menu. 

An alert appears to let you know you are starting a new year. 

 
 
 
 
 
 
 
 
 
 
 

 

2 Click OK. 
 

An alert appears describing what happens when the New Year 

process is completed 
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.  
 
 
 
 
 
 
 
 
 
 

 

3 Click OK.  
 
 
 
 
 
 
 
 
 
 
 
 
 

4 An alert appears telling you that you are ready to process payroll in 

the new year. Click OK to proceed. 

 
 

Before you create employee or employer checks in the New 

Year, you can do the following: 
 

• Change the hour categories order in Setup. 
 

• Delete Additional Income or Deduction categories that 

are no longer used. 
 

• Delete employer payees that are no longer used.  
 

Important Make Frequent Backups. Because there is always a risk of computer 

failure, it’s highly recommended that you make frequent backups to an 

external device (See “Backing Up Your Company Files” on page 237.). 
 

Keep Your Payroll Current. Install any updates or patches 

that are available. 
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Appendix A Direct Depos it 

 

CheckMark Payroll allows you to utilize direct deposit for your 

employees through your financial institution using ACH Direct 

Deposit or through National Payment Corporation using Web 

Direct Deposit. 
 

Using CheckMark Payroll for ACH Direct Deposit 
 

CheckMark Software allows you to utilize direct deposit for 

your employees through your financial institution. Payroll 

creates an ACH file that you can submit directly to your bank.  
 

Tip CheckMark Payroll also handles Web Direct Deposit via the internet 

through National Payment Corporation. For more information on getting 

set up for Web Direct Deposit, please contact National Payment 

Corporation at www.directdeposit.com. For more information, see “Using 

CheckMark Payroll for Web Direct Deposit” on page 250. 
  

Before setting up information in CheckMark Payroll, you should 

contact your financial institution to see if they allow for direct 

deposit to employee accounts using the ACH format. Your 

bank will give you specific instructions and information you 

need to set up CheckMark Payroll for direct deposit. 
 

After you have contacted your bank, follow these instructions to 

set up information in CheckMark Payroll: 
 

Set Up Employees for ACH Direct Deposit 
 

1 Click Employees in the Command Center. 
 

2 Select an employee from the list on the right. 
 

3 Check Direct Deposit, then select Checking or Savings. 
 

Select Checking if the employee wants his/her wages to be 

deposited in a checking account or select Savings if the employee 

wants his/her wages to be deposited in a savings account. 
 

4 Enter the employee’s nine-digit routing number for his/her bank 

in the Routing #1 field. 
 

This number is 9 digits. 
 

5 Enter the employee’s account number for his/her bank in the 

Account #1 field. 
 

This number can be up to 17 digits.  
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6 If the employee is depositing into two accounts, enter the routing 

number of the second account into Routing #2 field. 
 

7 Select whether this account is a Checking or Savings account. 
 

8 Enter the account number of the second account into the Account #2 field. 
 

9 Enter the amount to be deposited into the second account into the 

Amount field. 
 

10 If necessary, check Prenote. 
 

Prenote is typically only selected the first time that the 

employee paycheck is created for direct deposit. When your 

bank notifies you that the deposit went through correctly, you 

will deselect the Prenote option and click Save.  
 

Note If you’re using ACH Direct Deposit for the first time, you don’t 

need to check the Prenote box for employees. Instead, use the 

Prenote checkbox in the Direct Deposit setup window under the 

Employee Paychecks window.  

 

Set Up ACH Direct Deposit Information 
 

After you have set up employees for direct deposit as described 

earlier in this section, then processed payroll and created checks, 

you are ready to create the ACH file for submission to your bank. 
 

1 Click Employee Paychecks in the Command Center. 
 

2 Select ACH Direct Deposit. 
 

3 Select one or more check dates. 
 

The only checks that will be included in the ACH file are those 

for employees who are set up as Direct Deposit employees on 

the Personal tab of the Employees setup window. 
 

4 Click Text File. 
 

The following window appears:  
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Your bank or ACH provider should supply you with the 

information for this window. 
 

For more information about the Direct Deposit fields, see 

“Fields on the ACH Direct Deposit Window” on page 249. 
 

5 Once the information is entered, click OK. 
 

After you have entered this information the first time it will be 

saved for future use. The only information you may have to edit 

each time is the Effective Date. 
 

A Save dialog appears. The file is named Deposit by default. 

If your bank requires a different file name, you can change it. 
 

6 Choose where you want to save the file, then click Save. 
 

Check with your bank for information on submitting the 

deposit file that was created. 
 

Fields on the ACH Direct Deposit Window 
 

Originator Name This is usually your company name, but you should contact 

your bank to make sure of the exact name to enter. This field is 

limited to 23 characters. 
 

Originator Routing # This is the nine-digit routing number of your bank, and is 

printed at the bottom of your checks. This field can 

accommodate up to ten characters.  
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Destination Name This is the name of the institution receiving the ACH file. This 

field is limited to 23 characters. Your bank should provide you 

with this information. 
 
Destination Routing # This is the nine-digit routing number of the institution that will receive 

the ACH file. Your bank should provide you with this information. 
 

Company ID This is the ID number that identifies your company during the 

transaction. Check with your bank for the correct ID number to 

enter. This field can accommodate up to ten characters. 
 

Entry Description This entry will appear on employee’s bank statement when his pay is 

posted to his account. This field is limited to 10 characters. Examples 

for this include PAYROLL, DIRECT PAY, or DIRDEPOSIT. 
 

Discretionary Data This is for information your bank may have asked you to insert in your 

ACH file. Limited to 20 characters or 16 if all letters are capitalized. 
 

Account Number This is the offsetting account number used in a balanced file. If 

your bank requires a balanced file, enter the necessary account 

number in this field. This field allows 17 numbers. 
 

Effective Date This is the date you would like the transaction to take place. Typically it 

is one to two banking days after you have posted your ACH file. Your 

bank should let you know what the lead time is for the deposit. 
 

File ID Modifier The default value is an “A.” Increment to "B", "C", and so on 

for additional files sent on the same day, if you are instructed 

to do so by your bank. 
 

Balanced File If your bank requires a balanced file, place a checkmark in this box. 
 

Prenote If necessary, check Prenote. This option zeroes out all records. Prenote is 

typically only selected the first time that your company submits an ACH 

direct deposit. When your bank notifies you that the deposit was 

processed correctly, you will no longer need to check Prenote. 
 

Omit SS# This option omits the social security number on the ACH direct 

deposit file. 
 

Using CheckMark Payroll for Web Direct Deposit 
 

National Payment Corporation can use either the Web Direct 

deposit option or the ACH NPC Direct Deposit option. 

Contact National Payment Corporation for details on which 

format to use at www.directdeposit.com. 
 

Designate Employees for Web Direct  

Deposit 
 

1 Click Employees in the Command Center.  
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2 Select an employee who receives Web Direct Deposit from the list 

on the right. 
 

3 Check the Direct Deposit check box. Click Save. 
 

4 Repeat steps 2-3 for each employee who receives direct deposit. 
 

Create an Export File for Web Direct 

Deposit 
 

After you have set up employees for direct deposit as 

described earlier in this section, then processed payroll and 

created checks, you are ready to create the Web Direct 

Deposit file for submission to National Payment. 
 

1 Click Employee Paychecks in the Command Center. 
 

2 Select one or more check dates. 
 

3 Select the Web Direct Deposit radio button. 
 

4 If desired, select the Use Employee # checkbox to use the employee’s ID 

number instead of the Social Security number. You must have the 

Employee Number set up with National Payment Corp. to use this option. 
 

5 Click Text File. 
 

A save dialogue appears. The file is named Web Direct Deposit 

by default. You can change the file name if necessary. 
 

6 Choose where you want to save the file, then click Save. 
 

Be sure to remember where you saved the text file, as you will 

need it to import into the National Payment website. 
 

Using CheckMark Payroll for ACH NPC Direct Deposit 
 

National Payment Corporation can use either the Web Direct 

deposit option or the ACH NPC Direct Deposit option. 

Contact National Payment Corporation for details on which 

format to use at www.directdeposit.com. 
 

Designate Employees for ACH NPC Direct 

Deposit 
 

1 Click Employees in the Command Center. 
 

2 Select an employee who receives ACH NPC Direct Deposit from 

the list on the right. 
 

3 Check the Direct Deposit check box. Click Save. 
 

4 Repeat steps 2-3 for each employee who receives direct deposit.  
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Create an Export File for ACH NPC Direct 

Deposit 
 

After you have set up employees for direct deposit as 

described earlier in this section, then processed payroll and 

created checks, you are ready to create the ACH NPC Direct 

Deposit file for submission to National Payment. 
 

1 Click Employee Paychecks in the Command Center. 
 

2 Select one or more check dates. 
 

3 Select the ACH NPC Direct Deposit radio button. 
 

4 If desired, select the Use Employee # checkbox to use the employee’s ID 

number instead of the Social Security number. You must have the 

Employee Number set up with National Payment Corp. to use this option. 
 

5 Click Text File. 
 

A save dialogue appears. The file is named Deposit.txt by 

default. You can change the file name if necessary. 
 

6 Choose where you want to save the file, then click Save. 
 

Be sure to remember where you saved the text file, as you will 

need it to import into the National Payment website. 
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